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1 About AShop Deluxe

1.1 About AShop Deluxe

AShop Deluxe - Online Shopping Cart
eMerchant - Sales and Order Management
Digital Mall - Member Products
version 4.8.x

Developed by Andreas Rimheden and Rob Harris

Copyright © 2002-2008 – All Rights Reserved Worldwide

Webco Inc dba AShop Internet

Use of AShop Deluxe and eMerchant software is subject to a software license agreement.

Included in this documentation are instructions for installation, setup, and usage of the AShop Deluxe
shopping cart, eMerchant order management, and Digital Mall member product sales. AShop Deluxe
must be installed for eMerchant and Digital Mall to be installed.

1.2 Overview Of AShop Deluxe

AShop Deluxe is a shopping cart program, which can be used in a variety of different ways

to manage and sell products and services over the Internet. AShop Deluxe includes a system of tools
and resources to organize and automate online sales.
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AShop Deluxe can be used to sell many different types of products and services:
· Tangible Products
· Downloadable Products 
· Subscriptions for Password  Access to Protected Directories
· Key codes 

Click here for a Tour of AShop Deluxe.

The shopping cart is pre-integrated with software for most popular payment methods.
Click here for a list of supported payment services.

AShop Deluxe is a commercial software product, which is licensed per domain.

We offer several ways to try before you buy.

Get Trial Key and Download Files.

Install AShop Deluxe.

1.3 Overview Of eMerchant

eMerchant is a multi-user sales and order management system. It shares data with

the AShop Deluxe shopping cart and  provides a work space where sales people can login to manage
messages, orders, vendors, purchase orders, order tracking, and vendor bills. eMerchant is a server
based system and data can be easily accessed from multiple locations simultaneously using Internet
browsers.

http://www.ashopsoftware.com/tour-dx/index.html
http://www.ashopsoftware.com/payment-processor-cross-reference.htm
http://www.ashopsoftware.com/dlcounter/trialform.html
http://www.ashopsoftware.com/dlcounter/downloads.php
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eMerchant works in tandem with AShop Deluxe. AShop Deluxe must be installed for eMerchant to
function.

Click here for a tour of eMerchant.

Get Trial Key and Download Files.

Install eMerchant.

How to use eMerchant

1.4 Overview of Digital Mall

Digital Mall - Member Shopping Cart

Digital Mall lets other businesses and individuals sell their digital products through your online shopping
cart. It includes a system for members to join, manage their digital products and earn commissions
through a central order processing, payment processing, and product delivery system.

Digital Mall works in tandem with AShop Deluxe. AShop Deluxe must be installed for Digital Mall to
function.

Click here for a tour of Digital Mall.

Get Trial Key and Download Files.

Install Digital Mall.

How to Use Digital Mall

1.5 AShop License Agreement

Software License Agreement

Use of AShop Software is subject to the terms of this license agreement. Buying a license and using the
software signifies that you have read the license agreement and accept its terms. Violation of this
license agreement may void your right to technical support and subject you to legal action.

Ownership Of Software

http://www.ashopsoftware.com/emerchant-order-entry-tracking-software.htm
http://www.ashopsoftware.com/dlcounter/trialform.html
http://www.ashopsoftware.com/dlcounter/downloads.php
http://www.ashopsoftware.com/tour-dm/index.html
http://www.ashopsoftware.com/dlcounter/trialform.html
http://www.ashopsoftware.com/dlcounter/downloads.php


AShop Deluxe User Guide10

AShop Internet © Copyright 2002 - 2008

You acknowledge and agree that all of the computer programs and associated documentation
(collectively, the "Software") are owned exclusively by AShop Internet. You agree that the price paid by
you for the Software is a license fee granting you only the rights set forth in this License Agreement.

Licensed For Each Domain or IP Address
Your purchase of a Software license entitles you to install the program on a specific number or domains
or IP addresses. You may NOT copy, reproduce, resell, or give away copies of the Software in any way
shape or form without prior written consent from AShop Internet. You acknowledge that AShop Internet
periodically registers the Software with its license server by electronic transfer of information via the
internet to the ashopsoftware.com license server.

IonCube Decryption 
The distributed scripts are protected by IonCube encryption. We do not guarantee that the IonCube
decryption will work on all servers and hosting services. Troubleshooting of server configurations is not
included in our Software warranty. If you have trouble with IonCube decryption and cannot resolve it with
your hosting service or system administrator, then we recommend changing to a hosting service that
supports the software requirements.

License Fee Nonrefundable
Fees paid for license registration keys and installation services are not refundable. Before purchasing an
AShop Deluxe software license and receiving a permanent registration key, we recommend that you first
upload and run the pre-installation test script, which can be downloaded from our site. This small
program will report if the server supports the requirements of AShop Deluxe. It also installs IonCube
loaders and tests the IonCube decryption. If all of the tests pass, then install AShop Deluxe with a free
30-day trial key. When you are satisfied that the program will serve your needs, then purchase and
register a permanent license key to continue using the program.

Limited Warranty
AShop Internet warrants that the Software will perform without defect, within the functionality that is in
the program at the time of purchase. This warranty is for one year from the date of purchase. If you notify
AShop Internet of defects during the warranty period, AShop Internet will replace the defective program
media or, at its option, refund the purchase price. The Software is sold as is. We are a software
company selling a software product, not a custom development firm. We do not customize the software
for individual customers. Your remedy for breach of this warranty shall be limited to replacement or
refund and shall not encompass any other damages. No dealer, distributor, agent or employee of AShop
Internet is authorized to make any modification or addition to the warranty and remedies stated above.

Limitations Of Liability And Remedies
In no event shall AShop Internet or its licensors be liable for any loss of profit or any other commercial
damage, including but not limited to special, incidental, consequential, punitive or other damages, even if
AShop Internet or its licensors are advised, in advance, of the possibility of such damages. In no event
shall the liability of AShop Internet or its licensors exceed the purchase price paid for the Software.

Copyright © 2002-2008 – All Rights Reserved Worldwide
Webco Inc dba AShop Internet

1.6 Try Before You Buy!

Evaluate The Software Before Buying It!
We provide several methods to evaluate our shopping cart software before buying a permanent license
key. 
Technical support is free during trial periods so please try before you buy! 

http://www.ashopsoftware.com/ioncube-copy-protection.htm
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Permanent license key fees are not refundable.

· Free 30-day Trial Key - A free trial key may be used once per domain. Trial periods may be
extended by contacting our support team.  Installation of the software is not extremely complex, but it
does require a few basic webmaster skills. You must be able to create a mysql database, upload files
using FTP, and change a few file/folder permissions. Do-it-yourself installation is NOT recommended
for novices, however for or a fee we will install the software on your server.

· AShopCart Automated Shopping Cart Service - For a small setup fee the shopping cart software
is automatically installed within 5 minutes. The shopping cart program is hosted in a subdomain on
our server. FTP access is provided. This is a quick and cost effective way to evaluate the software
before buying a permanent license key. You may like the hosted shopping cart service and want to
stay there. If not, the shopping cart setup can easily be moved to the server where you domain is
hosted.

· Web Hosting Service - Installation service and technical support for our shopping cart and
ecommerce software is provided free for domains hosted on our servers.

1.7 How To Get Help

Step 1. Use This Help System.
If your issue can't be resolved this way, go to step 2.

· The table of contents on the left is organized in order of how the program is typically used.
· The Previous and Next links (top right) go through topics in order of the table of contents.
· Click the Keyword Index link (top left) to see an index of keywords, which are linked to relevant

topics.

· Context sensitive help topic links and tool tips  are located throughout the administration
panel pages. Context help links open the help topic in this system that relates to that page in the
administration panel. Tool tips pop-up brief explanations of specific functions within the shopping cart
admin panel.

Note: This help system uses frames and JavaScript. If the table of contents panel is not appearing on
the left, it is probably because you have an old browser or JavaScript is disabled. Download a current 
web browser to fix this.

To print help topics without printing the table of contents (Internet Explorer), right click in the right side
panel where the topic is located. A shortcut menu will open. Click "Print". This will send only the right
side (topic) panel to the printer.

Step 2. Submit Support Request or eMail 
If you don't find a solution in the help topics or if you prefer to hire someone to set up your web site and/
or to provide personal training, contact us through our secure contact form. A technician will respond by
email. Once your email address is in our system, you can send email directly to our support team.
Response time by email is typically within a few hours during business days and within 24 hours on
weekends & holidays. The secure contact form submissions and incoming email messages post directly
to our virtual support desk. All of our technicians are qualified to respond by email.

Step 3. Phone Support
If you need phone support, please submit a support request with your phone number and the best times

http://www.ashopsoftware.com/dlcounter/trialform.html
http://www.ashopcart.com/
http://www.ashopwebhosting.com/
http://en.wikipedia.org/wiki/Web_Browser
http://www.ashopsoftware.com/shopping-cart-software-support.htm
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to call. Someone will respond as soon as possible.

New Feature Requests
We appreciate your suggestions for improvements to AShop Deluxe. Each new feature is carefully
considered before adding to our development calendar. Each new version is developed and tested
extensively before releasing to the public. This process ensures consistent reliability in the software and
sustainability for our company. We are a software company selling a software product, not a custom
development firm. We do not customize the software for individual customers.

2 Installation & Setup

2.1 Install AShop Deluxe

Software Requirements:
· At least version 4.1.0 of PHP4 or any version of PHP5
· Safe Mode = Off 
· Enable dl() = On
· File Uploads = On
· MySQL Functions Available
· Curl With SSL Available
· Run-time notices = Off 
· The fsockopen-function is working
· IonCube decryption is working.
· The AShop Software license server can be reached

Pre-installation Test  Script - ashoptest.php
Before installing the program files, test the site to make sure that the IonCube encoded program files will
run on the server and that all of the server requirements are met. Download the pre-installation test script
. Instructions are included with it in a text file. Run the ashoptest.php script from a browser. If all of the
tests pass, go ahead with the installation.

License Agreement
AShop Deluxe is protected under US and International copyright laws. The software is licensed for use
per domain. Installing and using this software signifies that you have read and agree to the terms of our 
software license agreement.

Software Registration
The program files that are distributed from our shopping cart are encoded for copy protection and to
prevent hacking. A registration key is required to activate the program. A free 30-day trial key can be
used once for a domain. The trial period can be extended if you need more time to evaluate the software.
Permanent registration keys are available through our online store.

Installation of Software & Database

Install AShop Deluxe See separate instructions for installation of eMerchant.

1. Unzip the AShop program files on your local computer.

2. Ensure that your FTP client is set to upload php files and images in binary mode. Upload the

http://www.ashopsoftware.com/contact/
http://www.ashopsoftware.com/ioncube-copy-protection.htm
http://www.ashopsoftware.com/ioncube-copy-protection.htm
http://www.ashopsoftware.com/dlcounter/downloads.php
http://www.ashopsoftware.com/dlcounter/trialform.html
http://www.ashopsoftware.com/catalogue.php
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AShop files and folders to the server. The AShop Deluxe files and folders may be installed in the
public root directory or in a subdirectory. A single domain license can be used to install the
shopping cart in any number of subdirectories with different names. The AShop directory structure
must remain the same as in the distibution packate for each installation. Note that the Unix/Linux
file system is case sensitive. For instance, if you name the folder ashop in all lower case, the
setting within config.inc.php must also be ashop (not AShop). If the program files are installed in the
public root OrderForm pages will work anywhere in the public root and in subdirectories just below
the public root directory.

OR

  

Note: When AShop is installed in the public root directory, OrderForm code can easily be used in all of

the HTML pages in the public root and directories just below the public root directory. However, in this
case, other scripts running in the same public root directory, hidden files (.htaccess), and FrontPage
configuration may conflict with the AShop scripts. If there is a lot already going on in the public root or
you are not sure, it is safer to install AShop in a subdirectory.

3. Change permissions of the following directories and files to 777.  Note: The only gateway directories

that are required are the ones for the currencies that will actually be used by the shopping cart.
Unused gateway directories may be omitted.

· admin/fulfilment
· admin/gateways (only necessary if processing U.S. dollar)
· admin/gatewayscad (only necessary if processing Canada dollar)
· admin/gatewayseur (only necessary if processing Euro currency)
· admin/gatewaysgbp (only necessary if processing Great Britain pound)
· admin/gatewayssek (only necessary if processing Swedish Kroner)
· admin/gatewayssgd (only necessary if processing Singapore dollar)
· admin/receipts (if you want to save original customer receipts)
· admin/config.inc.php
· banners
· images
· images/logo.gif
· ioncube
· previews
· prodimg
· products
· updates
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Note: .htaccess files are included in the products and updates directories to protect product files.

These files may not appear within your FTP explorer on the server side after you have uploaded them,
but can usually be seen within your hosting services online file manager.

4. Create a database for AShop and add a user with a password to the database. If you do not have

access to create a mySQL database on your server, then contact your web host technical support
to have this done for you. You will need the path to the database (if it is not localhost), the database
name, user name and password. The user must have all privileges for database table mods and
creation of new tables.

5. Open config.inc.php in a text editor such as NotePad or within your FTP program and edit the

following variables BEFORE running install.php:

$databaseserver = "location of the mySQL database"
The database is usually located at "localhost". If the database is hosted remotely or on a different
server, this setting may be something like "mysql.server_name.com" or http://mysql.server_name.
com.

$databasename = "name of the database that you created in mySQL"
$databaseuser = "user name that you added to the database that you created"
$databasepasswd = "password for the user name that you added to the database"

 

6. Run install.php from a browser. This will create the database tables. To do this, enter something

like this into your browser address bar: http://www.yourdomain.com/install.php or http://
www.yourdomain.com/ashop/install.php depending on where the AShop files and directories are
located.

 

7. Enter your name, email address, and Registration Key Code in the spaces provided.

Third Party Software Integration

8. You will then be redirected to the third party software integration page. You can skip this step by

clicking the Skip This Step button at the bottom of the page. If you wish to add third party
integration later, it can be done through the admin panel in the Store Configuration > Shop
Parameters > Advanced Options menu. To add third party integration during the installation
process, enter the full server path for each supported third party software application that AShop
Deluxe will integrate to.

· ListMessenger (Lite and Pro)
· ListMail Pro
· phpBB
· AutoResponse Plus
· Password Administrator+ (PA+)
· Password Robot
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9. Remove the install.php file from the server.  Installation of the program files and database is now

completed. 

The next page will be the Administration Panel login. The default password is "ashopadmin". Login
and setup the Store Configuration, then Edit Catalog to add categories and products. For security we
recommend that you change the administrative password.  
  

Note: From now on, login to the Administration Panel by opening the /admin/login.php script.  
Example: http://www.yourdomain.com/ashop/admin/login.php

Setup Of Shopping Cart Design, Layout and Selling Options

Customize The Shopping Cart
After the initial installation of program files and the database is completed, the shopping cart can be
customized and configured in various ways. Shopping cart pages, receipts, email notices, images,
buttons, and page text for each language can be modified to suite your needs. Here is a quick list of the
most important considerations during initial setup.

Custom Page Templates
If you have not already seen the tour of AShop Deluxe, go back and look at the section about page
templates. It describes how page templates are included by the program. HTML templates are simply
HTML web pages with a place where the shopping cart content appears. A separate page template is
used for the catalog, delivery, checkout and affiliate support pages.

Layout Menu
Login to the admin panel. In the Store Configuration/Layout menu, set the default colors, sizes, fonts,
widths, borders, thumbnail image size, and various other parameters, which are used in the dynamically
generated areas of the shopping cart pages.

Pre-designed Themes
If you don't need custom page templates and you just want to begin using the cart with a canned look,
select a theme in the Layout menu. Themes can be a complete collection of page templates with
buttons and pre-configured Layout parameters. Or, themes may only include a set of buttons, or only
Layout parameters. Each them has a config file, which specifies how much it does and sets Layout

http://www.ashopsoftware.com/tour-dx/shopping-cart-templates-layout.htm
http://www.ashopsoftware.com/tour-dx/shopping-cart-templates-layout.htm
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parameters. The parameters in the theme.cfg.php file can be set so that the theme's config settings
override the admin panel Layout settings and if the theme includes page templates, they can override the
root AShop page templates.

What! No themes to select from? There is a selection of themes and buttons on our site, which may
be downloaded for free and used with AShop Deluxe. Select a theme package, download it to your
computer and unzip it. Upload the folder containing the theme to the themes directory where AShop is
installed. Then, select the theme in the Layout menu.

Language Sets
Each supported language has a unique set of files called a Language Set. When a language is selected
the program uses the corresponding language set. Each language set includes a set of images, a set of
language text files, and a set of receipt templates. To change the text in shopping cart pages, edit the
corresponding language file(s). The program file distribution packages contain only an English language
set. More language sets are available for download from our site.

Portable Catalog and Category Tree
The separate category tree and product listing areas of the catalog can be inserted into pages as
separate components and included in custom PHP and HTML pages. With this method, the category
tree can be placed on the right side of the page or omitted from the page entirely. There is no limit to the
number of custom catalog pages that can be made using this method.

Greeting Message & Content When Catalog Is First Opened
A file named first.html may be used to display product specials or messages to customers when the
catalog is first accessed. An example of first.html is included with the program file distribution package.
The first.html file works exactly opposite of page templates. Instead of the the content outside of the
tags being used by the program, the content between the <!--AShopstart --> <!-- AShopend --> tags
appears in the product listing area of the catalog when it is first opened. If the first.html file is not present
in the AShop root directory, then the catalog will instead open with the top product category appearing.

Separate Shopping Cart Buttons and Checkout Links In HTML Web Pages
AShop Deluxe supports several methods of linking to the shopping cart from HTML web pages and email
messages. See the Order-Link and OrderForm help topics. See the Order-Link Tech Tip for specific step
by step instructions. Also, some example files are included with distribution packages for new
installation.

Payment Processing Options
The shopping cart supports a variety of payment methods and integrates with most popular payment
services such as Authorize.net, PayPal, Verisign, Card Services International, WorldPay, and many
more. The degree of difficulty to set up each payment option varies widely. Instructions are provided as
needed for the payment services that are supported by AShop. If you do not find instructions for your
payment service in this help documentation, see if it is listed in the payment processor cross reference
chart. There might not be instructions if the payment option requires only the merchant ID to be entered
in AShop. If a payment service is not listed in the cross reference chart, it is probably not supported by
AShop.

Receipt (orderid) Numbers
When the shopping cart is installed, the first orderid number will begin at 1. New orderid numbers will
then auto increment from the highest existing orderid number in the orders database table each time a
new order is created. The beginning orderid number can be increased using a database management
tool such as phpMyAdmin. Either add a row with the higher orderid number or, if the highest existing
orderid number is not needed for anything else (for instance it is an incompleted/unpaid or a test order),

http://www.ashopsoftware.com/dlcounter/cart-themes.php
http://www.ashopsoftware.com/dlcounter/cart-buttons.php
http://www.ashopsoftware.com/dlcounter/downloads.php#language
http://www.ashopsoftware.com/techtips/orderlink1.htm
http://www.ashopsoftware.com/payment-processor-cross-reference.htm
http://www.ashopsoftware.com/payment-processor-cross-reference.htm
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change the highest orderid to the higher number. Subsequent new orders will then auto increment higher
orderid numbers. See also: Receipt and Order Reference Numbers

Time Zone Offset
Many times the server time is different than your time zone and some servers may be set by Greenwich
Mean Time (GMT). To adjust the time stamp for orders and stats, set the timezoneoffset in Store
Configuration > Shop Parameters > Advanced Options. The value of the offset is in seconds. To add time
enter only the digits. To subtract time, enter a minus sign in front of the digits. Example, Your time zone
is 2 hours later than the time zone of the server. To adjust the time so that it matches your zone on
receipts and notices, you would enter -7200, which is minus (60 seconds times 60 minutes times 2
hours).

Sales Taxes
If you are selling products that require sales tax calculations, visit Store Configuration > Taxes.

Shipping Calulations
If you are selling products that require shipping calculations, visit Store Configuration > Shipping.

Purchase Agreement Required Before Checkout
A purchase agreement may be included with acceptance required before checkout and payment. Create
a file named agreement.txt. Put text or HTML content in the agreement.txt and upload it to the
directory where AShop is installed. There is an agreementEXAMPLE.txt file included with the new
installation packages. The agreement will then be required for each order before checkout. Note: This is
completely separate from individual product license or terms of sale agreements.

Affiliate Program
If you are using the affiliate program, set up the default commission values before adding products.
Otherwise, skip this step.

Fulfilment Notices & Automated Processes
eMail notices can be sent automatically based on which products are ordered. An automation fulfilment
option can be used to activate third-party programs. SwiftCD automatic CD fulfilment service is also
supported. To send fulfilment notices or activate fulfilment automation, set up the fulfilment options first
and then assign each product to a fulfilment option.

Visit Counter
There is an automatic visit counter in catalogue.php and search.php, which counts unique visitors. The
current number of visitors, visitors today, and grand total (since last reset) displays in the admin panel
index page. 
See instructions to include the visit counter in other pages on the web site.

Technical Support
If you run into trouble, contact us. Technical support is free for trial installations. Technical support and
software updates are provided free for one year after a permanent registration key is purchased. After the
first year, technical support and software updates may be subscribed to for $60 annually. Technical
support, software updates, and installation service for our software is always provided free by request for
domains hosted with AShop Web Hosting Service and for AShopCart hosted shopping cart accounts.

2.2 Install eMerchant

Before installing eMerchant, install AShop Deluxe.

http://www.ashopsoftware.com/shopping-cart-software-support.htm
http://www.ashopwebhosting.com
http://ashopcart.com
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eMerchant program files are available to download from our site.

The AShop Deluxe license key must have eMerchant enabled. eMerchant is enabled in all free 30 day
trial keys. Permanent license keys may or may not have eMerchant enabled depending on how the key
is purchased. To verify the status of a license key, contact us.

Install eMerchant Program Files and Database Tables

1. Upload the emerchant directory and all of its contents to the same directory where AShop Deluxe is

installed.

2. Change permissions (chmod) the following directories to 777.

· emerchant/invoices
· emerchant/mail

3. Run emerchant/install.php from a browser. This will create the emerchant_ database tables. To do

this, enter something like this into your browser address bar: http://www.yourdomain.com/
emerchant/install.php or http://www.yourdomain.com/ashop/emerchant/install.php depending on
where the AShop files and directories are located.

The installation is complete, however before using eMerchant a few additional steps are required.

When logged into the AShop admin panel, there should now be an eMerchant link in the left nav bar. If it
does not appear, refresh the page. If the link still does not appear, ensure that the folder permissions are
set per instructions and run emerchant/install.php again. Click on the eMerchant nav link to configure

http://www.ashopsoftware.com/dlcounter/downloads.php
http://www.ashopsoftware.com/contact
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users and email.

eMerchant Setup and Configuration
See the following topics for additional setup instructions.

· eMail Configuration
· Add/Edit Users
· Recurring Billing
· Vendors and Products
· Contact Forms
· Quote Header/Footer

2.3 Install Digital Mall

Before installing Digital Mall, install AShop Deluxe.

Digital Mall program files are available to download from our site.

The AShop Deluxe license key must have Digital Mall enabled. Digital Mall is enabled in all free 30 day
trial keys. Permanent license keys may or may not have Digital Mall enabled depending on how the key
is purchased. To verify the status of a license key, contact us.

Install Digital Mall Program Files

Upload the members folder and the mall.php file to the directory where AShop Deluxe is installed.

Change the permissions (chmod) of the members directory to 777.

http://www.ashopsoftware.com/dlcounter/downloads.php
http://www.ashopsoftware.com/contact
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Shopping Mall Parameters

Set the Shopping Mall parameters in Store Configuration > Shop Parameters > Shopping Mall.

Login to the AShop Deluxe admin panel. When Digital Mall is activated and there is at least one
member, a username AND password is required to login. The username for the mall administrator is
ashopadmin. The password for ashopadmin is same as was previously set before the username
requirement was activated. 

Member Shop Directory - Page Template

If Individual Member Catalogs is enabled in Shopping Mall Parameters, modify the mall.html page
template or create a new one and upload it to the directory where AShop Deluxe is installed. If Individual
Member Catalogs is disabled, skip this step.

Administration Panel Images

Replace images that appear in the administration panel. Stay with the original image width to avoid
distortion of the admin panel pages.

The main image to replace is admin/adminlogo.gif, which appears above the main navigation on the left
side of the admin panel. (191 x 70 pixels recommended)
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Replace the AShop adminlogo.gif

with your own adminlogo.gif

You might also replace the admin/administration.gif image, which is at the top of the box that surrounds
the main navigation on the left. (The image that is distributed with the AShop Deluxe files has text
"Administration".) 189 x 39 pixels

Note: The login and admin panel background colors and table properties are presently hard coded into
the scripts. The hard coded parameters will soon be replaced with css to make these pages more
customizable.

Member Signup Form

The member signup form is displayed by navigating to the members directory or to the members/index.
php file. For example:
http://www.yourdomain.com/ashop/members or http://www.yourdomain/ashop/members/index.php

Edit or replace members/application.txt - The content of the members/application.txt file is included
at the top of the member signup form page. A description of the member program may be included in the
signup form page by editing or replacing this file. HTML may be used in the application.txt file to format
text and to include links and images.

Edit or replace members/signup.html - The members/index.php script uses the members/signup.
html page template. Create a page template or modify the example page template that is provided with
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the Digital Mall files. If a page template named signup.html is not present in the members directory, the
default logo image (images/logo.gif) will display at the top of the member signup page.

Add a link to the member signup page (members/index.php) from at least one page in your web site.
Typically the signup link goes in a web page where the mall and member program is described.

Edit the admin/admin.css file and change the loginform stylesheet to modify the look of the login form
page.

2.4 License Key Registration

A license key must be registered to activate the program. A trial key or a permanent key may be used
to register the program during the initial installation.

To re-register a license key or to replace a trial key, open the admin/register.php script in a browser.
For instance: http://www.yourdomain.com/ashop/admin/register.php. 
Enter the admin password and the license key, then click the Register button.

2.5 Page Templates

How AShop HTML Page Templates Work

If you have not already seen the tour of AShop Deluxe, go back and look at the section about page
templates. It describes how page templates are included by the program. The AShop page templates
are simply HTML pages with the AShop start and stop tags inserted where the AShop content is to

http://www.ashopsoftware.com/tour-dx/shopping-cart-templates-layout.htm
http://www.ashopsoftware.com/tour-dx/shopping-cart-templates-layout.htm
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appear or where to start and stop using content that is in the template. They are similar to include (.inc)
files. They can include HTML, images, links, CSS, and JavaScript just like any other web page. If you
are using a WYSIWYG HTML editor such as Dreamweaver, you can add the AShop script folders to
your website and create the AShop templates just as you would any other page within your website.
You can even use the "Create New Page From Template" feature and update the AShop template pages
along with other pages that are attached to the Dreamweaver Templates.

AShop page templates are simply HTML web pages with comment tags 
<!-- AShopstart --> <!-- AShopend -->  
inserted into the HTML code. For the page templates, AShop's dynamically generated content appears
between the two tags.

Note: If a template is not present, AShop will generate a catalog page anyway and the default logo.gif
image, which can be uploaded through the Layout menu, will appear at the top of the page above the
dynamically generated content. When a page template is present, it's body tags, such as background,
text, and link colors override default page settings made in Layout. Colors, fonts, and borders within the
dynamically generated content are still controlled through the administration panel, regardless of whether
a template is present unless there is a style sheet that overrides it.

There are five templates used for the retail shopping cart and affiliate pages. If the wholesale shopping
cart is activated, it has an additional 4 templates. The page templates can have the same or different
content, depending on your needs.

Example templates are included in the distribution package for new installations. The template examples
are not included in distribution of updates.

Retail Shopping Cart & Affiliate Page Templates

The following templates are located in the root directory of AShop.
The <!-- AShopstart --> <!-- AShopend --> tags indicate where the shopping cart content is
rendered on the page.

catalogue.html – used only in the catalog pages.

cart.html – used only by the basket and checkout pages

delivery.html – used only in the product delivery pages

thankyou.html – used only in the payment confirmation pages

IMPORTANT! Many payment gateways will host your payment confirmation page through their SSL
connection. When they do this, they take a snap shot of your page and nest it within their page at their
URL. If this is the case, the hyperlinks within the thankyou.html template must use absolute URL's for
links to work and for images to appear. In addition, image links should be https links so that browser
secure/non-secure content warning messages won't appear for customers when the payment processor
redirects to the thankyou (payment confirmation) page.

There is one template in the affiliate subdirectory.

affiliate/template.html – This template is only used with the affiliate sign up, login, and support pages.

Note: Other comments that you can use in your page templates are <!-- AShopname --> which will
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display your Shop Name and <!-- AShoplogo --> which will display your Logo Image.

Wholesale Shopping Cart & Sign up Page Templates

These templates are located within the wholesale directory and are only used for the wholesale catalog
pages.

wholesale/catalogue.html - used only in the wholesale catalog pages.

wholesale/cart.html - used only in the wholesale basket and checkout pages.

wholesale/signup.html - used only for the pages where wholesale customers sign up for an account.

wholesale/delivery.html - used only in the wholesale order confirmation and product delivery pages.

Digital Mall Page Templates (only used if Digital Mall is installed.)

mall.html - used by mall.php for member signup and member shop directory.
members/signup.html - used by members/index.php for new member signup form page.

2.6 Style Sheets - CSS

Some of the settings in the Layout menu are used to set styles in catalog pages. Styles and cascading
style sheets or CSS may be used to add parameters and/or override the default Layout settings.

Style Classes In Catalog Pages
Layout settings such as text color and font type are wrapped outside of the fontsize class spans so that
color and font types specified in the styles will override the Layout menu settings. To customize the
pages using CSS, either define the styles in the head of each AShop page template or create your own
style sheet and link to it in the AShop page template.

.fontsize1 sets the style for small text that appears in shopping pages. For example, after a product is
added to the cart in catalogue.php a small confirmation message appears underneath the subtotal box
and View/Checkout buttons and above thumbnail images there may be a "Click to enlarge." link.

.fontsize2 sets the style for most page body text and the category tree link text.
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.fontsize3 sets the style for text in category titles and product names.

.tablesize1 is used in the following pages. The Layout setting "Large tablesize" sets the width
parameter for the tables that use this style class. Style sheet settings may be used to override the
Layout width setting and also to add more table parameters.

· View Cart listings (basket.php)
· Payment Forms (orderform.php and giftform.php)
· Affiliate Sign-up Form (affiliate/signupform.php) 

.tablesize2 is used in the following pages.  The Layout setting "Regular tablesize" sets the width
parameter for the tables that use this style class. Style sheet settings may be used to override the
Layout width setting and also to add more table parameters.

· Payment Selection (checkout.php and wholesale/checkout.php)
· Shipping Destination Form (shipping.php)
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Admin Login Page

The admin panel login page, admin/login.php, uses the admin/admin.css style sheet.
.loginform sets the table properties in the admin/login.php page. If Digital Mall is installed, this is also
the member login page.

2.7 First.html

A greeting may be included in the product listing area of the page when the catalog is first opened.

The content for this greeting is from the first.html file. An example first.html file is included with AShop
Deluxe new installation packages. Content between the <!-- AShopstart --> <!-- AShopend --> HTML
web page comments appears in the product listing area of the catalog when it is first opened. The
content can be plain text or HTML.
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This method works in the pages generated by catalogue.php and also in custom web pages where the
product listing area is included as a separate object. If the first.html file is removed or renamed, the top
category of products appears in the product listing area when the catalog page is first opened.

2.8 Receipt Templates

Receipts in AShop Deluxe can be sent in either HTML or plain text format. Select the receipt format in
Store Configuration > Shop Parameters.

English language receipt templates are included in the AShop Deluxe new installation package. Receipt
templates for other languages are downloadable from our web site. The receipt templates can be edited
to suit your needs. Customer and order information is included in the receipts by using %tokens%. See
below for more about editing receipt templates.

http://www.ashopsoftware.com/dlcounter/downloads.php#language
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Save & View Original Receipts

To save original receipts,  change the permissions of the admin/receipts directory to 777. A copy of the
exact orginal receipt that is sent to each customer will then be saved in the receipts directory and
named with the Order ID number.

There are two places where the original receipt may be accessed through the admin panel Manage
Sales menu.

· Sales Reports - Navigate to Sales Reports. Click the Order ID number link and then select to view
or download the receipt.

· Customer History - Navigate to a customer record through customers and messaging and click on

the history link . Click on the Order ID number link and then select to view or download the
receipt.
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Resending Receipts and Re-activing Orders
A copy of the original receipt can be resent from Sales Reports in edit mode. If the order included
downloadable products, the download may be reactivated at the same time.

Editing Receipt Template Layout and Content

Receipt templates are in the admin directory. There are two receipt templates for each language; html
and text. Receipt templates are named with -en, -sp, -it, -jp, and so on to indicate the language.
Example: English language receipts are named receipt-en.html and receipt-en.txt. Modify the text in
receipt templates as needed, but do not change or remove the divider comment tags and token names.

Here is a list of tokens and how they are used in receipt templates.

%ashopname% The name of your store  
%dateshort% Date of the order     
%invoice% Invoice/Order number  
%customer_firstname% Customer's first name  
%customer_lastname% Customer's last name  
%customer_address% Customer's street address  
%customer_city% Customer's city  
%customer_state% Customer's state  
%customer_zip% Customer's zip code  
%customer_country% Customer's country  
%customer_email% Customer's email address  
%customer_phone% Customer's phone number  
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%customer_info% Extra Form Fields
%receipt_description%  
%payoption% Method of payment used  
%payoptionfee% Fee charged for using specified payment method  
%subtotal% Total before taxes and shipping  
%salestax% Tax total  
%shipping% Shipping costs  
%amount% Total cost billed  
 
<!-- Shippingdiscount --> Display shipping discount (if any)  
%shippingdiscount% Discount on shipping  
<!-- /Shippingdiscount -->  
 
 
<!-- Specialinstructions --> Determines whether any special instructions are to be sent

with the receipt. Necessary for all the following sections of the
receipt to be displayed.  

 
<!-- Shippingaddress --> Display shipping information (if product is shippable)  
%customer_shippingaddress% Customer's ship to address  
 
<!-- Shippingoption --> Display method of shipment (if any)  
%shipoptions% Method of planned shipment  
<!-- /Shippingoption -->  
 
<!-- /Shippingaddress -->  
 
<!-- Downloads --> Display information for download instructions (if applicable)  
%ashopurl% Your store's location as a link for product delivery  
%customer_email% Customer's email address  
%password% Password for customer to download product file  
%downloadtimes% Number of times download can occur  
%downloaddays% Number of days download is available for  
<!-- /Downloads -->  
 
<!-- Unlockkeys --> Display unlock keys (if any)  
%unlockkeys% Any Software Registration Keys  
<!-- /Unlockkeys -->  
 
<!-- Subscriptions --> Display instructions on how to access the subscribed directory
(if applicable)  
%subscriptionlinks% Link to the password protected directory subscribed  
%password% Password to access protected directory  
<!--/ Subscriptions -->  
 
<!-- Manualpayment --> Display notice that the payment was made using the Manual
Handling payment option.  
<!-- /Manualpayment -->  
 
<!-- /Specialinstructions --> End Special Instructions portion of the receipt.  
 
%ashopname% Your Shop Name  
%ashopaddress% Your Shop Address  
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%ashopemail% Your Shop Email  
%ashopphone% Your Shop phone number  
 
<!-- Membershop --> Displays if order came from a Digital Mall member's catalog  
%membershop% Digital Mall member's shop name  
<!-- /Membershop -->

2.9 Receipt Numbers

Receipt (orderid) Numbers
When the shopping cart is installed, the first orderid number will begin at 1. New orderid numbers will
then auto increment from the highest existing orderid number in the orders database table each time a
new order is created.

The beginning orderid number can be increased using a database management tool such as
phpMyAdmin. Most hosting services provide phpMyAdmin. In Plesk it is called DB WebAdmin.

Browse the database table named orders.
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Either add a row with the higher orderid number or, if the highest existing orderid number is not needed
for anything else (for instance it is an incompleted/unpaid or a test order), change the highest orderid to
the higher number and save the change (click Go).

 Subsequent new orders will then auto increment to higher orderid numbers.
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2.10 Separate Catalog Components

The category tree and product listing area of the catalog may be inserted into PHP and HTML pages as
separate components. An unlimited number of unique catalog pages with different file names may be
created using this method.

This method only works in local web pages (in the same domain where AShop Deluxe is installed).
It does not work in web pages that are located in other web sites.

Custom Catalog Page Layout
The category tree and product listing areas can be placed separately within each web page.
See also custom navigation links.

 The product listing area can be included separately...

...and the category tree can be included separately.
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PHP tags are used to include the product listing and/or category tree as separate components within
local web pages. The includes will work in files ending with .php extension. The includes will also work in
.htm and .html files if PHP is enabled for HTM, HTML files.

Example Files
Example files, which use this method are distributed with the AShop Deluxe program files. 
The file names are shop.html and find.html

Include the Product Listings

Include the following PHP code in the source code for the body of the page where the product listings
are to appear. Change the parameters as instructed.

<?php
$search = "find.html"; $categories = "off"; $catalog = "shop.html"; include "catalogue.php";
?>

The include catalogue.php"; parameter must point to the catalogue.php script, which is in the
directory where AShop Deluxe is installed. If this new page is in the same directory as catalogue.php,
set it as shown above. If catalogue.php is in a different directory, set the path accordingly. For example,
"../catalogue.php" (to go up one directory) or "store/catalogue.php" (to go down to a specific directory).

Set the $catalog parameter to the same page (where this PHP include is located) or to a different
page where catalogue.php is also included with this method.

Show or Hide Category Tree (Within Product Listing Area)

· $categories = "on"; With categories set to on, the category tree appears within the product listing
area, to the left of the product listings.

· $categories = "off"; With categories set to off, the category tree does not appear within the product
listing area. It may still be included separately in a different location within the page. see Include
Category Tree below.

Search Box Options

· $search = "off"; The search box does not appear in the page.
Example:
<?php
$search = "off"; $categories = "off"; $catalog = "shop.html"; include "catalogue.php";
?>

· $search = "find.html"; The search box is activated and it appears above the product listings. Use
this same include method to create a second page where the search results will appear. The search
results page can be a copy of the catalog page with a different file name or it may be a different
design, but it must exist and it must have this catalogue.php include in the page. In the example file
that is included with the AShop Deluxe new installation file package, find.html is simply a copy of the
shop.html page and the file name has been changed.

· $search = "shop.html"; The search box is activated and it appears above the product listings. In this
case, the search results page is same as the catalog= page so that the search results will appear in
the same page. (Change the filename to match the actual file in your site.)
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IMPORTANT! For search results to appear in the same catalog page, an if statement must be
added in the php code.

<?php
$search="shop.html"; $categories = "off"; $catalog = "shop.html"; if (!$searchstring) include
"catalogue.php"; else include "search.php";
?>

Include the Category Tree

Include Category Tree In Catalog Page
Include the category tree in the same page where catalogue.php is included by inserting this PHP tag
into the page.

<?php
include "categories.php"; 
?>

Include Category Tree In Site Navigation
The category tree may be included in site navigation by adding a catalogue.php="shop.html" parameter.
This parameter points to the page where the product listings are to appear. For example, when the
category tree is in a page that does not have any way to show products and a category is selected, the
product listings for that category need a place to appear in a page. In these examples the product listing
page is shop.html. Change this to match the actual product listing page(s) in your site.

Insert the following php statement to include the category tree in a page where the catalogue.php include
is NOT present in the same page. IMPORTANT! The $catalog variable must precede the categories.php
include in this php statement.

<?php $catalog = "shop.html"; include "categories.php"; ?>

This example will make all links in the category list open in the shop.html page. Change the $catalog=
variable to match the actual page in the site. The page that the catalog= variable points to must either be
catalogue.php or it must have the catalogue.php include in the page so that the product listings (for the
selected category) will appear in the body of the page.
 
To include the category tree in a subdirectory below the directory where AShop is installed, add a chdir
(""); parameter.

Example 1: Category include is in a page one directory below the AShop root.

<?php
chdir("../"); $catalog = "../shop.html"; include "categories.php";
?>

Example 2: Category include is in a page above the "ashop" directory.

<?php
chdir("ashop"); $catalog = "ashop/shop.html"; include "categories.php";
?>

Web Sites That Use Frames
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The separate category tree and product listing includes can be used in frames, but the Continue
Shopping button and the Check out and View cart pages will NOT work when located in a different frame.
Frames are not supported by our technical service.

2.11 Custom Navigation Links

Custom Navigation Links
Custom navigation can be used to allow selection of only specific products or categories. Language
selection can also be done through custom navigation links.

· Search URL - The search.php script can be called with a searchstring parameter. This will list only
products that contain the searchstring in the name or description. A unique string of characters can be
included in each product description. When a search is performed only matching products will appear.
A customized search system can be created this way. 
Example: http://yourdomain.com/search.php?searchstring=productcode123

Here is a tip for using search.php to filter the product listings. Include a unique text string in each
product name or description. To group products in searches, use a simple product code. For instance
a book that is fiction and is by an author with code name Hort and it is his 1st book might have a code
"BFHort1". A link to search.php?searchstring=BFHort1 will display only that product. However, a
link to search.php?searchstring=BFHort will display all of the fiction books by that author. To hide
the product codes so that they do not appear in catalog pages, put the codes between HTML
comment tags. <!-- productcode -->

· Category URL - A specific category of products can be listed by including a cat= parameter in the
URL to the page.
Example 1: http://yourdomain.com/catalogue.php?cat=2 will open the catalog page products
that are in category number 2.
Example 2: http://yourdomain.com/shop.htm?cat=2 will open a custom catalog page showing
products in category number 2.

· Product URL - A specific product listing in the catalog may be displayed by calling catalogue.php and
by including a product ID parameter.
Example 1: http://yourdomain.com/catalogue.php?product=123 will open the catalog page
showing product ID 123.
Example 2: http://yourdomain.com/shop.htm?cat=2 will open a custom catalog page showing
product ID 123.

Redirect Parameters In Language Selection URLs
A redirect URL may be one of the parameters in a language selection URL. For example this URL will
set the language preference to sp (Spanish) and redirect to http://thewebsite.com/redirect.htm.
http://thewebsite.com/language.php?language=sp&redirect=http://thewebsite.com/redirect.htm

Nesting Parameters Within Language Selection URLs
It may be necessary to include more than one parameter within the redirect URL. To add a product
without setting a language preference, the shipping.php or basket.php script is called with parameters to
specify product information.
http://thewebsite.com/shipping.php?product=26&quantity=1

What if you want to set the language preference AND add a product to the cart at the same time? If the
redirect URL with more than one parameter is appended to the language.php URL with its multiple
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parameters a conflict is created. The ampersand between the redirect URL parameters will be interpreted
by the browser as part of the first set of parameters, which will break the second set of parameters and
prevent the product from being added to the cart. To enable nested parameters such as this, the
language.php script recognizes the pipe character as a replacement for the ampersand.

Substitute the pipe character in place of the ampersand character in the redirect URL parameters to
make the product and quantity parameters work. For example, this URL will set the language preference
to sp and add quantity 1 of product 26 to the cart with one click.
http://thewebsite.com/language.php?language=sp&redirect=http://thewebsite.com/shipping.php?
product=26|quantity=1

2.12 Most Popular and Recently Added Products

The top products and latest additions may be displayed in shopping cart catalog and search pages by
inserting PHP code in the page where it is to appear.

The top.js.php script may be included in...
· page templates
· custom shopping cart pages that use the separate catalog and category includes
· other local web pages that support PHP includes

<script language="JavaScript" src="top.js.php"></script>

Parameters may be added to the src in order to modify the actions of the script. To add one parameter,
first add a question mark "?" and then add the parameter. If more than one parameter is specified, add
an ampersand "&" after the first parameter and to separate additional parameters. Here is an example.

<script language="JavaScript" src="top.js.php?items=5&redirect=product.html"></script>

Number of Products Shown
If not otherwise specified, the top.js.php script will display the last 10 new products and latest additions.
To display a lower number of products,  add the parameter "items=x" where x is the number of products
to display.

This include will display the 5 most popular and latest additions.
<script language="JavaScript" src="top.js.php?items=5"></script>
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Redirect To A Different Product Page
In shops where only custom catalog pages are used and a direct link to catalogue.php is not desired,
the top.js.php product links can be redirected to the custom catalog pages by adding a "redirect=x"
parameter, where x is the local file name or URL.

This include will display the 10 most popular and latest additions in a custom product page named
"product.html".
<script language="JavaScript" src="top.js.php?redirect=product.html"></script>

Table Header Text
The text that appears at the top of the listings is set in the corresponding language file, language/xx/
topjs.inc.php, where xx is the language abbreviation. For example, the text for English language is
set in language/en/topjs.inc.php.

Layout, Colors, and Fonts
The table borders, background colors, and fonts can be controlled through the Layout menu and with
style sheets (CSS).

2.13 Purchase Agreement

An agreement page can appear when your customers click the Check Out button.
Customers must then click the Accept button to proceed to the payment form.

The agreement page feature is activated when a file named agreement.txt exists in the directory where
AShop is installed on your server. For example, http://www.yourdomain.com/ashop/agreement.txt

An example file named agreementEXAMPLE.txt is included with the AShop new installation packages.
To use the example file, rename it to agreement.txt and modify the content as needed. The content can
be plain text or HTML.
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2.14 Language Selection

Language Selection For The Retail Catalog and Customer Messages

The language that is displayed in the retail catalog and in receipts to retail customers can be selected
and set as a preference for each customer. If no language is selected, the preference defaults to
English.

The preferred language is set in a cookie by navigating to the language.php script and then clicking on a
language icon/link or by navigating to the language.php script with a language parameter appended to
the URL.
Example: http://www.yourdomain.com/ashop/language.php?language=en

New installation packages for AShop Deluxe include only the English language set.

Download other language file sets from our website at:
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http://www.ashopsoftware.com/dlcounter/downloads.php

Language selection can only be done for language sets that have been installed in AShop.

2.15 Language Specific Files and Folders

There are three areas that have language specific files. Each language is identified by a 2 character
abbreviation, which is used for language subdirectory name, for image file names, and in receipt.html file
names. For instance; en for English, sv for Swedish, etc.

1. Text that retail customers see on pages is kept in editable language files, which are kept in

a subdirectory of the language directory. Each language has its own subdirectory named with the 2
character abbreviation and in each language subdirectory there is a complete set of include (inc)
files, which are named to correspond to the script that uses each one. The text in the language files
is defined as constants, which are then selected and used by the program files based upon the
language preference for each customer.

2. There is a complete set of images for each language, which are all kept in the images

directory. The language for button images that have text is identified by the 2 character suffix. For
instance, buy-en.gif is the name of a buy button image that is used for English language.

http://www.ashopsoftware.com/dlcounter/downloads.php#language
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3. There is a set of receipt templates for each language. The receipt templates are located in the

admin directory. There is a plain text receipt template and an HTML receipt template for each
language. Plain text or HTML receipt is selected through the admin panel > Store Configuration >
Shop Parameters menu.

Tokens are used to show customer and order information in the receipt. Start and stop comments
are used to separate each section.

clip of receipt-en.html file

A set of English receipt templates is included with the AShop Deluxe new installation package.
Receipt templates are also included with each language set.

If there isn't a receipt template for the language that the customer has selected, the default one
named receipt.html, which is distributed in English language, will be used. To change to a different
default language for the receipt copy the language specific template to receipt.html. To make all
receipts use the same language you would simply remove all the language specific templates and
keep only receipt.html.

See also: Add A Language Set

2.16 Add A Language Set

To create a new complete language set...

1. Make a copy of the set of files that are in the language/en directory and rename it with the 2
character abbreviation for the language, for instance French is fr, Spanish is sp, etc. Translate the
text in all of the files within the new directory. The words with all capital letters on the left hand side
are the constant names. DON'T CHANGE THE CONSTANT NAMES. The text is on the right hand
side in each line. If you use quotes (single ' or double " ) escape them with a backslash \" or there
will be parse errors when you run the scripts. For some languages, such as French, apostrophes
are used often to accent characters. If the special characters cause parse errors, replace them with
the ascii equivalent. Example: n&#039; in the html source displays n' (n followed by an apostrophe/

accent) in the web page.

http://www.ashopsoftware.com/dlcounter/downloads.php#language
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above is an English language file
below is the same language file translated in

Japanese

2. Edit the lang.cfg.php file. Change the language name. Set the $langredirect if using language
specific catalog pages. Leave the $langredirect empty for the catalogue.php script to open when a
language is selected.

3. Create a set of button images with text in that language. Name the images with the 2
character suffix just as the -en and -sv images are already named. The buttons must be in gif
format.

catviewcart-en.gif (english) catviewcart-sp.gif (spanish)

4. Make a copy of admin/receipt-en.html and/or admin/receipt-en.txt (if using plain text
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receipts), translate the text, rename and save it with the corresponding 2 character language suffix.

See also: Language Selectable Catalog Pages

2.17 Language Selectable Catalog Pages

Language Specific Catalog Pages
The product listing area and the category tree can be inserted into php or html pages as separate
includes. There is no limit to the number of unique pages that can be created in this way. In addition,
each category in the catalog can be set to open only for a specific language. These two features can be
combined to create a system of language selection with custom pages and unique product listings for
each language.

See the languages demo.

2.18 Order-Link Ordering Method

The Order-Link method supports Add to Cart, View Cart, and Check Out functionality within HTML
pages. The Order-Links may be located on the local server, on a remote server, or within email
messages.

Order-Link Code Basic Behavior and Customization
The basic Order-Link html code may be copied directly from each product listing in the AShop admin
panel and pasted directly into the source code of a web page, however typically modifications are
needed so that it works best within the context of each store design, for the marketing method, and for
the type of products that are being sold. This topic describes the basics of the html code. For additional
step by step examples and screen shots also see the Order-Link Tech Tip.

The three main scripts used for Order-Link are shipping.php, basket.php, and checkout.php. The scripts
may be run by linking to them or from an html form post. Parameters are added to specify product
information and Order-Link behavior. 

Customer Shipping/Tax Information Form Page
Products that are shippable or taxable require collection of shipping information from each customer. The
shipping information must be collected sometime before checkout, but it is optional to ask for it during
the shopping session or at checkout. Use shipping.php for buy buttons to collect the shipping address
before viewing the cart. Use basket.php for buy buttons to allow shopping before entering the shipping
address.

shipping.php - The shipping.php script is used to add products to the cart and to collect address
information for shipping or sales tax. It can also be used for checkout by specifying the parameter

http://languages.ashopcart.com
http://www.ashopsoftware.com/techtips/orderlink1.htm
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"action=checkout" in the link. The Order-Link (buy link/button) html code that is copied directly from the
AShop admin panel runs the shipping.php script. With shipping.php, when shippable or taxable products
are added to the cart the shipping information form appears (before the View Cart page) so that shipping
and taxes will be included in the View Cart page from the beginning of the shopping session.

basket.php - The basket.php script is used to add products to the cart or to view the cart contents. To
View Cart, link to basket.php without any parameters. For Add to Cart and Buy links, parameters must
be added to specify the products.  When a product is added to the cart with a link to basket.php, the
View Cart page opens (without first asking for shipping address first) even if shippable or taxable
products are added. In the View Cart page there will be a link to calculate shipping/taxes. With this
method, it is optional for customers to click the calculate shipping/taxes link in the View Cart page at
any time during the shopping session. If the shipping address is needed and it has not been entered yet,
the shipping address page will open before checkout can be completed. The Order-Link (buy link/button)
html code that is copied directly from the AShop admin panel runs the shipping.php script. To change
the shipping address behavior as described, change the Order-Links so that they link to the basket.php
script instead.

add=1 Parameter
The Order-Link (buy link/button) html code that is copied directly from the AShop admin panel does not
include an add=1 parameter. This must be added in order to allow more than one product to be added to
the cart. If the add=1 parameter is not included, each time a product is added it will replace any
previously added product. See examples below....

checkout.php - If there are shippable or taxable products in the cart, links to checkout.php will open the
shipping information page (shipping.php). When the shipping address is submitted, the checkout will
continue to the payment form page or the payment option selection page (depending on if there is more
than one payment option). If there are not any shippable or taxable products in the cart, a link to
checkout.php will go directly to the payment page or payment options.

How to Create an Add to Cart Order-Link Form
For each product Add to Cart button, add a form and set the product ID accordingly. The product ID is
listed next to each product within the Administration Panel > Edit Products.

Here is an example. The required parameters (for products without attributes) are quantity, product, and
add.

<form method="get" action="http://www.yourdomain.com/ashop/basket.php">
<input type="hidden" name="quantity" value="1">
<input type="hidden" name="product" value="1">
<input type="hidden" name="add" value="1">
<input type="submit" name="Submit" value="Add to Cart">
</form>

Note: When a form is inserted inside of a table cell, it may cause unwanted enlargement of the table cell
and distort the intended page design in some browsers. To avoid this problem, put the <form> and </
form> tags between the <tr><td> and the </tr></td> tags.
For example: <tr><form><td> and </tr></form></td>
This is not specifically WC3 compliant, but it works :-)

For quantity selection, substitute a text box in place of the hidden field.
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<input type="text" name="quantity" value="18" size="2" maxlength="2">

A drop-down selection box can be substituted for to offer only fixed quantities.

<select name="product">
    <option value="1" selected>1</option>
    <option value="2">2</option>
    <option value="3">3</option>
    <option value="4">4</option>
    <option value="5">5</option>
</select>

Add to Cart Order-Link Hyperlink With Text Or Image
A hyperlink may be used instead of the form.
<a href="http://www.yourdomain.com/ashop/basket.php?quantity=1&product=1&add=1">Add to Cart</
a>
or an image.
<a href="http://www.yourdomain.com/ashop/basket.php?quantity=1&product=1&add=1"><img
src="addtocart.gif"></a>

Change the quantity= and product= parameters accordingly.
The productid is listed next to each product in Edit Catalog.

Single Product Order Link
Omit the add=1 parameter for single product orders. This will clear the basket each time before the
product is added.
<href="http://yourdomain.com/ashop/shipping.php?quantity=1&product=1&action=checkout">Buy
Now</a>

To go directly to the payment form without viewing the cart.
http://www.yourdomain.com/ashop/shipping.php?quantity=1&product=1&action=checkout
Note that if the product has shipping or taxable set, the shipping information form will appear first.

View Cart Text Link
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<href="http://www.yourdomain.com/ashop/basket.php">View Cart</a>

Check Out Text Link 
<href="http://www.yourdomain.com/ashop/shipping.php?action=checkout">Check Out</a>

View Cart Image Link
<http://www.yourdomain.com/ashop/basket.php><img src="viewcart.gif"></a>

Check Out Image Link
<http://www.yourdomain.com/ashop/shipping.php?action=checkout><img src="checkout.gif"></a>

View Cart Form Button
<form method="get" action="http://www.yourdomain.com/ashop/basket.php">
<input type="submit" name="Submit" value="View Cart"></form>

Check Out Form Button
<form method="get" action="http://www.yourdomain.com/ashop/shipping.php">
<input type="hidden" name="action" value="checkout">
<input type="submit" name="Submit" value="Check Out"></form>

Return URL (Link from thank you page)
The default URL for the "Link from thank you page" is set in Shop Parameters. It may be overridden and
specified for each order by including a returnurl parameter in the Order-Link checkout URL. The returnurl
is stored in the orders table and used for the thank you page "Back to (ashopname)" URL after payment
has been processed.

The following example sets the return URL to http://www.mydomain.com/mypage.html.
http://www.yourdomain.com/ashop/shipping.php?action=checkout&returnurl=http://www.mydomain.com/
mypage.html
http://www.yourdomain.com/ashop/shipping.php?product=111&quantity=1&returnurl=http://www.
mydomain.com/mypage.html

How to include attributes in Order-Link URLs
The Order-Link method can be used to set an attribute by posting the parameter "attribute" with the
value "$attributeid:$valueid" to shipping.php, like this:
http://www.yourdomain.com/ashop/shipping.php?product=123&quantity=1&attribute=34:56

If there is only one attribute, it is simple to copy the URL from the link tool, which is displayed in the
attribute alternatives page.
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To specify more than one attribute, put a separator between each attribute:alternative parameter like
this.
http://www.yourdomain.com/ashop/shipping.php?product=123&quantity=1&attribute=34:56|
43:81

URLs are not automatically generated by the link tool for multiple attributes and alternatives, however the
individual parameters can be obtained by viewing each of the attribute alternatives and then appended to
create each combination of attributes and alternatives. The parameters can be obtained by viewing the
Order-Link for each alternative.

It may help to make a chart. For example. Lets say that we have a t-shirt product, which is available in 2
colors and 4 sizes. The parameters in the left column are for white or black and the parameters accross
the top are for sizes. The attributes and alternatives are combined for each possiblity where they
intersect in the chart.

Sml 65:708 Med 65:709 Lrg 65:710 XL 65:711
White 68:718 68:718|65:708 68:718|65:709 68:718|65:710 68:718|65:711

Black 68:719 68:719|65:708 68:719|65:709 68:719|65:710 68:719|65:711

The appended attributes can be used to create an individual buy now link for each combination. 
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For example, this link would buy one small white shirt.
http://www.yourdomain.com/ashop/shipping.php?product=151&quantity=1&attribute=68:718|

65:708

To change the link so that more than one product can be added to the cart, include the
"add=1" attribute.
http://www.yourdomain.com/ashop/shipping.php?product=151&quantity=1&add=1

&attribute=68:718|65:708

To create a form with drop-down selectors, copy the Order-Link form code from the link code generator
for the main product.

The form code can then be modified to work in various ways. Here it is cleaned up and aligned so that it
is easier to read.

<form action="shipping.php" method="post">
<input type="hidden" name="product" value="151">
Quantity: <input type="text" name="quantity" size="5" value="1">
Sizes: <select name="attribute65">
<option value="708">Sml
<option value="709">Med
<option value="710">Lrg
<option value="711">X L</select>
Color: <select name="attribute68">
<option value="718">White
<option value="719">Black</select>
<input type="submit" value="Buy now">
</form>

The add=1 Parameter
The form code copied directly from the AShop admin panel is for buying a single item. When a product
is added, any previous products are cleared from the basket. To convert the form into an Add to cart
button, include the "add=1" parameter so that more than one product can be added to the cart. To view
the basket before requesting shipping information, change the form action="shipping.php" to form
action="basket.php". Here is an example.

<form action="basket.php" method="post">

<input type="hidden" name="add" value="1">

<input type="hidden" name="product" value="151">
Quantity: <input type="text" name="quantity" size="5" value="1">
Sizes: <select name="attribute65">
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<option value="708">Sml
<option value="709">Med
<option value="710">Lrg
<option value="711">X L</select>
Color: <select name="attribute68">
<option value="718">White
<option value="719">Black</select>
<input type="submit" value="Buy now">
</form>

Language Preference and Order-Link

Language preference must be set at the beginning of each shopping session. This is done by linking to
the language.php script with language and redirect parameters. Here is an example:
http://yourdomain.com/ashop/language.php?language=sp&redirect=http://www.yourdomain.com/
SpanishOrderPage.html

By running the language.php script first, it sets the language preference in a cookie and redirects to the
Spanish order page. Then when products are added to the basket, the AShop scripts will read the
language preference from the cookie and display View Cart and other pages in the same language.
When the customer checks out the language preference is saved in the database so that future receipts
and notices will be in the same language for each customer.

2.19 Multi-Product Buy Form

To add more than one product to the cart with one button, call the multiproductbuy.php script with a form
post. An example of the form code is included with the AShop Deluxe distribution package in the file
named multiproductEXAMPLE.html.

Here is the example code. Change the products value to match the actual productid numbers or each
product as listed in the admin panel under Edit Catalog. The returnurl value is where the Continue
Shopping button returns to. If not set, the Continue Shopping button will return to catalogue.php. This
URL can be set to return to the same order page or to another page of ordering options. It may be set as
a relative URL (multiproductEXAMPLE.html) or an absolute URL (http://yoursite.com/ashop/
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multiproductEXAMPLE.html).

<form action="multiproductbuy.php" method="post">
  <p>
    <input name="products[]" type="checkbox" id="products" value="126">
    Product 126</p>
  <p> 
    <input name="products[]" type="checkbox" id="products" value="111">
    Product 111</p>
  <p> 
    <input name="products[]" type="checkbox" id="products" value="115">
    Product 115</p>
  <p> 
    <input type="submit" name="Submit" value="Add to cart">
    <input name="returnurl" type="hidden" id="returnurl" value="multiproductEXAMPLE.html">
    <input name="action" type="hidden" id="action" value="basket">
    <br>
  </p>
</form>

Change the productid numbers to match the actual products. Add options for more or less products. The
checkboxes can be initially checked or unchecked. Fields can be hidden to include groups of products
in multiple forms on the page. The HTML forms are editable using an HTML editor program such as
DreamWeaver or FrontPage.

Here is an example where the same three products added from hidden fields.

<form action="multiproductbuy.php" method="post">
  <p>
    <input name="products[]" type="hidden" id="products" value="126"><input name="products[]"
type="hidden" id="products" value="111"><input name="products[]" type="hidden" id="products"
value="115">
    Description of the multi-product. 
  </p>
  <p>
    <input type="submit" name="Submit" value="Buy All Three Products">
    <input name="returnurl" type="hidden" id="returnurl" value="multiproductEXAMPLE.html">
    <input name="action" type="hidden" id="action" value="basket">
    <br>
  </p>
</form>
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2.20 OrderForm Ordering Method

The source code to implement OrderForm in web pages has become too complex and is impractical for
most end users to implement. It is no longer recommended or supported by AShop.

The Order-Link method is easier to use. Order-Link source code is automatically generated for each
product and it can be used in remote (outside of the AShop installation) web sites.

For those who wish to continue using OrderForm code in web pages, the OrderForm code can be copied
from the source code of the pages that are generated by the catalogue.php script. The head code must
also be copied and included in OrderForm pages. Not all of the functions and parameters are necessary,
but the ones that are used must be included in the head and also in the buy button form actions. If you
understand enough about the functions and parameters to tackle this type of setup, more power to you
and good luck. We prefer to support and continue improving the Order-Link method now because it is
way easier to use and can be used in more places.

2.21 Subscription Password Expiration

AShop Deluxe supports the sales of subscription access to password protected members only
directories and provides a simple method to remove expired passwords from the list.

To remove expired passwords manually...

1. Open checksubscr.php in a text editor.

2. Change the $ashoppath variable to the full server path where the subscription directory is located.
Example: $ashoppath = '/home/username/public_html/protecteddirectory';  

3. Upload/replace the checksubscr.php file  

4. Make this script executable: chmod 755 checksubscr.php.  

5. Run the checksubscr.php script from a browser when you wish to remove expired passwords.  
Example: http://www.yourdomain.com/ashop/checksubscr.php  

Note: When PA+ (Password Administrator Plus) is installed on the same server as AShop and the path
to PA+ is set within the third party software integration, each subscription directory can optionally be
managed after the initial order by using the more advanced features of PA+. 

2.22 Visit Counter

Unique visitors to the catalog are counted by the counter.php script. It works automatically with the
dynamic catalog pages because catalogue.php calls counter.php each time that it is run.

When using OrderForm or Order-Link methods exclusively, the catalogue.php script is never called. In
order to count visitors to HTML web pages, a small line of code must be inserted into the head of each
page and the server must be configured to run PHP from within HTML files.

Here is the visit counter code that goes into the head of each page.
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<? php include "counter.php"; ?>

Change the relative path to counter.php accordingly.
For instance, if the web page is in the public root and AShop is installed in the ashop subdirectory the
code would look like this:
<? php include "ashop/counter.php"; ?>
If the page is down one directory from the counter script, it would be like this.
<? php include "../counter.php"; ?>

There are two ways to configure the server to run PHP from within HTML pages.

Method A.
Edit the configuration file for the web server (example is for apache) and add:
AddType application/x-httpd-php .php .phtml .php4 .php3 .html .htm

Method B.
Edit the directory configuration file (.htaccess for apache) and add:
AddType application/x-httpd-php .php .phtml .php4 .php3 .html .htm

2.23 Move or Copy AShop

An existing shopping cart may be moved or copied from one location to another.

Before installing AShop in a new location, run the ashoptest.php script, which tests for required
functionality and installs the correct IonCube loader for the operating system and version of PHP that is
running on the server.

1. Download the all of the AShop files and export (save as file) the database (structure and data) from
the existing site.

2. Upload the files to the new location.
3. Set the file and directory permissions as listed in the new installation instructions.
5. Create a database and import the sql structure and data.
6. Edit the admin/config.inc.php file if necessary so that it will match the database server, name, user,

and password.
7. Edit all of the path and URL settings in the database so that they match the paths and URLs at the

new location. This can be done with a tool such as phpMyAdmin or DB Admin, which are typically
provided by web hosting services.

That should do it. If there is trouble with any of the settings, error messages will typically indicate the
cause.

License key registration is not required if the domain name is same as what is already registered. If the
domain name is different, it must be registered. To register a license key and activate the installation,
open admin/register.php in a browser.

2.24 Store Configuration

2.24.1 Administration Panel

The Administration Panel can be accessed by navigating to the admin directory where the shopping cart
is installed. 
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Open the Administration Panel by typing a URL something like this into your browser address bar:  
(substitute the actual URL to the cart installation in place of "yourdomain.com/ashop")
http://www.yourdomain.com/ashop/admin

Security Features
The AShop admin login is password protected.  The default password that is installed with the program
is ashopadmin. This should be changed after installation. If you forget your password, it can be looked
up with your server's database browsing tools such as phpMyAdmin or through Shell access.

20 Minute Inactivity Security Check - The admin panel login times out after 20 minutes of inactivity.
By adding the line: $noinactivitycheck = "false"; anywhere in the config.inc.php file the time check is
skipped. This might be useful during initial setup or while adding a large number of products.

2 Minute Lockout Prevents Brute Force Entry -The login has protection against brute force attacks
were a hacker writes a script or program that will automatically try every possible combination of letters
to figure out the password. After three incorrect login attempts the login.php script will block all further
attempts until two minutes have passed. It will also send an email message to the administrator. This
should make it very hard (or at least extremely slow) to get unauthorized access to an AShop
administration panel. 

Login Cookies - The Administration Panel uses cookies for secure login sessions. If you cannot stay
logged in, it is probably because you have an old browser or your browser security settings are blocking
cookies. Check your security settings and/or download a current browser for free from Microsoft,
Netscape, or Mozilla. 

To return to the Administration Panel index page from any other page in the admin panel, click on
the AShop logo at the top of any page within the Administration Panel. This will redirect to the first page
that you see after logging in.

The Administration panel is divided into four main sections:  
Store Configuration
Edit Catalog
Manage Affiliates
Manage Sales

http://www.microsoft.com/windows/ie/default.mspx
http://browser.netscape.com/ns8/
http://www.mozilla.com/firefox/
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2.24.2 Store Configuration

The Store Configuration menu is divided into seven submenus.

Shop Parameters

Change Administrators Password
Shop Name, Address, Telephone, Email
Default Language Selection
Currency Selection
Shopping Cart Catalog Mode Selection
Save Cart enable/disable
Add to Cart Confirmation Window enable/disable
Link From Thank You Page
Items Per Page
AShop Affiliate ID
Receipt Mail Format html/text
TeleSign Customer ID
Wholesale Catalog enable/disable
Wholesale Catalog Volume Discount Settings
Download Password Duration
Number of Downloads Allowed Per Password
Random Key Code Delivery Selection
Edit Product Flags
Advanced Options

Layout

Upload Logo Image File (default page heading)
Theme Selections
Background Colors
Text and Link Colors
Forms Colors
Item Border Color and Width
Item Background and Text Colors
Condensed Layout enable/disable
Category Colors
Font Selection and Sizes
Thumbnail Image Size

Affiliate Program

Affiliate Text (displayed on affiliate sign-up page)
Affiliate Administrator E-mail
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Second Tier Affiliates enable/disable
Default Affiliate Commission Percentage (per product)
Second Tier Commission Percentage (per order)
Level 2 Affiliate Commissions
Require PayPal ID In Sign up Form on/off
Redirect URL (where visitors end up after clicking on affiliate links)

Payment (not all of the options listed are available for every payment option)

Add New Payment Option
Payment Option Name
Payment Gateway Selector
Payment Fee (optional)
Merchant ID
Transaction Key
SSL URL To Payment Form Logo Image
Extra Form Fields (only available for payment gateways that use the AShop Secure orderform script)
Deliver Before Payment enable/disable
Test Mode enable/disable
Automatic Delivery enable/disable
Payment Gateway Description
Text On Order Page
Thank You Message

Fulfilment

Add New Fulfilment Options
Three Options, add as many as you like of each
Email Order Notices To Fulfilment Services
SwiftCD.com CD Fulfilment Service
Automation Fulfilment Method

Shipping

Manage Storewide shipping options for FedEx, UPS, and custom methods.
Allow/Disallow Customer Selection of Shipping Service Options.
Add/Remove Local Country or Countries (used to determine local or international handling charge)
Ship Only Locally Option
Add Local Handling Charge (one-time per order charge if shipping to country of origin)
Add International Handling Charge (one-time per order charge if not shipping to country of origin)
Manage Zip Tables (used only if custom zip-zone lookup and zone rates have been setup for shipping)
Manage Shipping Options (for instance express shipping charges)
Manage Shipping Discounts (quantity based)

Taxes

Sales Tax Type - US, VAT, GST/PST
Taxable State Or Province (US/Canada)
EU/VAT Origin Country Setting
Sales Tax, VAT, GST Percentage
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PST Percentage
Request Vat Number from Customer Option
Sales Tax On Shipping Option

2.24.3 Shop Parameters

From the AShop Administration main menu, click Store Configuration on the left side menu. This will
open the Configure AShop menu. Click on the "Shop Parameters" link.
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Change Password

After installing AShop, the administrator's password should be changed. Enter the old password, then
enter the new password twice.  

Note: If you forget and lose your password, you can look it up from the mySQL database "user" table.
Most servers provide a control panel tool such as phpMyAdmin for browsing records.  

The password must be alphanumerical. Special characters would cause the database to be unable
to store the new password. Try your old password. If it doesn't work you will need to reset the password
using a database management tool such as phpMyAdmin or if you have no access to such a tool you
will need to reset the entire database (for example: delete it and create it again).

Contact Information  

Shop Name
The Shop Name will display in many places:

· In the browser title bar of the catalog page and in the product delivery pages by default.
Note that if a page template for the catalog, delivery, or affiliate sections is present, the page title
within the template file will display in web page browser title bars instead of the Shop Name setting.

· The "From" e-mail field of customer receipts and affiliate messages.
It is recommended that you do not use HTML tags or special characters to format the text in the
Shop Name field as most mail servers will reject messages with tags in the "From" field of the
message header and special characters, such as ™ may not appear correctly in e-mail messages.

· With the contact information in receipts and order notices.
· Appears in AShop template pages wherever the comment <!-- AShopname --> is placed.

Do NOT use a comma or appostrophe in your Shop Name as it may cause adverse effects when
messages are received by Outlook and possibly other programs.

Address
The store mailing address is displayed, with the store or organization contact information, on the product
delivery page and receipts.

Telephone
The Telephone number also appears with the contact information, which is displayed on the product
delivery page and receipts.

E-mail
The store administrator's e-mail is where notices of sales transactions and downloads are sent and is
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used as the return address for customer e-mail receipts. This e-mail address will also display on the
product delivery page and receipts with the other contact information.

Catalog Options

Currency
Set the currency for what will display in the catalog and within receipts and order notices. The currency
that is set here also controls which payment options are available. Only payment options that support
the selected currency will be available within Payment Options.

Catalog Mode
The Catalog mode is typically set to Shopping Cart, which enables selection of more than one product
per order and any quantity of each product. Use Single Product Order to go straight to checkout when a
product is put in the cart, allowing only allow one product per order. Use Single Product Shopping Cart
to disable the quantity box and set the quantity of each added product to 1. For a description of how this
works, see Shopping Cart Catalog.

Enable Save Cart
When this box is checked, a save cart option will appear in the View Cart page.

Confirm Add To Cart
A small window pops-up when a product is put in the cart to confirm the buyer's intention and also to
view and agree to terms of sale (if set) and to select product attributes (if set). For products that do not
have terms of sale requirements or selectable product attributes, the confirmation window can be set to
require confirmation or not.

Link From Thank You Page
After successful receipt of payment a login page is presented to the customer. Below the name and
address of your store, there is a link that says "Back to [Shop Name]!" This sets that link URL.

Items Per Page
Sets the number of items to be displayed on one page in the product catalog. If more than this number
of items exist in the chosen category or search result, the items will be split up on separate pages that
can be accessed by clicking a page number located beneath the products.

AShop Affiliate ID
To earn commissions by referring visitors to us, sign up for the AShop Software affiliate program and
enter your affiliate ID here. When an affiliate ID is saved, the small "Powered by AShop" logo will appear
below the categories in the catalog. It will link with your affiliate ID to our affiliate tracking and sales. If
the AShop Affiliate ID box is left blank, the AShop logo and link does not appear on the pages.

Receipt Mail Format
Select whether you want your eMailed receipts to be in HTML or Plain Text format. HTML format looks
better and is typically easier to read. Pain text is less likely to be blocked by overactive spam filters. The
choice of receipt format may depend on the type of products that you sell, the keywords that are
included in receipts, and the volume of orders that are processed.

Collect [full contact or only name/email] for gifts
When the total of the order is zero, upon checkout only contact information is collected and no payment
information is required.

only name and email - The checkout orderform will only require name and email address.

http://www.ashopsoftware.com/ashop-affiliate.htm
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complete contact information - The checkout orderform will require name, email address, physical
address, and phone number.

Telesign Customer ID
Telesign automated telephone call verification service is optional. Leave the box blank to disable the
service. Enter a valid Telesign account number to activate the service. Note that it only works for 
payment options that use a locally hosted payment form (orderform).

Non-fixed Voip (Voice Over Internet Protocol) and untraceable cell phone numbers are often used by
criminals to get around phone verification. To block fraudulent transactions, Telesign verification identifies
the type of phone number and will not validate untraceable phone numbers. If a customer enters a non-
fixed Voip number or an untraceable cell phone number an error message will appear. The Telesign error
message is stored in the TELESIGNINFO text in orderform.inc.php language file.

Example of untracable phone number error message:

http://www.ashopsoftware.com/payment-processor-cross-reference.htm
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Note! You must enter a fixed phone number without country code. Non-fixed Voip and untraceable cell
phone numbers will not be accepted. An automatic phone call will be made to this number to provide you
with a verification code. 

Wholesale Catalog

The wholesale catalog is optional. Check the box to activate it. See the Wholesale Catalog topic for
more information about how this works.

Wholesale Discount Levels
The wholesale discount levels only apply to the wholesale catalog.

Downloadable Product Expiration

Allow Download For (quantity) Days
A password is e-mailed to customers upon receipt of payment. This password is required to access the
downloadable products. The password will expire after the number of days that is set in the Allow
Download For box. Setting the allowed download days to 0 disables that restriction.

Allow (quantity) Downloads Per Product
Each password will work to download a product file this many times within the number of days that Allow
Download For is set to. Set it to 0 and any number of downloads are allowed.

Browser Save Dialogue
When downloadable products are ordered, customers are provided with a download link. Depending on
the customers' browser settings and applications that are installed on the customers' computers, some
file types will automatically open with the default application that is installed on each customer's
computer. For example, a pdf file may automatically open in Adobe PDF Reader and an mp3 file may
automatically open in Windows Media Player. When this setting is Off, the browser behavior is
dependent on each customer's computer configuration. When this setting is On, the Browser Save
Dialogue box is forced to open regardless of the customers' computer and browser configuration.

eMailed Key Codes

Random Key Code Selection
Key codes are emailed to customers. New key codes are added from a line delimited text file. If this box
is checked, the key codes will be used in random order. If the box is unchecked, the key codes are
used in the order of the original the text file, from top to bottom.

Shopping Mall Parameters (Digital Mall only)
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Default Commission Level
Each member earns commissions when his/her products are sold. The commission is a percentage of
the retail sales price for each member product that is sold. The commission percentage is set
individually for each member. When a new member is activated, that member's commission rate is
initially set to this value. The commission rate for each member may be changed by the mall
administrator (username: ashopadmin) through the Manage Members menu.

Member Catalogs
Member products may be displayed in dynamically generated catalog pages in one of two ways:

· Unchecked - all members products are displayed within one dynamically generated catalog.
· Checked - each member has an individual dynamically generated product catalog where only his/her

products appear.

Member Product Management
When checked, each member may add and edit his/her products.

Member Products Default to Active
When checked, new products added by members will automatically be active. When unchecked, new
products added by members will be inactive and will not appear in the catalog until the mall administrator
(ashopadmin) approves and activates each product.

Display Customer Info
When this option is checked, each member may view customer information relating to sales of his/her
products.

Member Product Template
The "Member Product Template" textbox can be used to set a default product description for new
member products. It can be used to create a standard description format so that members can then add
the missing information. For example:

Artist:
Genre:
Length:
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Edit Shop Categories
Member shop categories are different and separate from product categories. When Member Catalogs is
checked and each member has an individual catalog, mall.php will display a directory of member shops.
The directory will include a listing of shop categories. When Member Catalogs is unchecked, the shop
categories are only used for internal reference by the mall administrator.

After editing Shop Parameters, click the Submit button to save changes.

Click cancel or the browser back arrow to discard the changes.

Edit Product Flags

Here you can add or remove product flags (comments) that can be assigned to one or more products in
the Edit Catalog menu. These comments will display above the Price in the Product Catalog.

Advanced Options

Only change these settings if you understand what you are doing!

At the bottom of the Shop Parameters page click the Advanced Options link to set the Shop URL,
Secure URL, File System Path, Secure File System Path, time-zone offset, and path or URL to other 
third party software.

2.24.4 Member Shop Categories

This feature is only active when Digital Mall is installed.

Member shop categories are different and separate from product categories. If the Member Catalogs
option is checked in Shop Parameters so that each member has an individual catalog, the mall.php
script will display a directory of member shops. The directory will include a listing of shop categories.
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Create and Edit Shop Categories

When logged in as administrator (ashopadmin) navigate to Store Configuration > Shop Parameters >
Shop Categories.

To create a new shop category, enter a Caption and click the Add category button. Repeat this to add
more categories. Shop categories will be automatically sorted and listed in ascending alphabetic order.

2.24.5 Shopping Cart Catalog Mode

Catalog pages are dynamically generated by catalogue.php for customers to make selections, and
purchase products. Shopping pages may also be created by including separate components of
catalogue.php within custom HTML or PHP web pages and by inserting Buy buttons in HTML or PHP
web pages using the Order-Link method. In any case, the behavior of the shopping cart when products
are added to the cart will be determined by the Shopping Cart Catalog Mode setting.

Shopping Cart Catalog Modes

The Shopping Cart Catalog can be used in 3 different ways.
· Shopping Cart mode (default setting) - Products are added to the shopping cart until shopping is

completed and then the customer clicks view cart or checkout.
· Single Product Order mode - A Buy button next to the product is clicked and the customer is

immediately directed to checkout.
· Single Product Shopping Cart mode - Activates the shopping cart to purchase more than one product,

but only one of each downloadable product. This would work well for music and other types of
downloadable products where only one of each track or selection is typically ordered.
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The Shopping Cart Mode is set in the Administration Panel under Shop Parameters.

Shopping Cart Mode

Shopping Cart Mode will display multiple products and will allow the purchase of as many products as
the customer selects.

An "Add to Cart" button will appear next to each product within the catalog. 
At the top of the catalog will be the "View Cart" and "Check Out" Buttons, along with a Search and
Subtotal feature. 

The Shopping Cart contents can be viewed at any time by clicking on the "View Cart" button. The
customer will be directed to the Basket to proceed with the order. If products have been added to the
cart that require shipping or tax, a link to calculate will appear in the Basket.



Installation & Setup 65

AShop Internet © Copyright 2002 - 2008

* the shopping cart basket

Single Product Order Mode 

Single Product Order Mode will display multiple products in the store catalog, but will only allow the
purchase of one product selection in each transaction. This mode is typically enabled where
downloadable products are being sold or where there are buy links from external web sites for single
item purchases.

In this mode, the "View Cart" and "Check Out" buttons do not display within the store catalog page.
Neither do the Subtotal or Search features. Customers may select one product from the catalog by
clicking on a "Buy" button and will be directed to Check Out and proceed with the order. They will not
see the Basket page. If the product has a shipping charge or is taxable they will first be directed to the 
shipping information form.

Single Product Shopping Cart Mode 

Single Product Shopping Cart mode allows the customer to purchase different products, but no more
than one of each. This catalog method is suitable for music and other types of downloadable products
where only one of each track or selection is typically ordered.
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The "View Cart" button is available in this catalog mode so when the customer is finished adding their
products they can go to the Basket to proceed with their order.

* the shopping cart basket 

Clicking on the Calculate link will open the shipping information form.
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*shipping and taxes information form 

After the shipping information has been entered, the shopping cart contents will appear with shipping and
taxes added. 

If more than one payment option is set, the "Checkout" button will show a list of payment options to
select from. If only one payment option is set, the payment options are skipped and the secure payment
gateway form appears.
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* payment gateway selection 

They are then directed to a secure payment form for the select payment option where billing information
is collected and processed.

* secure payment gateway

· The transaction details, customer's name and shipping information are recorded in the database.
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· Upon submission of the payment form, a receipt is e-mailed to the customer. Notice of the
transaction with customer's IP address is e-mailed to the store administrator.

· If a downloadable product was purchased, an automatically generated password and a link to the
download page are e-mailed to the customer. If Automatic Delivery is supported by the selected
payment processor and is set to On within Payment Options, the customer will be immediately
logged into the product file download page. The password will expire after a number of days, which
is set by the store administrator.

· If the sale is the result of an affiliate link, notice of the sale is automatically e-mailed to the referring
affiliate and to the affiliate manager.

· Notice of the order is e-mailed to the store administrator and includes the referring affiliate's id if
applicable.

· If a downloadable product is purchased, the customer is redirected to the delivery page where the
product(s) may be accessed by using the password that was e-mailed to them by the program.

2.24.6 Save Cart Option

The Save Cart feature is optional and is set in Shop Parameters. When enabled, this feature allows
customers to save the contents of the shopping cart for later retrieval.

 A confirmation notice is sent to the customer by email.

Once the customer is registered they can save the contents of the shopping cart.
Enter the name of the saved cart contents and click the Save Cart button.
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Any number of carts can be saved and recalled at a later time.

When the customer comes back at a later time they can login at the View Cart page. They will find they
can load or delete the shopping cart contents they have saved.

2.24.7 Wholesale Catalog

The wholesale catalog is optional. To use the wholesale catalog, it must first be enabled within Shop
Parameters. There are three optional volume discount settings that can be applied.

Wholesale customers must sign up for an account. (wholesale/signupform.php)
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Upon submitting the application, the customer receives an email notice that the application has been
received and the shop administrator receives a notice that the customer has submitted an application.
The shop administrator can then login to the administration panel to view the customers information.
Upon approving the customer for a wholesale account, the shop administrator can then activate the
account.

To view the wholesale accounts go to Manage Sales and click the View Wholesale Customers link.
Click the Exclamation Point icon to activate a wholesale account. Once activated the wholesale
customer will receive an email notice with their wholesale account login information.

Products are set as active in the catalog by checking a box in add products or edit products. When the
wholesale catalog is active, a check box will appear to make each product active and there will be a
place to set the wholesale price.
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When the Catalog Status is unchecked for a product, it does not appear in the dynamically generated
catalog pages, but it can still be ordered using the Order-Link or OrderForm methods. This is useful
when some products are only offered in special situations or only from limited web pages. The wholesale
price (in parentheses) and catalog status appears in the category view.

The wholesale catalog is password protected. A password and link to the wholesale catalog login is
automatically sent to the wholesale customer when the account is activated. The wholesale catalog
does not apply sales tax to any orders. It is assumed that the customers have submitted sellers permits
if required for your state or locality. Within the wholesale catalog, the wholesale price appears first and
retail price appears in parentheses as a reference.

2.24.8 AShop Software Affiliates

AShop Software Can Generate Cash For You!
Become an AShop Software sales affiliate and generate income while offering useful software to your
website visitors or e-newsletter subscribers. Earn $50 for every click-thru sale of AShop Deluxe! Affiliate
sales commissions are paid out 60 days after the close of each month by PayPal or check.

2-Tier Commissions - Residual Income From Signing Up Affiliates
Sign up new affiliates and earn the second tier commissions from their orders. The second tier
commission rate is currently 3% of the order totals. Link code is automatically generated in the affiliate
support panel. When new affiliates sign up through your link, you will begin earning second tier
commissions each time they sell an AShop product!

A Product And Customer Service To Be Proud Of
AShop affiliate sales software is easy to use and packed full of useful features. It is backed by great
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customer service and full technical support. If you are using it now, you already know that we are serious
and passionate about our work. AShop affiliate sales software will outperform many programs that are
selling for 3 to 4 times as much. Join the growing AShop Software affiliate sales team today and profit
with us while we expand our product line.

Grow And Profit With Us!
In addition to affiliate sales software, AShop Software is developing a family of e-commerce applications.
Once you have joined as an affiliate, you will automatically receive commissions for sales of new
products as they are added.

Take five minutes to sign-up now. A link with your affiliate ID will be automatically generated for you
to place in your website or e-newsletters. You can check your click-thru sales and commission stats in
real time at the AShop affiliate support panel.

Use the ashoplogo.gif that appears in your catalog pages to earn money as an affiliate.
After joining the AShop Software affiliate program, open catalogue.php in a text editor and replace the
http://www.ashopsoftware.com link with your affiliate referral tracking link.

To remove the ashoplogo.gif, simply delete it and rename the included invisible.gif with the name
ashoplogo.gif so that there won't be a broken image. 

2.24.9 Digital Product Delivery

Digital product files are accessible only after payment has been completed.

See also: Key Code Products

When Downloadable Products Are Ordered

Upon completion of payment, a password and link to download the program file(s) is included within the
emailed receipt.

A login to download the product file(s) is included in the payment confirmation page. The customer also
can click the link in the receipt at a later time to access the files(s).

http://www.ashopsoftware.com/affiliate/signupform.php
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Automatic Delivery is optional with payment gateways that support the feature. When Automatic Deliver
is used, customers still receive the password and link by email AND upon completion of payment, they
will be automatically logged into the product delivery page. 

The password can be set to expire in a number of days and/or after a number of downloads. This is set
in Shop Parameters. 

2.24.10 Layout

From the AShop Administration main menu, click Store Configuration on the left side menu. This will
open the Configure AShop menu. Click on the "Layout" link.
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Upload Logo Image
This logo image file will be displayed on any page that does not have an HTML page template attached
to it. The main pages will use a page template if present. If a page template is not present, the logo will
appear at the top of the page. Some message pages do not use templates and will always display the
logo image at top of the page. The language selection page also displays the logo image.



AShop Deluxe User Guide76

AShop Internet © Copyright 2002 - 2008

Theme Selection
A theme is a canned set of design components. Each theme typically includes a set of page templates,
a set of button images, and a configuration file, which sets the Layout parameters. When a theme is not
selected, the root page templates, button images, and Layout parameters are used for shopping cart
pages. Themes and buttons are available to download from AShopSoftware.com.

How To Set Colors

Colors can be selected by clicking on the color selector icon , which is on the right side of each color
setting.

The colors can also be set by entering the hexadecimal equivalent into the color text box. AShop Deluxe
does not include an eyedropper to sample and convert colors in the page to hexadecimal, but
Dreamweaver, PhotoShop, and other similar programs include a color sampler/converter, which can be
used to get the hexadecimal number for colors that are not web standard. Just open an image containing
the color that you want in one of these programs and use any of the color selector tools to activate the
eyedropper tool.

http://www.ashopsoftware.com/dlcounter/downloads.php#themes
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Notes about Layout settings

Layout settings can be overridden by the presence of settings in AShop HTML page templates and style
sheets.

Some pages do not use page templates. For instance add to cart confirmation windows and attribute
selection windows do not use a page template and will always use these settings.

Page Body Colors

Background Color
This sets the body background color of web pages that are created by the shopping cart program.
 

Text Color
This is the default text color for shopping cart pages.
 

Link Color
This is the text color of link text for shopping cart pages.

Alert Color
Controls the text color of product alert messages such as the filesize and filetypes text for downloadable
products. 

Forms Colors
  

Forms Background Color
This field sets the background color in forms used to collect shipping and billing information.
Forms Text Color
This field sets the text color used in forms that collect shipping and billing information.

Product Layout & Colors
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Item Border Color
The products are displayed in the catalog within tables (boxes). The border color of these tables is set
here.
 

Item Border Width
This field sets the width of the table borders, in which the products are displayed.
 

Item Background Color
This field sets the background color of the tables, in which the products are displayed.
 

Item Text Color
This field sets the text color of the tables, in which products are displayed 

Condensed Layout
With the standard layout product listings are separated by borders and there are line breaks between the
product names, descriptions, price, etc. When condensed layout is selected the product listings so not
have as much space between them. Instead of table borders, each product listing is separated by a
horizontal rule. This layout is desirable when there is a large number of product selections.

standard layout 

condensed layout 
 
Category Colors

Category Color
The categories have two different background colors to differentiate ones that are not selected from the
one that is selected. This field sets the color of the categories that are not selected in the product
catalog.
 

Category Text Color
This field sets the text color within a category.
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Selected Category Color
This field sets the color of a selected category in the product catalog.
 

Selected Category Text Color
This field sets the text color within a category that is selected.

Other Settings
 

Font
This field sets the default text font style that will be used for text within the affiliate pages and in the
product descriptions within the catalog.

Click  to select from a list of fonts.

Text Size
The small, medium, and large text sizes are set used 

Table Width
The Regular and Large table (width) size settings in the Store Configuration->Layout page are applied to
tables in the catalog and view cart pages. The table size settings are applied through CSS, which makes
it possible to override them and modify the style options through style sheets. The two table size
classes are called "tablesize1" (default is 700 pixels) and "tablesize2" (default is 500 pixels).

Thumbnail Image Size

It's best to set this initially with the size that will be used for all of the product thumbnail images when
displayed in the shopping cart catalog. Note that the images always appear in 100 x 100 pixel size
within the Administration Panel > Edit Products.

When images are uploaded in Add Products or Edit Products, the images are resized to the current
Thumbnail Image Size setting. Original images that are larger than the thumbnail size will be resized to
fit. Original images that are smaller than the thumbnail are not stretched. In cases where the original
image size is smaller or a different ratio of width and height than the thumbnail size, there will be blank
space around the image. To preserve the aspect ratio the blank space in the resulting image will be filled
with the current "Item background color", which is set in Layout > Product Layout and Colors.

Note: For the thumbnail image resizing and optimization to work, the version of PHP on the server must
be 4.3 or higher and GD or ImageMagick must be installed on the server. AShop will check if these
features are available and use one. GD is an additional PHP library that is typically installed on most
servers. Not all versions of the GD library have support for saving gif images so AShop checks and if it
isn't available, all of the thumbnail images will be converted to jpeg. ImageMagick is a similar software
that may be installed on some servers. If both GD and ImageMagick are available, AShop will use
IMageMagick.

Link to large original image

If the thumbnail image is automatically resized by GD or Imagemagick, this setting will, when activated,
keep the (if more than 20%) larger original image file AND create a link above the thumbnail image,
which will open the original larger size image in a new browser window. The default text "Click to
enlarge" may be edited in the catalogue.inc.php file for each language. This feature is in addition to the
preview files, which may also be uploaded through the product Files menu.
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2.24.11 Payment Options

From the AShop Administration main menu, click Store Configuration on the left side menu. This will
open the Configure AShop menu. Then select "Payment Options".

If only one payment option is set, customers will skip the payment option page and go directly to the
payment form when checking out. If more than one payment option is set, the payment options will be
selectable by customers when checking out. There is no practical limit to the number of payment
options that can be added and the same payment gateway may be used in more than one payment
option with different payment option settings in each occurrence.

This topic describes the payment option settings in AShop Deluxe.
For instructions specific to each payment service see: Payment Gateway Integration

Add a new payment option
Select a payment gateway or manual payment method from the drop-down box and click the Add
button. A new payment option is added and displayed on the page.

Payment Option Settings
Enter the payment option settings and click the Update button for one payment option at a time.
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Option Name
The payment Option Name appears in the payment selection page if there is more than one payment
option. If there is only one payment option created for the shop, then checkout skips the payment
selection page and this Option Name is not seen.

Payment Gateway
This will already be set when the payment method is added.

Payment Fee
A payment fee may be added for each payment option. The amount set here is rounded to 2 decimal
places. When customers check out and select a payment option, the corresponding payment fee for
that payment option will be added to the order total. If a payment fee is not set, the Payment Fee text
will not even appear on the payment options page that customer see.

Merchant ID
The Merchant ID is assigned by the payment gateway. It is usually the same ID that is used to log into
your payment gateway Merchant Control Panel and is required for payment to post transactions to your
merchant account. For PayPal, it must be a verified business account primary e-mail address.
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Transaction Key (AuthorizeNet SIM only)
See AuthorizeNet Payment Integration

SSL URL to Logo Image
The payment form can optionally include an image of your choice. This most commonly used for the
store logo. Since the payment form is accessed through a secure socket layer (SSL) connection, the
image URL must also be an SSL connection in order to avoid annoying warning messages. If a non-
secure URL is used to link the logo image, the payment form will still work and will display the logo, but
a warning message will display to customers indicating that non-secure information is being exchanged.

Extra Form Fields
Payment options that use the orderform.php script to collect credit card information can have extra fields
included on the payment form. Data that is entered in the extra fields is saved and can be viewed for
each customer. The extra form field data can also be included in receipts.
See: Extra Form Fields

Deliver Before Payment
Real time payment options provide immediate download of digital products upon receipt of payment. 
Manual and offline credit card options will not allow customers immediate access to the digital products.
Instead, the store administrator will receive a link in the e-mailed order notice. Upon receipt of payment,
the store administrator can click on the link to activate the order or run a sales report of unpaid orders in
edit mode to activate each order. The password and link to the product delivery page is then
automatically e-mailed to the customer. To deliver digital products before the manual payment or offline
credit card processing is activated, check the Deliver Before Payment box.

Test Mode (Not all payment services support this.)
Check this box to set the payment form to test mode. This will set the payment gateway in test mode
for each order. When the payment form is in test mode, payments will not post to your merchant
account, but the payment receipt will still function. If you have the Authorize.Net Address Verification
System (AVS) turned on in your Authorize.Net merchant panel, it will not verify addresses while the
payment form is in test mode.

For test orders, enter the following credit card number and any future date: 4111111111111111 (4
followed by fifteen ones) 

The personal information and address can be anything since it will not be verified, but to test the e-mail
receipt function you must enter a valid e-mail address.

Automatic Delivery (Supported by some gateways.)
For downloadable products, after payment is received the customer can be automatically logged into the
product download page. It is only available as an option for payment gateways that support it. When
Automatic Delivery is checked, customers who use this payment option will be automatically logged in
to the delivery area after returning from the payment gateway. Note that the Thank you message
(confirmation page) is bypassed when the Automatic Delivery option is functioning.
Gateways that support Automatic Delivery:
Authorize.Net SIM, Authorize.Net eCheck, WorldPay, PlanetPayment, SkipJack

Description
The payment option description will appear below the option name within the Payment Options selection
page. The payment options page only appears if there is more than one payment option. When only one
payment option exists, this page is skipped and the payment details page opens instead.
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Text on order page (Manual method only)
When a manual payment option is selected during checkout, customers are directed to the order form
page to enter their name and contact information. This text will appear on the order form page above the
form fields.

Thank you message
Upon receipt of the order, customers are redirected to the confirmation page. You can include your own
personalized thank you message and ordering instructions to appear on this page. When each payment
option is added, the Thank you message is populated with a canned message. The canned message
will include the contact information that was set within Shop Parameters. This field may contain HTML
formatting.

Note: Insert variables into the Thank You Message for each payment option by using tokens. The tokens
can be used within ROI tracking scripts to track pay-per-click and other types of referral systems.

%orderid% = Order ID, %amount% = Sale Amount, %firstname% %lastname% = Customer Name, %
email% = Customer Email, %password% = Download/Subscription Password, %keycodes% = Unlock
Key Codes

Note: The download product buttons may not appear on the confirmation page, depending on whether
downloadable products were ordered or if the payment option is manual. For instance, if the manual
payment option is selected and payment is to be mail in the form of a check, the download product
buttons will not appear. In this case, the customer will not have access to the product file until payment
is received and the order is activated. When the order is activated, an e-mail message is sent to the
customer with a link to the delivery page and a password to download the digital product(s).

2.24.12 Fulfilment and Automation

Fulfilment is an automated process that sends customer, order and delivery information to a third party
person, service, or software. It can also send a set of instructions to an external or third-party software.

Fulfilment options are first created in the admin panel through the Store Configuration >
Fulfilment menu. 
There is no limit to the number of fulfilment options that can be created.

Then, each product is assigned to a fulfilment option through the Edit Catalog menu.
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Fulfilment products are grouped for each order.
Multiple products in the same order are automatically grouped for each fulfilment option. For instance, if
five products are ordered, with two using fulfilment option A and three using fulfilment option B, only two
fulfilment notices will be sent; one with two products for A, and one fulfilment with three products for B.
(not 5 individual fulfilments)

Collect Shipping Information
Shipping information is collected in the shopping cart before check out. Every product that uses a
fulfilment method, which requires shipping information must have a shipping calculation method set for it.
By having a shipping method set, each product causes the shipping information form page to appear
before customers can check out. To activate the shipping information page without actually adding any
shipping to the order, set the shipping type for the product to Flat Rate and set the flat rate amount
to .0001. This will activate the shipping form without adding a measurable amount.

Fulfilment Option Types
There are several types of fulfilment options, which can be used in many different ways.

eMail Fulfilment
The email fulfilment option sends the order information to an email address or list of email addresses.
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1. To create a new email fulfilment option, navigate to the Fulfilment menu, select the Email and

click Add.

2. Set the email address and additional message text, which will be included in fulfilment notices,

and click the Update button. To send notices to multiple email recipients, separate them by a comma... 
email@service.com, fulfilment@ashop.com

3. Assign products to fulfilment option.

Select the fulfilment option that the product will activate when it is ordered and then click the Submit
button.
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When a product with an email fulfilment option is ordered, notice is sent with customer information,
products ordered and the additional message text. Products in an order that use the same fulfilment
option are grouped together so that there is only one fulfilment notice sent for each fulfilment option and
it includes all of the products that use the same fulfilment option.

Swift CD Service
Swift CD (www.swiftcd.com) is an on demand CD duplication and fulfilment service. The Swift CD
fulfilment option sends an email to Swift CD with an attached batch order file formatted according to their
specifications. An unlimited number of fulfilment options can be created to use the Swift CD method and
each fulfilment option that uses the Swift CD method can have its own user id (the customer id you get
when you sign up at www.swiftcd.com) which means that you can sell CD's for different Swift CD
accounts from the same shopping cart. 

1. To create a new fulfilment option for Swift CD, navigate to the Fulfilment menu and select Swift

CD.

2. Enter an Option name and User ID. You can rename the Option name to any combination of

characters. The User ID must be an active Swift CD account.

http://www.swiftcd.com/
http://www.swiftcd.com/
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3. Assign each product to the Swift CD fulfilment option through the Edit Catalog menu. For

products assigned to a Swift CD fulfilment method, an email is sent to Swift CD when they are ordered.
The email includes an attachment, which is specifically designed to work with the Swift CD fulfilment
system.

Automation Fulfilment
The automation fulfilment option interprets data from AShop and posts it to a third party application. The
data can be posted in a variety of ways. Each fulfilment option that uses the automation method can be
programmed separately. There is no limit to the number of fulfilment options that can use the automation
method.

The Automation fulfilment feature lets you pass the order information for each product separately
to an external script after a customer has completed an order. This makes it possible to integrate AShop
Deluxe with almost any type of third party software. For example you can use this to automatically
activate a web hosting account when it has been paid or you can add your customer to a mailing list
using a software that isn't already supported by AShop or you can activate a service on another website
or even another server for your customer.

1. To set up Automation fulfilment option, navigate to the Store Configuration > Fulfilment menu,

select Automation and click Add.

2. Set Automation Parameters

· Option name is just for your own reference and can be set to anything you want.

· URL to external script or software can be a relative URL, for example: ../activate.php
or it can be an absolute URL, for example: http://www.yourdomain.com/cgi-bin/activateaccount.
pl

· Variable Names - Since each website script can use different names for variables and form fields that
they can accept you can map the fieldnames of the fields that AShop sends to match the ones your
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external software uses. Each field is listed with a box where you can fill in the name your software
uses. For example the AShop order ID field can be called: "invoicenumber" if your software needs that
name. All fields must be filled in but if you don't use some of them you can simply type in any name
that isn't used by your software.

· Other Fields + Values - The box labeled "Other fields + values" will let you pass along any other
information needed by your external software. For example you can send a username and password.
Just put "fieldname=value" on separate lines in the box:
user=myusername
password=dfkdifk33

3. Click Update when you have completed the form to save it.

4. Assign each product to the automation fulfilment option through the Edit Catalog menu.

5. If your product has any attributes you can send them to the external software. 

Each one of your products' attributes are listed with a text box that will let you map its' name to the
name that is used by the receiving software. For example: if your product has an attribute named "Size"
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that will let your customer select the size from a number of options and the script that is going to receive
the order information sent by the fulfilment option instead calls this information "attribute2" you can enter
that into the box next to "Size" for the product.

6. Repeat steps 4 and 5 for all other products that are to use this fulfilment option.

Related Topic: Allow Upload After Order - Fulfilment Automation Example

2.24.13 Allow Upload After Order

Customers may upload a file following an order placed through the shopping cart. The file upload is
controlled by a script named buyupload.php, which only allows one file upload for each order and only
allows specific file types. The script works with a mySQL database table to keep track of file uploads. A
file upload notice is emailed to a specified address when a file upload has occurred. An automation
fulfilment option is used to activate the buyupload.php script after payment is completed.

Setup instructions:

1. Create a new MySQL database or add a table to an existing database if one is available that

does not already have a table named "uploads".

2. Edit the automationexamples/buyupload.php script with a text editor to set the configuration

options. The $savepath variable must be set to the full filesystem path to the directory where the
uploaded files will be saved. The $password variable is used to make sure that only you or your AShop
scripts can add new allowed uploads to the database. The database variables should be set according to
what you use to login to your MySQL database. The $allowedfiletypes can be set to a comma separated
list of file extensions. If none are set, any type of file will be allowed. The $notifyemail variable should be
set to an email address where you will receive notifications of uploaded files.

3. Run the automationexamples/buyupload.php script in a web browser to install the database table.

4. Login to your AShop admin panel and open the page Store Configuration->Fulfilment.

5. Add a new Automation fulfilment option and set its' URL to where the buyupload.php script is
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located on your site.

6. Ensure that the Fieldname - order ID is set to: "orderid".

7. Enter the text: "pass=mypassword" (changing the "mypassword" part to what you set the

$password variable to in the buyupload.php script) in the text box labeled: "Other fields + values" and
click Update to save the settings.

8. In Store Configuration > Payment, edit the Thank You Message for the payment option(s) and

add the following html code:

<form action="automationexamples/buyupload.php" method="post" enctype="multipart/form-
data" name="productform"><input type="hidden" name="orderid" value="%orderid%"><input
type="file" name="uploadfile"><br><input type="submit" value="Upload"></form>

Make sure that the action parameter of the form tag contains the right URL to your buyupload.php script
if you have placed it in another directory than the default on your site.
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10. Add fulfilment to product(s), which when sold will allow the upload. Click the Fulfilment button for

the new product and select the new automation fulfilment option.

When a customer buys the product the order ID will be added to the upload database table. The thank
you page presented to the customer 
after payment will contain a text entry box and a browse button, which the customer may use to upload
a file. An upload notice is emailed to the address that is set in buyupload.php.

2.24.14 Customer Shipping Address

Customers are asked to provide shipping information if it is required for the products that have been
selected.

The shipping information form shows fields selectively.

If there are no taxable or shippable products in the basket, the shipping information form page does not
appear. The customer is directed to the basket and there is not an option to enter shipping information.
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If there is at least one taxable or shippable product in the basket, The View Cart page will include an
additional row for Shipping/Sales Tax with a link to the shipping information form.

If there are taxable products, but no shippable products in the basket, the shipping information page
asks only for the country and state in order to determine if sales tax is required and to apply the correct
rate for the locality.

If there is at least one shippable product in the basket, the shipping information page asks for the state
(or province), zip (or postal code), and country.
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 The street address and shipping contact phone number is not required until Checkout.

The shipping information is saved for each customer. The shipping contact phone number is saved in
the Customer Profile. If a different billing phone number is entered during the payment process, then it
will also be saved (as an alternate phone number for the customer).

Related Topics

Each product is set as taxable in the Add Product or Edit Product page.

Shipping is set for each product by clicking the Shipping button in the Edit Catalog view.

Per order handling charges or shipping options will only be added to orders that have at least one
shippable product in the basket. To charge handling without adding shipping per product, set Flat Rate
shipping for each product and set the value to .0001 

2.24.15 Shipping and Taxes

Shipping and Taxes options are managed in separate pages as of version 4.7.0.

See individual help topics for Shipping and Taxes.

2.24.16 Shipping

Shipping and handling options are set in the Shipping menu in your AShop Administration Panel.
Administration Panel > Store Configuration > Shipping

http://www.ashopsoftware.com/update/index470.html
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Shipping Method
In the Shipping page, there is a main Shipping Method selector. The Storewide shipping and individual
product shipping options are dependent on the Shipping Method setting. For example, if the main
Shipping Method is set to FedEx, only FedEx options will be available in related settings and options. If
UPS is selected, then only UPS settings and options will be available. If Custom shipping options are
selected, only custom settings and options will be available. This method of selection simplifies the
setup process and avoids potential conflicts.

When FedEx is selected as the Shipping Method...

...only FedEx options are available in the Store Configuration > Shipping page...

 ...FedEx is available, but UPS is NOT available in the shipping options for each product.

When UPS is selected as the main Shipping Method...

...only UPS options are available in the main settings...
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 ...and UPS is available, but FedEx is not available in the per product shipping options.

When Custom is selected as the Shipping Method...

 
...only Custom Shipping Options are available through the Store Configuration > Shipping
page...

...FedEx and UPS options are NOT available for each product Shipping options.
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Customer Selectable Service
When the shipping amount is requested during a shopping session, the state, zip, and country is
required. (The street address and shipping contact phone number is not required until Checkout.)

When FedEx or UPS is selected as the Shipping Method, the Options include Yes/No selector for
Customer Selectable Service. When this is set to Yes, customers will have selectable service options.
In this case the rate is looked up based upon the service option that is selected during each shopping
session.
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Note that when the main Shipping Method is set to FedEx or UPS AND Customer Selectable Service is
set to Yes, custom shipping options are NOT available in the per product shipping options.

Storewide Shipping
Each product may have an individual shipping calculation method OR it may be included in the 
Storewide Shipping calculation. The storewide can be FedEx, UPS, or a flat rate per pound. Total weight
for all products in the cart that are set with storewide shipping is used for the lookup or calculation. A 
maximum weight per package setting limits the total weight for each package. The program adds more
packages as needed when the maximum weight for each package is exceeded.

Local Handling Countries

Local Handling country/countries - The local handling charge (per order) will be added to orders where
the shipping destination is a country that is set here.
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To add a country to the list, click the Add Country button. A new selection box will appear where another
country can be selected and added to the list.

To remove a country from the list, select Remove This Country from the drop-down list. When the form is
submitted, that selection box will be removed.

Ship Locally Only - When this box is checked, only the local handling countries will appear in the
shipping form country selector that customers see and a small note appears below saying "We only
ship to this country." or "We only ship to these countries.". The page gets this text from the language
file shipping.inc.php.

Add Local Handling Charge - This amount will be added to each order where the destination country
is local.

Add International Handling Charge - This amount will be added to each order where the destination
country is NOT local.

Bottom Menu Bar

Zip/Zone Tables - Zip tables can be used to add shipping charges based upon zip code zones within
the United States. Set up the zip/zone lookup tables first. This can be done through Store Configuration
> Shipping and Taxes or through Edit Catalog > Shipping (for each product that is set to use the zip/
zone method). After a zip/zone table is created, then set each product to use a zip/zone table and set
the 7 zone rates for each product. This is essentially how UPS and FedEx look up the zone from the zip
code, however this method allows you to set rates for each zone specifically for each product.

Shipping Discounts - Shipping discounts can be created based upon the quantity of shippable products
that are in the shopping cart basket.

Custom Shipping Options - When Custom is selected as the main Shipping Method, there will be an
additional link in the bottom menu bar.
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2.24.17 Taxes

Sales tax options are set in the Taxes menu in your AShop Administration Panel.
Administration Panel > Store Configuration > Taxes

Sales Tax Options

Sales Tax Type - Select which country or regional tax will be applied to orders. For instance; US sales
tax, VAT (European Union), or GST/PST/HST (Canada).

Canada Sales Taxes

For the retail catalog - If the products are shipped to any of these Canadian provinces: Nova Scotia,
New Brunswick or Newfoundland, the HST will be applied instead of GST and PST. If the products are
shipped to any other province, except the one they are shipped from, the tax will be just the GST. If they
are shipped to the same province that they are shipped from, then the tax will be both GST and PST.
 
In the wholesale catalog everything is the same except that the PST is never charged. If you ship to
your own province you would still only charge the GST.

State/Province to Charge Sales Tax To – For US sales taxes, this is the origin state. In the US,
state sales tax is typically only collected from residents within the same state as the selling merchant.
For Canada sales taxes the province that is set here is used to determine HST, GST, or PST.

EU VAT Origin Country - When Request VAT Number From Customer (see below) is checked, a VAT
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Registration Number text box appears within the shipping form. EU businesses can enter their VAT
Number to be exempted from the tax. The country that is set in EU VAT Origin Country is excluded from
the VAT exemption and will be charged VAT even if a registration number is entered by the customer.

Sales Tax/VAT/GST Percentage - This percentage rate used to calculate US sales tax, VAT, or GST
for products that are set as taxable.

PST Percentage (Canada) - The Provincial Sales Tax rate that is set here will be applied to taxable
products for Canada where the customer's province is the same one that is set in the State/Province To
Charge Sales Tax. This tax is in addition to the GST.

HST Percentage (Canada) - The Harmonized Sales Tax rate that is set here will be applied to taxable
products for Canada where the customer's province is within HST jurisdiction. If the products are shipped
to any of these Canadian provinces: Nova Scotia, New Brunswick or Newfoundland, the HST will be
applied instead of GST and PST.

Request VAT Number From Customer - When this box is checked, the VAT Number box appears in
the shipping destination form. EU customers, except countries that are set in EU VAT Origin Country
(above), are exempt from the tax.

Sales Tax On Shipping - If this box is checked, sales tax will be applied to the taxable product
subtotal AND shipping at the rate set above. If the box is not checked, sales taxes are only applied to
the product price (and not the shipping).

Include Sales Tax In Displayed Price - If this box is checked, sales tax will be included in the price
that displays in the retail catalog.

2.24.18 Custom Shipping Options

Shipping options appear within the shipping information form for customers to select. See also: Shipping
Information Form
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Shipping options are set within Store Configuration > Shipping & Taxes. To create a new shipping option
or modify an existing one, click on the Shipping Options link in the bottom menu bar.

Create A New Shipping Option
1. Enter the Description that customer's will see.  
2. Enter the Fee that will be added to the order when this shipping option is selected.  
3. Select from the Shipped drop-down box to set if the shipping option will apply to local, international,
or both (all) destination countries. If locally is selected, this shipping option will only appear in the
shipping information form that customers see when they select a destination country that is local. See 
Shipping and Taxes for more information about setting local destination countries.  
4. Click Add.

Modify An Existing Shipping Option
1. Change the Description, Fee, and/or Shipped
2. Click Update.

Delete An Existing Shipping Option
1. Click Delete.
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Move An Existing Shipping Option Up A List Of Shipping Options
1. Click Move Up.
2. Repeat as Necessary.

2.24.19 Shipping Discounts

Shipping discounts are created and modified in Store Configuration > Shipping and Taxes, in the bottom
menu bar.

Shipping discounts are based upon the quantity of shippable products in the shopping cart basket. They
can be set to apply only to products selectively based upon whether the destination country is local or
international and can also be applied to specific shipping options or to all shippable products in the
basket. There is no limit to the number of shipping discounts that can be created, but you should be
careful not to create shipping discounts that conflict with each other as the results may be
unpredictable.

Add A New Shipping Discount
1. Enter the amount to be deducted from the order.  
2. Enter the minimum quantity of products in the basket that will activate this shipping option.  
3. Select if the shipping discount applies to local or international country destinations.  
4. Select if the shipping discount applies to a specific shipping option or to all shippable products in
the basket.  
5. Click the Add button to save the shipping discount.

Modify An Existing Shipping Discount
1. Change the Discount amount, minimum quantity, shipped destination, and shipping option as
needed.  
2. Click the Update button to save changes.

Delete An Existing Shipping Discount
1. Click the Delete button.

2.24.20 Storewide Shipping

Each product may have an individual shipping calculation method or it may be included in the storewide
shipping calculation. The storewide can be FedEx, UPS, or a flat rate per pound. Total weight for all
products in the cart that are set with storewide shipping is used for the lookup or calculation. A 
maximum weight per package setting limits the total weight for each package. The program adds more
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packages as needed when the maximum weight for each package is exceeded.

First set up Storewide Shipping through Store Configuration > Shipping and Taxes.

or

or

Then set Shipping for each product that is to use Storewide Shipping.
Weight for each product can be entered in decimal lbs or in pounds and ounces.

Decimals are converted to pounds and ounces.
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2.24.21 UPS Options

The UPS online rate lookup provides different rates based on various shipping parameters. These options
are used for all UPS shipping calculations. The options may change depending on current selections.

2.24.22 FedEx Options

The FedEx online rate lookup provides different rates based on various shipping parameters. These
options are used for all UPS shipping calculations. The options may change depending on current
selections.

2.25 Payment Gateway Integration

2.25.1 Payment Gateway Integration

The shopping cart supports a variety of payment methods and integrates with many popular payment
services such as Authorize.net, PayPal, Verisign, Card Services International, WorldPay, and more...

The degree of difficulty to set up each payment option varies widely between different payment services
and methods. Instructions are provided as needed for the payment services that are supported by
AShop. If you do not find the payment gateway setup instructions that you are looking for in this help
documentation, see if it is listed in the payment processor cross reference chart. It it is listed, but there
are no instructions it is probably so easy to set up that instructions are not necessary. For instance,
you might only need to select the payment option and enter the merchant ID in AShop to begin
processing payments in the shopping cart. If a payment service is not listed in the cross reference chart,
it is probably not supported by AShop.

http://www.ashopsoftware.com/payment-processor-cross-reference.htm
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For each supported currency there is a set of payment gateway modules, which contain settings for
each gateway. The gateway modules are pre-configured and under most circumstances do not require
modification. More about payment gateway modules.

Curl with SSL
The Authorize.net SIM method and other payment connection methods where the payment page is
hosted on the payment gateway server typically do NOT require Curl or SSL. This is because the
payment gateway is providing a secure connection when credit card information is exchanged and no
credit card information is passed from server to server over the Internet.

Payment options where credit card information is collected in a page on your server DO require both Curl
with SSL and an https connection. This is because sensitive information is being passed over the
Internet from your server to the payment gateway server.

Payment Gateways That Use Curl with SSL:
· 3rdlevelbilling
· Authorize.net AIM
· Echo
· eSelect
· Iongate
· Linkpoint Connect SSL
· PayNova (old and new v2.0)
· PayPal Pro (both Direct Payment and Express Checkout)
· PayPal IPN uses Curl if available but it is not a requirement.
· Payready
· ViaKlix

3-digit Security Code Requirement
For each payment gateway there is a gateway module. For US merchants, the gateway files are in the
admin/gateways directory. These files are open source and editable. The security code requirement can
be changed here so that it is not required and the field will not appear in orderform.php pages. This only
applies to payment options that use the local orderform.php script to create a payment page locally. For
payment options where the payment form is hosted by the payment gateway, the security code option is
controlled through the payment gateway merchant panel. For instance, Authorize.Net SIM payment form
fields are set at https://secure.authorize.net.

Do Not Require Security Code
The payment gateway modules are set to require the 3 digit security code, but it is easy to change this.
Open the gateway file for the payment option. For instance, if the payment option is Authorize.net AIM,
open the authorizenetaim.gw file. Find the following line and change the word TRUE to FALSE. Save the
modified file on the server.

$ccsecuritycode = "TRUE";

See Also: Store Configuration > Payment Options

2.25.2 Extra Form Fields

Extra form fields can be used to collect information from customers. The extra fields appear in the
payment page when customers check out. The extra fields require an entry in order to complete
payment.
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This feature only works for payment options that use an SSL connection to your local orderform.php
script to collect credit card information. It does not work for PayPal, Authorize.net SIM or any of the
other payment options where the payment form is hosted on the payment processor's server. Payment
options that support extra fields are listed with an X under "Orderform" in the payment gateway cross
reference chart.

Data that is entered in the extra fields is saved and can be viewed for each customer. 
It appears in each customer's profile under Additional information.

http://www.ashopsoftware.com/payment-processor-cross-reference.htm
http://www.ashopsoftware.com/payment-processor-cross-reference.htm
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The data can be included in receipts by inserting the %customer_info% token into the receipt
template.

2.25.3 Manual Order Activation

Any of the payment options in AShop may be set up to delay delivery of products, even after real time
payment has been completed by the customer. For instance, if you are selling a downloadable product
and your store becomes a target for credit card or PayPal fraud, it may be advantageous to delay
delivery of product files until after some form of communication is established with the customer or the
customer's identity is verified.

How to delay delivery of downloadable products after payment is received by PayPal
You can make your PayPal payment option work like the Manual handling payment method: when the
customer buys your downloadable items he/she won't be able to download them before you have
activated the order, which you would do once you see that it isn't fraudulent. Activating the order can be
done from the Sales Report page in your admin panel or by clicking a link in the admin notice that you
get by email.

To make this work you should locate the file admin/gateways/paypal.gw (if you are using the regular
PayPal+IPN method, if you use Website Payments Pro you would need to open paypaldp.gw and/or
paypalec.gw instead) and search for the word: "VERIFIED" in capital letters. Change it to: "PENDING"
and save the file + upload it to your site. This will make it possible for you to review each order before
activating it.

The setup process for other payment options is similar.
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2.25.4 2 CheckOut Version 2

2CheckOut Version 2 payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.

With the 2CheckOut Version 2 you must enter the post back URL in the 2CheckOut.com admin panel. It
should be set to the value of their ashopurl + "/order.php".

To use 2CheckOut they require that you add information about each of your products to your
2CheckOut account:

1. Login to your 2CO account.

2. Click "Set Up Products".

3. Click "New Product".

4. Enter information about your product. Make sure you specify the same product ID in the box labeled
"Your Product ID" for your product that you have in your AShop database.

Test Mode
Test mode for 2CheckOut Version 2 can be set from within the AShop admin panel in the payment
option settings.

2CheckOut Payment Confirmation Page
After a successful test transaction, the 2CheckOut payment confirmation page appears. A button must
be clicked to proceed and complete the order with AShop. 2CheckOut provides a setting to bypass their
confirmation page under Account Details > Return, but this option disables the return response code. Do
not use it with the shopping cart.

1. Scroll down the page to the "Overall Passback Requirements".

2. The Direct Return must be set to No for AShop to work with 2CheckOut.

2.25.5 Authorize.Net SIM

AuthorizeNet SIM payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.

Important: In addition to adding the AuthorizeNet SIM payment option within the AShop Administration
Panel, the receipt and response URLs must be set within your Authorize.Net Merchant Account
Settings. See instructions below.

1. Click the Payment Gateway text box and select Authorize Net SIM.
2. Click Add.
3. Set the following as needed within the AuthorizeNet payment option form.

Merchant ID (required)
The Merchant ID is assigned by AuthorizeNet. It is viewable through the Authorize.net merchant panel
under Settings > Security > API Login ID & Transaction Key and is labeled "API Login ID".

http://www.2checkout.com/
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Transaction Key (Required)
The Transaction Key is required in order to connect to the AuthorizeNet SIM method.
1. Login to your AuthorizeNet Merchant Panel.
2. Select Settings > Security > API Login ID & Tranbsaction Key. Then scroll down to Create New

Transaction Key.
3. Create a Transaction Key. Your security secret answer, which was created when you opened the

Authorize.Net gateway account, will be required. You may obtain a new Transaction Key as often
as you wish by providing your Secret Answer. You may choose to disable the old one immediately
by checking the Disable Old Transaction Key(s) option. If you do not immediately disable the old

value, it will automatically expire in 24 hours. 

4. Copy the Transaction Key and paste it into the Transaction Key setting within the AShop
Administration Panel > Payment Option settings for the AuthorizeNet SIM payment option.

Response/Receipt URLs (Required)
The Response and Receipt URL's must be set in the AuthorizeNet Merchant Panel under Response/
Receipt URL's. This is only set in the AuthorizeNet Merchant Control Panel. No setting is required for
the Response/Receipt URL within the AShop Administration Panel.
1. Login to the AuthorizeNet Merchant Panel at https://merchant.authorize.net.
2. Select Settings > Response Receipt URL's.
3. Add the URL's to order.php (response) and checkout.php (receipt) for each installation of AShop.

For example; http://www.your_domain/ashop/order.php
http://www.your_domain/ashop/checkout.php  

(eMerchant Only) Also add emerchant/orderquote.php and emerchant/payquote.php. For example;
http://www.your_domain/ashop/emerchant/orderquote.php
http://www.your_domain/ashop/emerchant/payquote.php

SSL URL to logo image (optional)
The payment form can optionally include an image of your choice. This most commonly used for the
store logo. Since the payment form is accessed through a secure socket layer (SSL) connection, the
image URL must also be an SSL connection in order to avoid annoying warning messages. If a non-
secure URL is used to link the logo image, the payment form will still work and will display the logo, but
a warning message will display to customers indicating that non-secure information is being exchanged.

Test Mode (Recommended before going live)
Check this box to set the payment form to test mode. The text "Test Mode" will display at the top of the
payment form and e-mail receipts. When the payment form is in test mode, payments will not post to
your merchant account, but the payment receipt will still function. If you have the Authorize.Net Address
Verification System (AVS) turned on in your Authorize.Net merchant panel, it will not verify addresses
while the payment form is in test mode.
To run test transactions for AuthorizeNet, enter the following credit card number and any future date:
4111111111111111 (4 and fifteen ones).
The personal information and address can be anything since it will not be verified, but in order to test the
e-mail receipt function, you must enter a valid e-mail address.
Don't forget to un-check the test mode box and resubmit the changes after successfully testing the
payment gateway.

After editing the AuthorizeNet fields, click the "Submit" button to save the changes. To cancel
without saving changes, click the "Cancel" button or page back on your browser.

How to contact Authorize.Net
Contact Authorize.Net at E-mail: support@authorize.net or Tel: 1-877-447-3938.

https://merchant.authorize.net/
mailto:support@authorize.net
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Other Authorize.Net Settings
The following settings are located within the Authorize.Net merchant panel at https://merchant.authorize.
net.

Settings > Transaction Submission > Payment Form > Form Fields - The payment form fields can be
set to view, edit, or required. The shipping information fields are usually not necessary to view or require
in the payment form as shipping information is already collected within AShop Deluxe for products that
require shipping or tax calculations. See also: AuthorizeNet Payment Form Settings

Transaction Submission > Password-Required Mode - This should be checked.

Transaction Response > Email Receipts - Here is where you can select if the Authorize.Net transaction
receipt is to be emailed to the customers or not. You can optionally include message headers and
footers.

Security > Card Code Verification - This feature is for fraud prevention. It verifies that the 3 digit security
code, which is printed on the back of US credit cards matches with the card issuing bank records. The
down side is that a small percentage of U.S. card issuing banks don't support it and non-US credit cards
almost always don't support it.

Security > Address Verification - Again, this is for fraud prevention, but a small percentage of US banks
and almost all non-US banks don't support it.

2.25.6 Authorize.Net SIM Payment Form Settings

The following settings are located within the Authorize.Net merchant panel at https://merchant.authorize.
net/.

Settings > Transaction Submission > Payment Form > Form Fields - The payment form fields can be
set to view, edit, or required. The shipping information fields are usually not necessary to view or require
in the payment form as shipping information is already collected within AShop Deluxe for products that
require shipping or tax calculations. Here are the recommended settings.

https://merchant.authorize.net/
https://merchant.authorize.net/
https://merchant.authorize.net
https://merchant.authorize.net
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There are also some additional fields that are optional and usually not needed.

2.25.7 Authorize.Net AIM

AuthorizeNet AIM payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.

Important: In addition to adding the AuthorizeNet AIM payment option within the AShop Administration
Panel, the receipt and response URLs must be set within your Authorize.Net Merchant Account
Settings. See instructions below.
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1. Click the Payment Gateway text box and select Authorize Net AIM.
2. Click Add.
3. Set the following as needed within the AuthorizeNet payment option form.

Merchant ID (required)
The Merchant ID is assigned by AuthorizeNet. It is viewable through the Authorize.net merchant panel
under Settings > Security > API Login ID & Transaction Key and is labeled "API Login ID".

Transaction Key (Required)
The Transaction Key is required in order to connect to the AuthorizeNet AIM method.
1. Login to your AuthorizeNet Merchant Panel.
2. Select Settings > Security > API Login ID & Transaction Key. Then scroll down to Create New

Transaction Key.
3. Create a Transaction Key. Your security secret answer, which was created when you opened the

Authorize.Net gateway account, will be required. You may obtain a new Transaction Key as often
as you wish by providing your Secret Answer. You may choose to disable the old one immediately
by checking the Disable Old Transaction Key(s) option. If you do not immediately disable the old

value, it will automatically expire in 24 hours. 

4. Copy the Transaction Key and paste it into the Transaction Key setting within the AShop
Administration Panel > Payment Option settings for the AuthorizeNet SIM payment option.

Response/Receipt URLs (Required)
The Response and Receipt URL's must be set in the AuthorizeNet Merchant Panel under Response/
Receipt URL's. This is only set in the AuthorizeNet Merchant Control Panel. No setting is required for
the Response/Receipt URL within the AShop Administration Panel.
1. Login to the AuthorizeNet Merchant Panel at https://merchant.authorize.net.
2. Select Settings > Response Receipt URL's.
3. Add the URL's to order.php (response) and checkout.php (receipt) for each installation of AShop.

For example; http://www.your_domain/ashop/order.php
http://www.your_domain/ashop/checkout.php

(eMerchant Only) Also add emerchant/orderquote.php and emerchant/payquote.php. For example;
http://www.your_domain/ashop/emerchant/orderquote.php
http://www.your_domain/ashop/emerchant/payquote.php

SSL URL to logo image (only used when cart.html page template not present)
The payment form for the AIM method is hosted on the local server. The cart.html page template is used
for the payment form page. Images within the cart.html page template and the thankyou.html page
template should have secure image links. If a cart.html page template is not present, the secure logo
image will appear at the top of the page instead. This most commonly used for the store logo. Since the
payment form is accessed through a secure socket layer (SSL) connection, the image URL must also
be an SSL connection in order to avoid annoying warning messages. If a non-secure URL is used to link
the logo image, the payment form will still work and will display the logo, but a warning message will
display to customers indicating that non-secure information is being exchanged.

Test Mode (Recommended before going live)
Check this box to set the Authorize.Net AIM payment form to test mode. The text "Test Mode" will
display at the top of the payment form and e-mail receipts. When the payment form is in test mode,
payments will not post to your merchant account, but the payment receipt will still function. If you have
the Authorize.Net Address Verification System (AVS) turned on in your Authorize.Net merchant panel, it
will not verify addresses while the payment form is in test mode.

https://merchant.authorize.net/
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To run test transactions for AuthorizeNet, enter the following credit card number and any future date:
4111111111111111 (4 and fifteen ones).
The personal information and address can be anything since it will not be verified, but in order to test the
e-mail receipt function, you must enter a valid e-mail address.
Don't forget to un-check the test mode box and resubmit the changes after successfully testing the
payment gateway.

After editing the AuthorizeNet fields, click the "Submit" button to save the changes. To cancel
without saving changes, click the "Cancel" button or page back on your browser.

How to contact Authorize.Net
Contact Authorize.Net at E-mail: support@authorize.net or Tel: 1-877-447-3938.

Other Authorize.Net Settings
The following settings are located within the Authorize.Net merchant panel at https://merchant.authorize.
net.

Transaction Submission > Password-Required Mode - This should be checked.

Transaction Response > Email Receipts - Here is where you can select if the Authorize.Net transaction
receipt is to be emailed to the customers or not. You can optionally include message headers and
footers.

Security > Card Code Verification - This feature is for fraud prevention. It verifies that the 3 digit security
code, which is printed on the back of US credit cards matches with the card issuing bank records. The
down side is that a small percentage of U.S. card issuing banks don't support it and non-US credit cards
almost always don't support it.

Security > Address Verification - Again, this is for fraud prevention, but a small percentage of US banks
and almost all non-US banks don't support it.

2.25.8 ConnectnPay

ConnectnPay.com is a Plug-N-Pay clone. To connect the shopping cart with ConnectnPay, create a
payment option for Plug-N-Pay.

2.25.9 Cybersource

The Cybersource Hosted Order Page service is supported by AShop Deluxe.

Requirements
Cybersource does not require Curl with SSL, however SSL with a security certificate is recommended in
order to avoid security warning messages in the customer's browser when redirected back to the AShop
payment confirmation page after payment is completed.

Cybersource free for all demo account for testing
https://businesscenter.cybersource.com/sbc/Login.do
Login with the username/merchant ID: universaldemo and the password: demo4me2 and change it's
settings before running any tests.
 
These are the steps needed to start using Cybersource HOP:
1. Login to the Business Center and click "Tools & Settings" in the menu to the left.
2. Click "Settings" under Hosted Order Page and scroll down to the Receipt Page section.

mailto:support@authorize.net
https://merchant.authorize.net/
https://merchant.authorize.net/
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3. Change the Receipt Response URL to a secure URL to the AShop order.php script and add ?
payopt=nn where "nn" is replaced with the actual payoption ID in AShop. For example: https://
securedomain.com/~yoursite/ashop/order.php?payopt=113

4. Scroll down to the Notifications section and check the Merchant POST URL option.
5. Change the Merchant POST URL to a regular http URL to the AShop order script, for example:

http://www.yoursite.com/ashop/order.php
6. Click "Security" under Hosted Order Page in the left menu.
7. Select "PHP" under the Generate Security Script section and click Submit to download the

resulting HOP.php script.
8. Upload the HOP.php script to the admin subdirectory in AShop.
9. Create a payment option in AShop using the Cybersource merchant ID/username for the Merchant

ID box and the Cybersource account password for the Security Secret box.

2.25.10 Echo

To use the Echo payment method, SSL must be supported by your hosting service.

Note: The secure URL for AShop is set in Shop Parameters > Advanced Options.

The security secret in AShop must be the PIN number for the Echo account.

2.25.11 eWay (Australia)

The eWay payment gateway service does not require any setup, just an active account. Simply enter
the eWay account number in the Merchant ID setting for the AShop payment gateway option.

To test the eWay payment gateway without having an account, set the Merchant ID with the test
account number 87654321. Buy a product that costs $10 and use the credit card number:
4444333322221111. The exp month must be greater than today's month and the exp year greater than
2007. The sec code can be any 3 digit number.

2.25.12 Ezic

Ezic payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings

1. Open the Administration Panel, select Store Configuration, and then Payment.

2. Click on the drop-down Payment Gateway box, select Ezic and click Add.

3. Enter your Merchant ID. The payoption Merchant ID must be set to the Ezic [Account ID]:[Site tag],
for instance: "109748335950:ODOOR1" both of which can be found in the Ezic admin panel by
clicking Setup->Website config in the Ezic Merchant Menu.

4. The payoption Security Secret should be set to the Ezic Order integrity key which can be found in
the Ezic admin panel by clicking Fraud Controls in the Ezic Merchant Menu, clicking Fraud
Barricade and then looking under the "Order integrity" step in the resulting page.
The field can be left blank too but this will make the payoption a lot less secure.
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5. If you wish to do so; you can edit the Option Name, add a Payment Fee, add a Payment
Description, and even edit the Thank You Message that appears upon successful completion of a
transaction.

6. Don't forget to click the "Update" button to save the changes you made.

2.25.13 IC Pay

IC Pay is one of the few payment services that will process payments for sales of adult content.

IC Pay provides a secure connection to a payment page, which is hosted on their server. It does NOT
use the local orderform.php page and hence cannot use the TeleSign service for credit card fraud
prevention.

IC Pay is different from most other payment services in that there two separate procedures required for
processing orders for physical products and orders for digital products.

Physical product sales can only be done from the shopping cart with "auth" (authorize only)
transactions, which means that no payment will be transfered until the merchant logs in to his IC Pay
SiteManager and captures it in the Orders screen. This payment process will NOT activate orders
automatically in the shopping cart. To complete the order in the shopping cart and send a store receipt,
click the "activate" link in the emailed AShop order notice after the payment has been captured.

Digital product sales will be authorized AND captured immediately from shopping cart transactions.

Unfortunately, having separate methods for handling physical and digital products causes a limitation
and potential conflict where both types of products are sold by the same merchant. For example, if both
physical and digital products are added to the cart within a single order, the transaction must be handled
as if it is for physical products, which means that orders for digital products will not be delivered until the
payment is manually captured through the IC Pay SiteManager and the order is manually activated
through the shopping cart admin panel. There is no way within a single shopping cart to separate the
product types or to force one payment option or another based upon the type of product(s) that are in
each order. If both IC Pay payment options are available at checkout, the selection is left up to each
customer, which is not predictable and may be prone to errors. Because of this limitation, if both types
of products are offered only the IC Pay Physical Goods payment option should be available to
customers.

How to Add the IC Pay Payment Option in AShop Deluxe
There are two separate Payment options for IC Pay: IC Pay Physical Goods and IC Pay Digital Goods.

Login to the IC Pay SiteManager
1. Generate a Secret Key.
2. Change the Notification Config setting in the IC Pay SiteManager. Enter the URL to the AShop

order.php script in the URL box, for example: http://www.yourdomain.com/ashop/order.php

Login to the AShop admin panel.
1. Click Store Configuration and then Payment.
2. Select the IC Pay option for the type of products that will be sold: physical goods or digital goods.
3. Add the payment option.
4. Enter the IC Pay User ID in the Merchant ID box for the payment option.
5. Enter the Secret Key in the Security Secret box for the payment option.
6. Save the changes.
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2.25.14 LinkPoint Basic - Card Services International

LinkPoint Basic payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.

AShop Settings
Under "Add a new payment option..."
1. Select LinkPoint Basic from the drop-down selection box and click Add.

2. Set the Store ID in the Merchant ID text box.
Note: Be sure you enter your LinkPoint Store Number, not your merchant number.

3. Set the password that is set for your LinkPoint Basic account in the Security Secret text box.
Note: The other settings are described in Payment Options.

4. Click the Update button to save the settings.

LinkPoint Basic Merchant Panel Settings - Required
Before the LinkPoint Basic payment integration will work with AShop Deluxe, some URLs must be set
within the LinkPoint Central merchant panel.

1. Login at LinkPoint Central
2. Click "Customization"
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3. Click "Settings"
4. Enter the following settings:

· For Order submission form URL enter: http://thecustomersashopurl/checkout.php
· For Thank you page URL enter: http://thecustomersashopurl/order.php. Check both checkboxes

below this setting.
· For Sorry page URL enter: http://thecustomersashopurl/order.php. Check both checkboxes below

this setting.  
5. Click the Submit buttons at the the bottom of the page to save these settings.
6. Click "Payment Form"
7. This page will alloy some payment form customization:

· Set the Company Logo Graphics URL, Background Graphics URL, and Company Name for the
payment form.

· Set custom fields to optionally collect additional information within the payment form.

8. Click the Submit button at the bottom of the page to save the settings.

2.25.15 LinkPoint Basic SSL

LinkPoint Basic SSL payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.
It is for the same gateway as the old LinkPoint module but bypasses the payment form that is hosted by
LinkPoint and instead uses orderform.php through the secure URL setting in Advanced Options.

AShop Settings
Under "Add a new payment option..."
1. Select LinkPoint Basic SSL from the drop-down selection box and click Add.

2. Set the store ID in the Merchant ID text box.
Note: Be sure you enter your LinkPoint Store Number, not your merchant number.

3. Set the password that is set for your LinkPoint Basic account in the Security Secret text box.
Note: The other settings are described in Payment Options.

4. Click the Update button to save the settings.
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LinkPoint Basic Merchant Panel Settings - Required
Before the LinkPoint Basic payment integration will work with AShop Deluxe, some URLs must be set
within the LinkPoint Central merchant panel.

1. Login at LinkPoint Central
2. Click "Customization"
3. Click "Settings"
4. Enter the following settings:

· For Order submission form URL enter: http://thecustomersashopurl/checkout.php
· For Thank you page URL enter: http://thecustomersashopurl/order.php. Check both checkboxes

below this setting.
· For Sorry page URL enter: http://thecustomersashopurl/order.php. Check both checkboxes below

this setting.  
5. Click the Submit buttons at the the bottom of the page to save these settings.
6. Click "Payment Form"
7. This page will alloy some payment form customization:

· Set the Company Logo Graphics URL, Background Graphics URL, and Company Name for the
payment form.

· Set custom fields to optionally collect additional information within the payment form.

8. Click the Submit button at the bottom of the page to save the settings.
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Linkpoint does allow multiple referrer URLs. They call it an 'Order Submission Form URL'. According to
their tech you just put a space after the first URL Address, then add the second, but the settings are
limited to 127 characters total.

2.25.16 Manual Payment By Check or Money Order

Manual payment options are for processing orders where payment will be made by check, money
order, or some other form or third party or delayed payment. A manual payment option will not allow
customers immediate access to the digital products. Instead, the store administrator will receive a link in
the e-mailed order notice. Upon receipt of payment, the store administrator may then click on the link to
activate the order. The password and link to the product delivery page is then automatically e-mailed to
the customer.

Note: To deliver digital products before the manual payment or offline credit card processing is activated,
check the Deliver Before Payment box within the payment option parameters (see below).  

Processing And Activating Orders
There are several ways to access the credit card information for processing.

1. When the manual payment processing method is used, the administrator's order notice will contain
a link to login and activate the order.

2. The order activation can also be accessed through the Manage Sales profile for each customer.

3. Unpaid orders can be accessed and activated through Sales Reports by selecting the Unpaid filter
and Edit.

Unpaid orders are shown in the Edit view with an Activate Order icon, , next to each order. Orders
paid by manual payment have an Activate Order icon to the right. Click on the icon to activate that order.
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Create A Manual Payment Option

Create a manual payment option through the Store Configuration > Payment menu.

Check the Deliver Before Payment box only if you wish to provide immediate access to digital products
and subscriptions before the payment is processed and activated.

Activating Manual Payment Orders Immediately

To activate orders immediately upon submission of the manual payment form, edit the manual.gw
module in the admin/gateway directory for US currency. If you are using a different currency, edit the
manual.gw file in the corresponding directory. For instance Great Britain Pounds is gatewaysgbp, Euro
is gatewayseur, etc. Open it in a text editor and change the following line.

From
else $validate[0] = "PENDING";
To
else $validate[0] = "VERIFIED";

2.25.17 Moneris eSelect - Canada only

AShop Deluxe supports integration with the Moneris eSelect payment gateway for Canada only.

We tested the eSelect Plus integration with the following test user/password.
Merchant ID: store1
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Security Secret: yesguy
 
Test Method
The following credit card number works for testing.
4111111111111111 (that's 4 and 15 ones)
Use this credit card number and any future expiration date.

Their test server uses the penny value of the charged amount to simulate different types of
responses. .00, .01 and .04 will approve and all other values will decline.
 
This gateway has a couple of special requirements: the communication with their server is over the port
43924 which must not be blocked by a firewall and like some other gateways it uses Curl with SSL.
Moneris calls the Merchant ID "store ID" and the password is called "api token". To use the gateway
module you must have access to your own secure server (SSL, https connection) since it uses the
orderform.php script on the localhost to collect credit card information.
 
To put the payment option out of test mode the file admin/moneris.inc.php (which is written by Moneris)
needs to be edited and the line: MONERIS_HOST => 'esqa.moneris.com' near the top of the script
needs to be changed to: MONERIS_HOST => 'www3.moneris.com'

Moneris eSelect files in AShop Deluxe
moneris.inc.php goes in the admin directory.
eselect.gw goes in the admin/gatewayscad directory.

2.25.18 Offline Credit Card Processing

The offline credit card processing payment option is used for collecting credit card and billing address
information in order to process payments manually after the sale. The host server must support an SSL
connection to the domain to use this payment option. A security certificate that matches the AShop
URL is recommended to avoid seeing browser security warning messages.

How Offline Credit Card Processing Works

When an offline credit card payment option is selected, the customer is redirected to a payment form
through a secure connection. The secure connection URL is set in Shop Parameters > Advanced
Options. When checking out using this payment method, AShop automatically changes the URL to the
Secure URL and redirects to the secure payment form.

Customer Payment By Credit Card
Customers enter credit card and billing information into the secure payment form and submit it. The
credit card information is encrypted and saved in the database.
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Upon submitting the payment form, a receipt is sent to the customer and notice is sent to the
administrator.
If the "Deliver Before Payment" option (see below) is unchecked, the receipt will include the following
message.

"A manual payment method has been selected for this order. Orders will be fulfilled upon receipt of
payment by check or other means. If a free digital product was requested, delivery will be activated
manually by our store administrator during business hours."

If the Deliver Before Payment option is checked, the orders for downloadable products, key codes, or
subscriptions will be fulfilled. Links and passwords will be included in the receipt.

Processing And Activating Orders
There are several ways to access the credit card information for processing.

1. When the offline credit card processing method is used, the administrator's order notice will contain
a link to login through a secure connection and view the credit card information. When the payment
has been processed, click the Activate button to complete the order and send a receipt with link
and password to access digital products. Activating the order also deletes the credit card number
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and expiration date from the database.

2. The above billing information and activation form can also be accessed through the Manage Sales
profile for each customer.

3. Unpaid orders can be accessed and activated through Sales Reports by selecting the Unpaid filter
and Edit.

Unpaid orders are shown in the Edit view with an activate icon next to each order. Orders paid by offline
credit card payment have an activate icon to the right. Click on the icon to view credit card information
and activate each order. 

Create An Offline Payment Option

Create an offline payment option through the Store Configuration > Payment menu.

Check the Deliver Before Payment box only if you wish to provide immediate access to digital products



AShop Deluxe User Guide124

AShop Internet © Copyright 2002 - 2008

and subscriptions before the payment is processed and activated.

Credit Card Validation And Credit Card Options

Credit card numbers are validated for the correct number of digits and also for the first number, which
must correspond to the credit card type that is selected from the drop-down box.

The security code is validated for 3 digits.
It can be turned off by editing admin/gateways/offline.gw and setting $ccsecuritycode = "FALSE"

The expiration date is validated to be a future date.

Accepted Cards - Visa, MasterCard, American Express, and Discover credit cards are accepted in the
payment form by default. Edit the admin/gateways/offline.gw file to remove options for credit cards that
are not accepted. We will add new credit cards and validation upon request.

$gw_cardtypes = "
<option value=\"VISA\">VISA</option>
<option value=\"MASTERCARD\">MasterCard</option>
<option value=\"AMEX\">American Express</option>
<option value=\"DISCOVER\">Discover</option>";

Common Problems

The offline credit card processing option requires an SSL connection for the entry of credit card
information by customers and subsequent viewing of the credit card information when it is processed by
the AShop administrator.
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If upon check out, the offline payment option is selected and it returns a page not found error, check the
Secure URL setting in Shop Parameters > Advanced Options. A secure URL must be supported by the
server and the secure URL to the directory where AShop is installed must be set as the Secure URL
within AShop.

Garbage characters in the credit card info is caused by a change in the Security Secret for the payment
option that was used for those orders. The Security Secret is used to encrypt/decrypt the credit card
information and if it is changed the decryption of old credit card numbers will fail.

2.25.19 PayNova

PayNova payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings

1. Open the Administration Panel, select Store Configuration, and then Payment.

2. Click on the drop-down Payment Gateway box, select PayNova and click Add.

3. Enter your Merchant ID. The Merchant ID is assigned to you by PayNova.

4. Enter the payoption Security Secret. The Security Secret is assigned to you by PayNova.
Note: PayNova first issues test account details to each merchant which needs to be tested before
they will issue a real live account id and security secret by phone. This means that the account info
will need to be replaced when switching from test mode to live mode.

5. If you wish to do so; you can edit the Option Name, add a Payment Fee, add a Payment
Description, and even edit the Thank You Message that appears upon successful completion of a
transaction.

6. Don't forget to click the "Update" button to save the changes you made.

2.25.20 PayPal IPN

This shopping cart software is certified by PayPal. 

PayPal payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

To add PayPal gateway service as a payment option;

1. Open the Administration Panel, select Store Configuration, and then Payment.

2. Click on the drop-down Payment Gateway box, select PayPal and click Add.

3. Enter the Merchant ID for your PayPal account (e-mail address). PayPal Instant Payments require
a verified business account. The PayPal e-mail address must also be the primary e-mail address for

https://www.paypal.com/us/mrb/pal=648JPWBNC6H8G
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the PayPal account.

You must use your primary PayPal ID, which is case sensitive! If the PayPal account ID set within
AShop is a verified business account address, but is not THE primary e-mail address for the PayPal
account, PayPal will accept the payment, but the response codes from PayPal will list the primary
address instead of the one that is set in AShop. As part of the product file download security, the order
will not be recorded and a password is not generated unless the addresses match EXACTLY.  The
PayPal IPN system is case sensitive, which means that the email address must set in AShop exactly
as it is set for the PayPal account. For example: yourname@yourdomain.com is NOT the same as
YourName@yourdomain.com.

4. The SSL URL to logo image is for the logo that is displayed within the PayPal secure payment
forms and receipts. If you don't have access to SSL, leave this blank for the PayPal logo to appear
at the upper left of the PayPal pages. You may enter the URL to a logo image that is not SSL, but
an annoying message will appear between each PayPal page to alert your customer that there are
secure and non-secure files being loaded.

5. Instant Payment Notification (IPN) must be turned on within your PayPal.com account
settings for orders to be completed and notices to be sent by AShop after payment is received!
Login to your PayPal account and select Profile, then select Instant Payment Notification
Preferences. Check the box to activate IPN and enter the URL to your order.php script. For
example; http://www.your_domain/ashop/order.php

Note: AShop resets the payment response code URL for each transaction when the PayPal payment
window is first opened. This overrides the URL that is set within the PayPal account settings so that
multiple installations of AShop can use the same PayPal account.

Other notes about PayPal

· Collecting the customer's phone number when using the PayPal payment option is possible
through a setting in the PayPal account. After logging in at paypal.com, click profile, click website
payment preferences, select "contact telephone on (optional field)" and finally click save.

· Set the language in the PayPal payment page by adding an extra field parameter in the admin/
gateways/paypal.gw. Add the lc parameter as a hidden field in the section $gw_extrafields. ("lc" is
abbreviation for locale.)
Example, to set American English language, add the following.
<input type=\"hidden\" name=\"lc\" value=\"US\">";

Here are a few lc values supported by PayPal:
DE = German
ES = Spanish
FR = French
IT = Italian
JP = Japanese
US = American English

· The locale in the shipping address sets the language in the PayPal payment page. For
example, if you sell shippable products and the customer selects Spain for the country field in the
shipping information page, the language (lc value = ES) parameter will automatically be sent to
PayPal to select Spanish for the payment page. This value overrides the value that is set in the
paypal.gw file. If you want Spanish language in the PayPal payment page for downloadable products
you will need to add an extra hidden field named: "lc" with the value: "ES" in the gateways/paypal.gw
file. To override this feature and force the language to always be the same, remove the "lc" value for
the $gw_country variable in the paypal.gw file. Then, the added hidden field (lc value = ES) will always

http://www.paypal.com/
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will set the lc parameter to "ES" regardless of the shipping destination.
Find this line of code: $gw_country = "lc";
Remove the lc setting: $gw_country = "";

· Curl with SSL - PayPal and some other payment gateways require Curl with SSL to be available.
There will be an error during the payment process if Curl with SSL fails. See also: PayPal Curl Error

2.25.21 PayPal Item Number - 2ashoporderstring4a

Starting in AShop Deluxe 2.1,there is a field on the PayPal confirmation page that reads "Item Number:
2ashoporderstring4a". What is this and where does it come from?

 The simple explanation is that the shopping cart requires more security than the PayPal IPN
provides. It must pass information through and compare it before allowing orders to be fulfilled and this is
the only way to pass the information through the payment process.

The more complicated explanation is...
The "2ashoporderstring4a" is a version of the product string, which contains information about which
products have been ordered. In previous versions of AShop this was an 'a' separated list of product id's
that was split apart by the different scripts to find out what the shopping cart contained or what had been
ordered. Since some of the payment gateways don't allow for more custom fields to be sent we needed
a way to pass through information about which payment method had been chosen without adding
another field. This information was added to the beginning of the product string, which became the order
string.

The 'ashoporderstring' is used to split apart the information about which payment option (id 2 in this
case) has been used from the old product string. The reason for making it a word instead of just a single
letter is that it needs to be clearly identifiable by the order script to make sure that the value of the right
field (the name of the field differs between the different gateways) is used. order.php searches through all
input fields that has been sent and when it finds a field that contains 'ashoporderstring' it uses it as the
product string.

2.25.22 PayPal Pro & Express Checkout

This shopping cart software is certified by PayPal. 

How to set up PayPal Express Checkout and Web Site Payments Pro

1. Request API Credentials from PayPal

Website Payments Pro service must be activated in your PayPal Business account.
An application through paypal.com is required and fees must be paid before Website Payments Pro or
Express Checkout will work in the shopping cart. To use the Payment Pro options you will need a
certificate file, a Merchant ID, and a password.

Login to your PayPal account and go to the Website Payments Pro section.

https://www.paypal.com/us/mrb/pal=648JPWBNC6H8G
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A. Login to your PayPal Pro enabled PayPal account and click Profile.

B. Click "API Access" under the section "Account Information".

C. Click "Request API Credentials".

D. Select "API SSL client-side certificate", check the box "I agree" and click "Submit". The API
Username on the following page should be entered into the box labeled "Merchant ID" in your
AShop payment option and the API Password should be entered in the box labeled "Security
Secret".

E. Click "Download Certificate" and save the file named "cert_key_pem.txt" somewhere on your hard
drive.

F. Upload the certificate file to the directory admin/paypal where you installed your AShop Deluxe on
your website.

2. Upload the PayPal Pro program files from AShop

PayPal's Website Payments Pro SDK (Software Development Kit) must be installed on your server. This
can be done at domain level or the SDK software may be installed centrally on the server, which reduces
setup time and disk space usage.

IMPORTANT: If your domain is hosted with a service where PayPal SDK software is installed
centrally on the server (for example the SDK software is in the PEAR repository), skip this step.
Installing the SDK scripts in the admin/paypal directory when the SDK is already installed
centrally will break the PayPal Pro payment options.

On most Unix/Linux servers you should only need to upload the separate SDK files that we distribute to
the admin/paypal subdirectory in the directory where you installed AShop Deluxe.

* On some servers you might need to ask your hosting provider to activate PEAR (a PHP code
repository) and possibly also install the PayPal SDK in PEAR. The SDK and installation instructions are
available at: http://www.paypal.com/sdk

To reduce bandwidth usage, the SDK files are not distributed with the shopping cart program installation
or update packages. The SDK files can be downloaded from PayPal.com or from AShopSoftware.com.

You will need to first download these files and upload them to your server in the "admin" directory where
AShop is installed (i.e. yourdomain.com/ashop/admin or yourdomain.com/admin). 

The PayPal Pro package will have all the necessary files in a folder named "paypal", update the entire
folder into the admin directory.

3. Setup PayPal Website Payments Pro in AShop

A. Login to your AShop Deluxe administration panel and click Store Configuration->Payment.

B. Select PayPal Direct Payment and click Add.

https://www.paypal.com/cgi-bin/webscr?cmd=p/pdn/software_dev_kit_php-outside
http://www.ashopsoftware.com/dlcounter/downloads.php
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C. Enter the PayPal certificate API Username into the box labeled Merchant ID and enter the PayPal
API Password into the box labeled Security Secret. Then click the Update button.

D. Select PayPal Express Payment and click Add.

E. Enter the PayPal certificate API Username into the box labeled Merchant ID and enter the PayPal
API Password into the box labeled Security Secret. Then click the Update button.
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Note that the two payment options are set up separately in AShop, but PayPal requires both the
Direct Payments and Express Checkout options to be offered together. The Merchant ID and
Security Secret settings are identical for both options.

2.25.23 PayReady

PayReady payment integration requires access SSL support on the server. This is necessary because
the credit card information is collected through a page that is hosted on the server where AShop is
installed.

Note: There is a hosted payment form option available from PayReady. We don't use it because it uses
the GET method for postbacks, which causes security issues.

PayReady Test Account
PayReady provides a test account that is publicly available. Specific card number and billing information
is required in order for test payments to be accepted.

Account username (Merchant ID): PayReady.net Test Account
Credit card type: Visa
Credit card number: 4012000010000
Security code: 999
Total amount: between $1.00 and $150
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Expiration date: Apr 2004
Address* : 8320 SOUTH HARDY DRIVE
City* : TEMPE
State* : AZ
Zip* : 85284

* Only needed to get an exact AVS match

2.25.24 PaySat

PaySat payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings

1. Open the Administration Panel, select Store Configuration, and then Payment.

2. Click on the drop-down Payment Gateway box, select PaySat and click Add.

3. Enter your Merchant ID. The Merchant ID must be set to the PaySat Merchant assigned to you by
PaySat.

4. Enter the payoption Security Secret. The Security Secret must be the secret word that you can
enter for a domain in your PaySat account.

5. Enter your Page ID. The Page ID must be the Domain ID for your domain in the PaySat account.

6. If you wish to do so; you can edit the Option Name, add a Payment Fee, add a Payment
Description, and even edit the Thank You Message that appears upon successful completion of a
transaction.

7. Don't forget to click the "Update" button to save the changes you made.

PaySat Setting

1. Set the Return Page URL for the domain in your PaySat account to the URL of your AShop followed
by: "/admin/paysat.php" For example: http://www.yourdomain.com/ashop/admin/paysat.php

2.25.25 Plug-N-Pay

Plug-N-Pay payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings
1. Open the Administration Panel, select Store Configuration, and then Payment.
2. Click on the drop-down Payment Gateway box, select Plug-N-Pay and click Add.
3. Enter your Merchant ID. The Merchant ID is assigned to you by Plug-N-Pay.

Note: Test Mode is set within the Plug-N-Pay administration panel at https://pay1.plugnpay.com/
admin. Don't forget to change this setting after testing.

4. Click the Submit button to save changes.

https://pay1.plugnpay.com/admin
https://pay1.plugnpay.com/admin
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5. Open the AShop file /admin/gateways/plugnplay.gw in a text editor.
6. About half way down the page, there is a setting for the accepted credit cards. Delete the ones that

are not accepted.
name=\"card-allowed\" value=\"Visa,MasterCard,Discover,Amex,Diners,JCB,MYAR\">";

7. Save the plugnplay.gw file on the server.

Plug-N-Pay Settings

There are not any settings required in the Plug N Pay merchant panel in order to use it with AShop.

Important Note: The payment confirmation page, which is a combination of the delivery.html page
template and the thank you text, is nested within a secure page that is hosted by Plug-N-Pay. All links
within the page template and thank you text must be absolute. To avoid browser security warnings from
popping up, all image links must be through secure connections (https).

Company Logo Image In Payment Form
Unlike most other payment gateways, Plug-N-Pay does not support the inclusion of a logo image from
the shopping cart program and merchants cannot customize the payment pages themselves. Plug-N-
Pay support staff can change colors, add your company logo and/or background image within the
payment form by requesting this through their online help desk, which is located within the Plug-N-Pay
merchant panel . Any other changes to the payment form will most likely require custom programming
by Plug-N-Pay for a fee.

Currencies Accepted
Plug-N-Pay can process in multiple currencies. But it is up to the merchant to have a merchant account
in the applicable currency. Except under some rare circumstances a single merchant account can
handle only 1 currency. For instance, if a merchant is setup on the Plug-N-Pay system as processing in
Euro then all amount data would be sent to PnP in Euro's. The currency symbol displayed within the
PnP payment form is the same currency symbol that is set within the AShop Administration Panel >
Store Configuration > Shop Parameters and used for display purposes. Plug-N-Pay integrates into
several international processors in Europe and the Caribbean.

2.25.26 PSBill

PSBill payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings

1. Open the Administration Panel, select Store Configuration, and then Payment.

2. Click on the drop-down Payment Gateway box, select PSBill and click Add.

3. Enter your Merchant ID. The Merchant ID is assigned to you by PSBill. The Merchant ID should be
set to the PSBill SiteID without the leading "S".

4. The transaction key can be found by logging in to the PSBill backend, clicking Site List in the
menu, clicking the Site's Name and finally clicking Password File Setup in the menu. It is referred
to as the "password script key" in the PSBill backend.

5. If you wish to do so; you can edit the Option Name, add a Payment Fee, add a Payment
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Description, and even edit the Thank You Message that appears upon successful completion of a
transaction.

6. Don't forget to click the "Update" button to save the changes you made.

7. To setup the postback to the Ashop Deluxe order processing follow the steps above in step 4 and
then enter:
http://www.yoursite.com/ashop/admin/psbill.php in the text input box on that page (replacing "http://
www.yoursite.com/ashop" with the right URL to the site).
Then click the "Get Password Script" button and cancel the download that will result from this.

2.25.27 TeleSign Phone Verification

How to Activate the TeleSign Phone Verification:
There is a setting in your Administration Panel under Store Configuration > Shop Parameters labeled
TeleSign Customer ID. A valid TeleSign ID must be saved here.

In Store Configuration > Payment, for each payment option there is a check box to enable TeleSign.
Check the box for payment options that are to use TeleSign phone verification.

* Don't forget to click the "Submit" button to save any changes you make.

How TeleSign Phone Verification Works:
In the payment form, if TeleSign is enabled, there is a comment below the phone number field.

When the payment form is submitted, the customer is redirected to a verification page. TeleSign
automatically calls the customer's phone number and gives a numeric code, which must then be entered
into the verification page and submitted to complete the order. The credit card information is not sent to
the payment gateway until after the verification is complete, which reduces or eliminates the need to void
and refund fraudulent transactions. This saves time and money. It works because theives typically do not
want to risk being found by caller ID or a phone trace. It also works because most of the fraud rings are
typically in Asia and Africa and their phone service may be limited.
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** Note
TeleSign Phone Verification works with Payment Gateways, such as these, that use the AShop
payment form:
Authorize.Net AIM, Verisign PayFlo Pro, eSelect, Echo, and offline processing.

It does not work with payment options where the payment form is hosted on the processor's server such
as:
Authorize.Net SIM and the majority of other payment options.

** TeleSign Phone Verification is not a Payment Gateway in itself, but a tool to help prevent
credit card fraud.

2.25.28 Verisign PayFlow Link

AShop Administration Panel Settings
Verisign PayFlow Link payment integration is set in the AShop Administration Panel through Store
Configuration > Payment.

Verisign Settings
In PayFlow Link Info configuration page set:

Return URL Method to LINK
Return URL: To website URL link you wish to send customers to when they complete payment.

Assure box is checked for Silent Post URL and enter
http://www.yourwebsite.com/ashop/order.php

This allows Verisign to post the info back to the cart with the Silent Post URL, but allows you to send
people back to the website with the Return URL. Otherwise the orders are not recorded and receipts are
not sent.

The VeriSign payment form must be configured to collect the billing address and email address of your
customers. Login to VeriSign Manager, click Account Info, click PayFlow Link Info. Under the section
"Billing Information" check all boxes for "Required Fields" and "Editable Fields" except "CSC" (unless
you want to enable the Card Security Code feature).

2.25.29 Verisign PayFlow Pro

PayFlow Pro is a backend payment processing method. The payment form is generated by the AShop
script orderform.php. SSL support is required.

Setup
1. To integrate AShop Deluxe with the PayFlow Pro gateway, PayFlow Pro client software must be

installed on the server. It is available on the Downloads page of Verisign Manager. Installation
instructions are included with the client software.

Note: The PayFlow Pro software only needs to be installed once on the server. It is already installed
on AShopWebHosting.com servers and is available to all hosted domains. The only thing that is
needed to make it work for a new site on our server is to add the certs directory with its contents.

http://www.ashopwebhosting.com/shopping-cart-web-hosting-plan-comparison.htm
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2. Put the f73e89fd.0 file (included with the client software) in the certs subdirectory of the directory
where you installed AShop.

Test Mode
Credit Card Numbers For Testing
Visa: 4111111111111111
MasterCard: 5555555555554444
American Express: 378282246310005

The AShop payment option AND the Verisign account must be in test mode in order for these test
numbers to work. Besides activating test mode in the Verisign account, you must also deactivate all
security filters in the VeriSign Manager to make test mode work. The filters will cause all transactions to
be declined since test mode doesn't support them.

To set test mode in the Verisign account...
1. Login to the Verisign Manager and go to the Security page
2. Click Test Setup
3. Click Edit Filters
4. Deactivate all the filters and click Continue
5. Click Continue once more
6. Click Deploy Test Mode and finally click Finish.

Troubleshooting
It is very easy to confuse the settings between Verisign and AShop. If everything seems right, but the
credit cards are denied, double check the payment option settings within AShop.

The Merchant ID setting within AShop is the Verisign Username.
The Security Secret setting within AShop is the password for the Verisign merchant account login.

2.25.30 ViaKlix

1. Login to your viaKLIX account at https://www2.viaklix.com/Admin/login.asp
2. Click "Terminal Setup" in the menu.
3. Click "Adv System Config" in the submenu.
4. Enter the full URL to your AShop orderform.php script in the "Authorizes Referrers" field

Example: https://mydomain.com/ashop/orderform.php, and click "Add Referrer".

2.25.31 WorldPay

WorldPay payment integration is set in the AShop Administration Panel through Store Configuration >
Payment.

AShop Settings
1. Open the Administration Panel, select Store Configuration, and then Payment Options.

2. Click on the drop-down Payment Gateway box, select WorldPay and click Add.

3. Enter your Merchant ID. The Merchant ID is assigned to you by WorldPay and is also referred to as
your Installation ID.

https://www2.viaklix.com/Admin/login.asp
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Note: Test Mode is set to yes by default. Don't forget to change this setting after testing.  

4. Click the Submit button to save changes.

WorldPay Settings
1. Open a browser and log in to your WorldPay Administration Server with the user name and

password that was assigned to you by WorldPay. https://select.worldpay.com/wcc/admin

2. Under Installations for (your company), click the corresponding arrow under Configuration options for
this Installation ID.

3. In the Callback URL text box, enter the URL to the AShop order.php script. This URL will be
something like http://www.yourdomain.com/ashop1/order.php

4. Check Callback Enabled.

5. Check Use Callback Response

6. Save Changes.

Note: WorldPay grabs the callback URL page and displays it from their server. If you are using
HTML page templates, the images and links within the delivery.html template must have absolute
URL's.

As mentioned in previous notes, there are other settings that you will probably want to change in the
WorldPay Administration Server. After completing any other changes and successfully testing the
payment process, uncheck the Test Mode box as mentioned in step 2. Submit a completed Activation
Request Form (AR) to WorldPay. Once WorldPay Technical Support is satisfied with your site, they will
set your site to live. The Technical Support Team will send you confirmation by email that your web site
can go live, together with any technical changes you must make to enable live operation.

2.25.32 Payment Gateway Modules

For each supported currency there is a set of payment gateway modules, which contain settings for
each gateway. The gateway modules are pre-configured and under most circumstances do not require
modification.

Important! Payment gateways do not follow a standard format or system. Complexity of integration
varies widely among payment services. Depending on the payment gateway, integration may only
require settings in a gw file or it may require installation of additional software. For some gateways
modification of the AShop code may be required. Also, some payment services may not support all of
the required data exchange for the shopping cart to function fully and some payment service may be
problematic. Modify the payment gateway modules and create new ones at your own risk! We do NOT
provide technical support for custom made payment modules.

Gateway Directory Names and Currencies
In the admin directory, there is a directory for each currency.

https://select.worldpay.com/wcc/admin
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· gateways - U.S. Dollar
· gatewaysaud - Australian Dollar
· gatewayscad - Canadian Dollar
· gatewayseur - Euro
· gatewaysgbp - Great Britain Pound
· gatewayssek - Swedish Krona
· gatewayssgd - Singapore Dollar

For each currency there is a set of payment gateway (.gw) files. Each payment gateway file is named
with an abbreviation for the payment service that it is configured to work with.

Payment Gateway Module Variables

$gatewayname = the name of the payment processor as it will appear in the AShop administration panel

$paymenturl = the URL to which AShop should post order information.
For gateways that require the merchant to collect credit card information on the merchant's site the
function process_payment is used instead and this URL should be set to the orderform.php script that is
included with AShop.

$postbackurl = the URL to the AShop order.php script which will receive the postback of order
information from the payment gateway and then process the order.



AShop Deluxe User Guide138

AShop Internet © Copyright 2002 - 2008

$visibleorderprocessing = should be set to TRUE or FALSE.
If it is set to TRUE then the order.php script will process the order directly in the customer's web browser
and then show the thank you text if the order was processed successfully. If it is set to FALSE then the
order.php script will be called through server to server communication with the gateway to process the
order and the thank you text will be shown to the customer regardless of the result of the order
processing.

$resultpagessl = should be set to TRUE or FALSE.
If it is set to true then the order.php script will produce an SSL adapted version of the thank you page.
This is used by some gateways that fetch the thank you page from their own URL instead of redirecting
the customer back to the merchant's site.

$sendpayoptionid = should be set to TRUE or FALSE.
Payment gateways that require the merchant to collect credit card information on the merchant's site
should set this to TRUE. All other gateways should set this to FALSE.

$noquerystring = should be set to TRUE or FALSE.
This was added to fix a problem with some payment gateways that check the referring URL and need an
exact match, with the exact same query string. Setting this to TRUE will simply remove the query string
from the AShop script that sends the order information to the payment gateway.

$gw_orderid ... $gw_shipcountry  = the field names of all the order information.
Change these to the field names required by the the payment gateway. For example: if the gateway
requires a variable named totalamount which should contain the amount to be paid then the $gw_amount
variable should be set to: "totalamount". Fields not needed by a specific gateway can be set to "".

$gw_extrafields = if any extra gateway specific fields are needed this variable should contain them as
html input tags of the type hidden. For example: a payment gateway requires a field named x_Method
with the value "ECHECK", the $gw_extrafields can then be set to: <input type=\"hidden\" name=
\"x_Method\" value=\"ECHECK\">

$testrequest = set this to a hidden html input tag with the name and value of a variable to request test
mode if the gateway supports this. Checking the text mode checkbox for the payment option in the
AShop admin panel will then result in this input tag being included in the payment request.

$gw_parameters['settingname'] = these should be set to true or false and will activate or deactivate
the corresponding setting in the AShop admin panel for a payment option using this gateway. For
example: setting $gw_parameters['testmode'] to "true" will make the test mode checkbox appear
for this gateway when used in a payment option in the admin panel.

Payment Gateway Module Functions:

authenticate($gateway_input, $securityhash, $merchant) - checks that the payment has been
authenticated by the payment gateway.

The $gateway_input array contains all the order information fields sent back to the AShop order.php
script, for example: $gateway_input['orderid'] will contain the value of the field orderid if such a field
is posted back to AShop.

The $securityhash variable contains any security hash string or password used by some gateways to
make sure the order information has not been manipulated in any way.

The $merchant variable contains the merchant's username or merchant ID with the payment gateway
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and can be checked against any returned field that should contain the same value to add more security.
The function should set $validate[0] to "VERIFIED" if the authentication is successful or "INVALID" if
not. The variable $validate[1] can also be set to any message containing the reason why the
authentication failed if such a message is returned by the gateway.

process_payment($user, $password, $vspartner, $cardtype, $ccnumber, $seccode, $expdate, $amount,
$invoice, $firstname, $lastname, $address, $city, $zip, $state, $country, $phone, $email, $testmode,
$description) - used to process the payment by gateways that require that the merchant collects credit
card information on the merchant's site.

The $user and $password variables are used to authenticate the merchant on the payment gateway's
server. The remaining variables contain the corresponding payment and order information to be used by
the function for processing, for example by using Curl to post the information to the gateway.

If the payment is successfully processed the variable $result["RESULT"] should be set to "success".

The variable $result["REMOTEORDERID"] should also be set to the transaction ID of the payment as
returned by the payment gateway and $result["RESPONSEMSG"] can be set to any response message
from the gateway.

If the payment has failed then the variable $result["ERROR"] should be set to the error returned by the
gateway.

parse_response($gateway_input) - maps the fields returned by the payment gateway to the
corresponding variables used by AShop.

2.26 eMerchant Configuration

2.26.1 eMerchant Configuration

From the AShop admin panel, click on the eMerchant link in the main navigation bar on the left. At the
top of the page, select Configuration.

Spam Protection

Upon login to the eMerchant panel, eMerchant gets email messages from your POP3 mailbox and
transfers the messages to the eMerchant customer inbox. When the box labeled Block POP3 email
from unregistered senders is checked, only email from known contacts will be transferred to the
customer inbox. All other messages will go to the spam bin where they can be browsed and saved
individually before dumping. For messages to be moved to the inbox the following conditions must be
met.

· Sender is already in the inbox. 
· Sender is already on the contact list. 
· Domain of sender is on accepted domain list. 
· Message was submitted through and eMerchant contact form. 
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To accept all mail from specified domains, add the domains to the list of Accepted domains. Do NOT
include http or www before the domain name. Separate each domain name by a line break [Enter].
Submit the form when done to save changes.

Spammers often forge the reply address in an attempt to spoof recipients into opening messages.
eMerchant compares the reply address with the actual sender address, which is in the email header. If
the reply and sender addresses do not match, then the message goes to the spam bin. This is an
effective method to block spam, however bulk mailings from known contacts may use similar mailing
methods where the sender address in the header is different from the reply address. If a message from a
known contact is found in the spam bin, this is most likely what has happened. To accept messages
from the sender in the future, save the message from the spam bin to the customer inbox and then save
it from the customer inbox to customer history. (Click on the Save icon to the right of the message) If the
reply address already exists in a customer profile, the new sender address will be added to the same
customer's profile under alternate email addresses. Then all future messages from that sender will not be
blocked and messages to/from that sender will automatically be saved in the same customer's history.

Mail Server Type

Mail may be received in the eMerchant inboxes from a POP3 or IMAP mailbox. The IMAP setting is only
available if the IMAP extension is installed on the server. Otherwise, it will silently default to POP3.

When the Mail Server Type is changed, the Port settings for customer and vendor mail (see below) will
automatically change to the default port for that server type. The Port settings may then be changed if
the mail server is on a non-standard Port.

Do NOT use other POP3 email clients when eMerchant is set to use IMAP!
When IMAP is used there is one very big difference in how the mail is handled. IMAP keeps the mail in
the mailbox on the mail server, while POP3 downloads the mail and stores it in the emerchant/mail
directory. The emerchant/mail directory is still used with IMAP but only to save outgoing mail. This
means that if a client-side POP3 email client such as Outlook is used to get messages from the same
mailbox, the source of messages will be removed and the messages will be blank when viewed in
eMerchant. Since Horde webmail also uses IMAP, it can be used to access messages from the same
mail account even when eMerchant is set to use IMAP, but there is one limitation. When a message is
opened in eMerchant it is marked as read in Horde. If is deleted from eMerchant it will be deleted in
Horde, but if the message is deleted in Horde it is NOT deleted in eMerchant.

The mail server must be on the same machine as eMerchant when using IMAP!
IMAP should not be used when the web site running eMerchant is not the same machine (or at least on
the same network) as the mail server. The entire email is downloaded from the mail server every time it

http://en.wikipedia.org/wiki/Post_Office_Protocol
http://en.wikipedia.org/wiki/Internet_Message_Access_Protocol
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is opened in eMerchant. If the mail server is on a remote server, messages could be slow loading. When
eMerchant is installed on the same machine as the mail server, IMAP will typically open messages
faster and it is capable of handling larger attachments than the POP3 method, which uses a PHP
extension.

Customer Mail Account

· Set the Customer Mail Address to the address of the POP3 mailbox where customer email is
received. For instance service@yourdomain.com. This will be the reply address in messages sent
to customers from eMerchant.

· The Mail Server setting is typically something like mail.yourdomain.com.
· The Account Username is may be the first part of the mail address if the POP3 mail server will

accept the short username, but on some servers it must be the full username including the domain.
For example, the username "service" may work on some servers and the username
"service@yourdomain.com" may be required on other servers.

· The Password is the one that you have set for that mail account through your hosting service.
· The Mail Port is typically 110 when using POP3 or 143 when using IMAP.

The POP3 mailbox will be checked and mail downloaded automatically to the customer inbox upon
logging into eMerchant.

If the admin email setting, which is set in Store Configuration > Shop Parameters is set to the same
address as the eMerchant customer email address, all admin notices will post directly in the eMerchant
customer inbox (not sent by email to the POP3 mailbox). This method is more reliable and secure than
sending admin notices by email and it reduces the load on the local mail server. If the addresses are
different, the admin notices will be sent as regular email (same as when AShop Deluxe is installed
without eMerchant).

Vendor Mail Account

Vendor mail is received separate from customer mail so that the messages can be processed and saved
in relation to vendors and purchase orders. To use the vendor mail features, create a separate POP3
mailbox for vendor mail and configure the Vendor Mail Account settings in eMerchant with the matching
POP3 settings. The vendor mail inbox does not use spam blocking. If you do not publish the vendor
email address, spam will typically not be an issue in this area. If the vendor email does become
comprimised, a spam filter such as SpamAssassin can be applied to the POP3 mailbox.

The Vendor Mail Account settings are set in the same way as Customer Mail, but with a different
mailbox.
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Automatic Billing

These are the default settings for bills and related messages that are sent to customers. In eMerchant,
each order begins with a quote. When a quote is converted to a bill there are bill options, which will be
preset with these values and may then be edited for each bill.

2.26.2 Add/Edit Users

eMerchant may be used by an individual or by multiple users. There is no limit to the number of users
that can be created in eMerchant. When logged in as admin all available data is visible and all options
are available. When logged in as any other user, some data and options are hidden.

Add and edit eMerchant users through the AShop admin panel. Click on the eMerchant link on the left
side and then click the Manage Users link at the top of the page.
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eMerchant User Login

The admin user may login through the AShop admin panel. There is also a direct login to eMerchant,
which will be a URL similar to http://www.yourdomain.com/emerchant/ or http://www.youdomain.com/
ashop/emerchant/ depending on where AShop is installed in your domain. All users may login directly at
the emerchant directory. A redirect (index.html) goes to emerchant/login.php.

The admin user may have the same password as for the admin panel or a different one. The default
admin password when eMerchant is first installed is "emerchantadmin".

Add New eMerchant User

Click on the Add new user link, enter the new username and password, then click Update.

Edit eMerchant User

Click on the profile icon to the right of the user that is to be edited. Edit the settings and then click
Update to save the changes.

Delete eMerchant User

Click on the trash icon to the right of the user that is to be deleted. A confirmation page will open. Click
yes to delete the user. Note that the admin user cannot be deleted.
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2.26.3 Vendors and Products

To create purchase orders and track order status each product must be assigned to a vendor. Products
are assigned to vendors through the AShop admin panel in Edit Catalog, but before this can be done
vendors must first be added through eMerchant.

Add New Vendor

Click on the New Vendor button. Add the vendor contact information and click Save.

Assign Each Product to a Vendor

Assign each product to a vendor through the AShop admin panel Edit Catalog menu. Click on the edit
button for each product. When eMerchant is installed and at least one vendor has been added, there will
be a drop-down selector in each product page. Select a vendor and save the product. 

Note that products are not required to be assigned to a vendor. All active products will appear in the
shopping cart regardless of their vendor relationship. The vendor assignment simply enables automation
within the eMerchant system. For example, when an order is received and it includes products that are
assigned to a vendor, the order will appear in eMerchant > Vendors > Open Orders with an option to
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automatically generate a purchase order, filled in with the vendor, customer, and product information.
Example 2: When manually creating purchase orders the vendor products are selectively displayed
depending on which vendor the purchase order will be sent to.

See also: eMerchant > Vendors

2.26.4 Contact Forms

eMerchant contact forms post directly to the eMerchant inbox (database) and do not send any email. 
An image recognition character entry requirement in the form prevents most automated spam
submissions. When used with an https connection, the eMerchant contact forms provide a secure way
to receive sensitive information from a web site submission.

The contact form requires three files, which are distributed in the emerchant directory.
· mailform.php (This is the program script. It is not editable.)
· mailformtemplate.html (This file defines the page layout and form fields. Edit this file.)
· thankyou.html (This file defines the confirmation page, after mailform.php is submitted. Edit this

file.)

The contact form files will work in the emerchant directory or within any directory that is at the same
relative level as the emerchant directory. An unlimited number of custom contact forms may be created
by copying these three files, modifying the html files as needed and uploading the files to separate
subdirectories within the directory where AShop Deluxe is installed.

To set up a contact form, edit the mailformtemplate.html and thankyou.html files in an HTML editor.
Copy and edit the example mailformtemplate.html, which is provided in the emerchant directory. Add or
delete fields as needed, but do NOT delete any of the following required fields or the %errormessage%
and %securityimage% tokens. The fields may be hidden, but a value must be set for each of the
following form fields.

· firstname
· lastname
· email
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· confirmemail
· subject
· message
· securitycheck

Tokens are used to set the value of each text field in the form. A token is the name of the field bracketed
with percentage characters. For example, the text field with name="firstname" also has the parameter
value="%firstname%". Each text field should have a value such as this, which corresponds with the field
name. The tokens are used by mailform.php to repopulate the fields if there is a validation error and the
page must be reloaded.

The thankyou.html file is simply an HTML file. There is nothing special about it except for the name and
location.

2.26.5 Quote Header/Footer

Each order begins as a quote. Quotes may be saved and sent to customers by email. Each quote may
then be converted into a bill (unpaid order) or a paid order. The content of emailed quotes includes
header and footer content, which is set in the editable emerchant/header.inc.php and emerchant/footer.
inc.php files. Plain text and html may be used in the header and footer.

2.26.6 Recurring Bill Templates

Billing templates are created through the admin panel in eMerchant > Billing Templates. Billing
templates are currently supported for Authorize.net ARB and eMerchant AutoBill recurring bills.
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To automatically initiate recurring billing or ARB from orders, first create a billing template. Then each
product may be assigned to a billing template through Edit Catalog > Edit (for each product).

Authorize.net ARB
Authorize.net ARB billing templates create ARB (automated recurring billing) in your Authorize.net
account from product or subscription orders that are placed through the shopping cart and through
eMerchant. Each ARB is created from the credit card information that was used to pay for the order. If
more than one of the products in the order is assigned to an ARB billing template, an ARB will be
created in Authorize.net for each of the products individually.

PCS Compliance
Credit card numbers, expiration dates and security codes are saved by Authorize.net on their secure
server. Credit card numbers, expiration dates and security codes are only transmitted across a secure
encrypted connection and they are NOT saved on the local server.

Authorize.net Account With ARB Is Required
Before billing templates can create new ARBs in Authorize.net, you must have an account with 
Authorize.net and ARB service must be activated for the account. Also, a payment option for Authorize.
net AIM or Authorize.net SIM must be created in the AShop admin panel. If other payment options are
also offered in the shopping cart, the Authorize.net ARB billing templates will not work with them and
there is not a method in the shopping cart to offer different payment options specifically for each product.

How to Add an Authorize.net ARB Billing Template
Select Authorize.net ARB. Give it a name, which will be for your own internal reference. Click Add.

In the new billing template, set the ARB parameters.
· Template name is for your internal reference. It is used to assign a billing template to each product.
· Start is the number of days after the order when the ARB will begin.
· Recurring may be weekly, monthy, quarterly, semiannual, or annual.
· Repeat is the number of times that the ARB will occur before it ends. Set this to 0 (zero) for the ARB

to continue indefinitely.
· Click Update to save the settings.

http://www.freeauthnet.com/index.php?partner=100004
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AutoBill Recurring Bills
When a recurring bill template is set to initiate an AutoBill and a product, which is set to use that billing
template is ordered through the shopping cart or eMerchant, eMerchant will subsequently create new
unpaid orders for the product and send invoices on a preset billing cycle. If more than one of the
products in the order is assigned to a billing template, a recurring bill will be created for each of the
products individually.

PCS Compliance
This method does not save any credit card information and it does not automatically debit any credit
card or PayPal. Customers receive invoices and may pay each bill by any option that you offer; online or
offline. A payment link is included in each invoice. It links to the payment page in the shopping cart.
When an AutoBill is paid online through the payment link, payment is applied directly to the unpaid bill
and a confirmation notice is automatically sent. When payment is received offline, for examply by check
or electronic funds transfer, payment may then be applied manually through the Sales Reports for
Unpaid orders.

How To Add an AutoBill Billing Template
Select AutoBill. Give it a name, which will be for your own internal reference. Click Add.
· See eMerchant > Bills and Recurring Billing for a list and description of the AutoBill parameters.

Assign Products To Billing Templates
To use a billing template, assign a product to a billing template and set a recurring amount. Do this
through Edit Catalog. Click on the Edit button for each product. When eMerchant is installed and at
least one billing template exists, there will be a drop-down selector for billing template assignment and a
text box to set the recurring amount. If no recurring price is set the retail price of the product will be
used. The amount of the recurring bill or ARB will be multiplied by the quantity that is ordered.

Manage Unpaid Bills
Unpaid Orders are reported in the admin panel under Sales Reports. Select status Unpaid and Edit
mode to manage unpaid orders and to send reminders. Unpaid orders also appear in each related
customer's history through eMerchant.
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2.27 Third Party Software Integration

2.27.1 Third Party Software Integration

To integrate AShop to any of the third party software applications that are supported by AShop
Deluxe:

1. Install the program files for the third party software on the same server as AShop Deluxe.

2. Follow the installation instructions for each application. Setup the program and test to ensure that it
is working correctly.

Note: AShop Software does not provide free support for third party application installation or usage.
To get assistance with the installation or usage of a third party application, please contact the
developer or vendor who provided the software.

3. Set the full server path to the directory where the third party software is installed.
You do this in your AShop Administration Panel, go to the Store Configuration, under Shop
Parameters, at the bottom click Advanced Options.

4. See additional notes for each application.

An automation fulfilment option can be used to integrate with third party applications that are
not specifically supported by AShop Deluxe.

2.27.2 AutoResponse Plus

The integration with ARP works similar to the other third party tools. You install it by entering the file
system path in the Advanced Shop Parameters in your AShop Administration Panel (update.php must
be run first in old AShop installations to add the new database fields) and then you can select one of the
autoresponders in a drop down list on the Add/Edit product/subscription pages. Whenever a customer
buys one of the products he/she will automatically be added to the corresponding autoresponder and
receive the first follow up message.

There is one thing that can cause trouble with the ARP integration. An open basedir restriction will
prevent the AShop scripts from reading the ARP config file. To fix this...

Copy the config file (it is called arp3-config.pl) to another directory, such as httpdocs, where it can
be read from php. Set the AShop third party software configuration (set in the Advanced Shop
Parameters) to this path. It needs to be an exact copy of the actual config file that is used for ARP
on the site.

OR
Add the cgi-bin directory to the open basedir in the httpd.include file for the domain.
For example: /home/httpd/vhosts/yourdomain.com/conf/httpd.include

There are two methods of signing up with an ARP autoresponder. You can either use an html form or
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simply send an email to an address that is connected to the autoresponder. The email is the unique
identifier of each autoresponder in ARP, which is why it is used in the drop down list within AShop
Administration Panel > Edit Products for each product. To be able to use the email method a mail filter
needs to be installed which runs an ARP script automatically when a message is sent to a certain
address.

Note: See ARP instructions for installation of ARP and mail filters.

You don't need to have a mailbox for each email address that is to be used in ARP. You can simply use
the catch all option in the server administrator, and you don't need to use the email sign up method of
ARP at all to be able to use it together with AShop. No additional configuration or setup other than what
is described in the install.txt of ARP is needed for the AShop integration but if you want the email sign
up method you must create a mail filter.

The first ARP message will be sent immediately when customers purchase associated products. Cron
jobs must be setup for ARP to automatically send subsequent messages.

Note: If ARP is installed in a subdomain, add the subdirectory path extension to 3 of the fields in the
arp3-settings.pl script file. For instance: /dir/subdir

Troubleshooting Tips

Internal Server Error When Running ARP
It seems like the most common problem with cgi scripts is that they have the wrong type of linebreaks
(Windows instead of Unix). This might happen when you upload the scripts with ftp in binary mode
instead of ascii mode. 

Tips for AutoResponse Plus Users

Sending new messages to subscribers who have already finished the sequence
If you add new messages to a follow-up sequence and want "Finished"
subscribers to get those new messages, here's the process:

1. Set autoresponder status to "Suspended".

2. Add your new messages.

3. Set autoresponder status to "Active".

4. Filter subscriber list by autoresponder and status "Finished"

5. Use Subscribers > Group Tasks > Edit to set their status to "Active" en masse.

They will be added back into the sequence and carry on from where they left off.

After they have received the new messages, they will be re-flagged as "Finished".

Note that the above will only work if messages are added at the end of the sequence,
not in the middle of it. 
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2.27.3 ListMessenger Lite & Pro

ListMessenger Lite is a free mailing list management program written in PHP using a mySQL database.
The program files can be downloaded from http://www.listmessenger.com/index.php.

When ListMessenger Lite or Pro is installed on the same server as AShop and the path to
ListMessenger is set within the third party software integration, each product can be associated with a
ListMessenger mailing list group.

A drop down list will appear on the add product and edit product pages where you can set the mailing
list group. When someone buys the product, they will automatically be added to the corresponding
group within ListMessenger Lite.

The full path to the ListMessenger directory must be set.
Example: /home/username/public_html/listmessenger

2.27.4 Password Administrator+

Password Administrator+ (PA+) is a commercial password management program. PA+ is no longer sold
or supported by its author. However we still support it in AShop for existing customers who already have
it. 

The author of PA+ ceased distribution of it and began selling Password Robot. You can purchase
Password Robot from their website http://www.passwordrobot.com/. You can find integration instructions
for Password Robot here.

AShop Deluxe supports the sales of subscription access to password protected members only
directories and provides a simple method to remove expired passwords from the list. When PA+ is
installed on the same server as AShop and the path to PA+ is set within the third party software
integration, each subscription can instead be managed after the initial order by using the more advanced
features of PA+.

How AShop Deluxe Integrates To PA+
PA+ is written in Perl. It uses simple text files to store information about members. It uses standard web
server access control to protect the directory/directories, but instead of .htpasswd files it writes to its
own password files called d_pass.txt. Depending on which version of PA+ that you have, each protected
directory may have a corresponding set of: d_active.txt, d_expired.txt, d_inactive.txt and d_pass.txt files
stored in a subdirectory to the directory that the PA+ scripts are installed in or there may be only one
set of corresponding .txt files in the directory that PA+ is installed within (not a subdirectory). The only
thing AShop does differently with PA+ integration is to write to those .txt files instead of to a .htpasswd
file.

Note: When we originally created integration to PA+, in version 3.6, separate sets of password files
could be created in order to manage passwords on multiple directories separately. Somewhere between
version 3.6 and 3.6.5, Illmatic removed this feature and changed PA+ to only administrate passwords in
one directory. They now offer a more expensive application called PasswordRobot to manage more than
one directory.

There is no drop down list on the add subscription page for PA+ integration. Just like with ordinary 
subscriptions you should enter the name of the protected directory in the box labeled: Protected
directory. If a directory with this name exists within the path that is set for PA+ on the third party tools
page, it will be used when a subscription is bought. If there is no such directory AShop will instead

http://www.listmessenger.com/index.php
http://www.passwordrobot.com/
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check for a standard .htpasswd file in $ashoppath/$protecteddirectory. PA+ subscriptions will always
override ordinary subscriptions so you won't have to remove any old protected directories or .htpasswd
files from your $ashoppath to make it work.

To use the PA+ integration
1. Set up the protected directory in PA+
2. Set the path to the cgi-bin directory (not the protected directory itself) where the PA+ scripts are

stored as the $papluspath variable in the AShop Shop Parameters > Advanced Options

Example: /home/httpd/vhosts/yourdomain.com/cgi-bin/subdirectory or /home/httpd/vhosts/
yourdomain.com/cgi-bin

3. Add a subscription in the AShop catalog and enter the name of the protected directory.

2.27.5 ListMail Pro

ListMail Pro is a commercial mailing list management program written in PHP using a mySQL database.
The program files can be purchased and downloaded from http://www.listmailpro.com/.

When ListMail Pro is installed on the same server as AShop and the URL to ListMail Pro is set within
the third party software integration, each product can be associated with a ListMail Pro mailing list
group.

A text box will appear on the add product and edit product pages where you can enter the name of the
mailing list group. When someone buys the product, they will automatically be added to the
corresponding group within ListMail Pro.

The full path to the ListMail Pro directory must be set.
Example: /home/username/public_html/listmailpro

2.27.6 Password Robot

Password Robot is a commercial password management program. It can be purchased from http://www.
passwordrobot.com/.

AShop Deluxe supports the sales of subscription access to password protected members only
directories and provides a simple method to remove expired passwords from the list. When Password
Robot is installed on the same server as AShop and the path to Password Robot is set within the third
party software integration, each subscription can instead be managed after the initial order by using the
more advanced features of Password Robot.

How AShop Deluxe Integrates To Password Robot
Password Robot is a Perl CGI program that lets you easily manage access to an unlimited number of
password protected directories. It automatically deactivates expired accounts, disables abused
accounts, sends personalized HTML e-mail, and stores its data in a MySQL database. Its capacity is
virtually unlimited-- Your site will never outgrow it. It can easily manage thousands of accounts without
slowing down your site, and you can export your data directly from Password Robot's admin area.
Finally, your data is more secure simply due to the fact that it's not stored in text files.

Just like with ordinary subscriptions you should enter the name of the protected directory in the box
labeled: Protected directory. If a directory with this name exists within the path that is set for Password
Robot on the third party tools page, it will be used when a subscription is bought.

http://www.listmailpro.com/
http://www.passwordrobot.com/
http://www.passwordrobot.com/
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The receipt email will contain a link to the URL that you specify yourself for your subscription product in
AShop. You should enter the complete address to the protected part of your site in the box labeled
"Protected URL" when you create/edit your subscription product. If you want it to be the sign-in page
you can simply enter the URL to that page. The box labeled "Protected directory" must contain the
name of your Password Robot group though. If it is incorrect or misspelled the automatic registration
won't work and the username and password can't be used.

To use the Password Robot integration
1. Set up the protected directory in Password Robot
2. Set the path to the cgi-bin directory (not the protected directory itself) where the Password Robot

scripts are stored as the $passwordrobotpath variable in the AShop Shop Parameters > Advanced
Options

Example: /home/httpd/vhosts/yourdomain.com/cgi-bin/subdirectory or /home/httpd/vhosts/
yourdomain.com/cgi-bin

3. Add a subscription in the AShop catalog and enter the name of the protected directory.

2.27.7 phpBB

phpBB is a free bulletin board (forum) program written in PHP using a mySQL database. The program
files can be downloaded from http://www.phpbb.com/.

When phpBB is installed on the same server as AShop and the path to ListMail Pro is set within the 
third party software integration, each product can optionally be associated with a phpBB discussion
group.

A drop down list will appear on the add product and edit product pages where you can set the
discussion group. When someone buys the product, they will automatically be added to the
corresponding group within phpBB. An email with the phpBB username, password and link to phpBB is
sent to the customer.

Note: At least one user group must first be created within phpBB before the drop down user group list
will appear in the AShop Administration Panel for each product.

The full path to the phpBB directory must be set.
Example: /home/username/public_html/phpbb
The full URL to the phpBB directory must be set so the customer receives a link to it in their email.
Example: http://www.yourdomain.com/phpbb   <------ note: no trailing slash

You set these in the Administration Panel, in the Store Configuration, under Shop Parameters, in
Advanced Options.

2.28 Maintenance & Updates

2.28.1 Database Backup

You can backup the contents of your mySQL database.

Access your administration panel and click on the Backup Icon .

http://www.phpbb.com/
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You will be prompted to save the file, set as a default to ashop.sql. You may rename the file, though it
must have the file name extension sql.

To restore the contents of your database from the point when you ran the backup simply call import.php
from your browser.

For example: http://www.yourdomain.com/ashop/admin/import.db

You will be prompted for your database password and the location of the sql file you created when you
ran the backup.

Be sure to click the "Upload and Restore" button.

2.28.2 Updating Software Versions

As of version 4.2.6, software updates and patches are distributed through the admin panel in the
resources page. The technical support and updates must be current and active for the license key and
resources to be visible.

Update Instructions
Updating from one version to the next, it is typically simple.

1. As a safety measure, it is always a good idea to have a recent backup of the AShop directory and
SQL database.

 
2. Upload and replace all of the files from the update folder to their corresponding AShop directory

location.
Note: the admin/config.inc.php, page template files, and logo.gif are NOT included in the UPDATE
folder so you can upload the entire file structure without accidentally replacing the configured files in
your existing installation.

3. Ensure that the admin/config.inc.php file has permissions of 777.

4. Run update.php in a browser.

If no modifications were previously done to payment gateway setup files, language files, or standard
image files then the update is complete at this point. If the setup files have been modified, continue
reading.

http://www.ashopsoftware.com/help/shopping-cart-buttons.htm
http://www.ashopsoftware.com/help/shopping-cart-buttons.htm
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Check for Modified Configuration Files

PAYMENT OPTIONS - CREDIT CARDS ACCEPTED
(If there are not any .gw files in the update package or the original .gw files have not been modified,
skip this step.) For some payment options, the accepted credit cards, such as Visa, MasterCard,
Amex, are set in the gateway setup files, which are located in the admin/directory under a
subdirectory for each currency. For example; admin/gateways, admin/gatewaysuk, gatewayseu,
etc.) If the .gw file(s) for payment method(s) used in the cart have been modified and new .gw files
are included in the update package, then it may be necessary to modify the .gw file(s) again to
remove unaccepted cards.

CUSTOM IMAGE FILES
(If there are not any new button image files in the update package or if the original button images
that came with the program have not been changed, skip this step.) If any language specific image
files in the images directory or within a theme/images directory have been replaced or modified, do
not upload the entire images directory. Instead, check the mod dates for new images and only
upload new button images that have been added to the program. 

LANGUAGE AND RECEIPT TEMPLATE FILES
(If there are not any language or receipt files in the update package or if the original language and
receipt template files that came with the program have not been changed, skip this step.) If the
language or receipt template files have been modified, make the same mods in the new language
files and/or receipt template files.

Updating From Old Versions

If you are updating from a version earlier than 4.0, it is advisable to first ensure that all program
requirements are met by the server where AShop Deluxe is hosted. Versions prior to 3.9.5 used Source
Guardian encoding. Since then, the program is encoded using IonCube.

The update package that are distributed through the admin panel are only available going back a few
versions. If you need a package to update an earlier version, contact us.

3 Manage Products

3.1 Edit Catalog

Catalog pages are dynamically generated by catalogue.php for customers to make selections, and
purchase products. Shopping pages may also be created by including separate components of
catalogue.php within custom HTML or PHP web pages and by inserting Buy buttons in HTML or PHP
web pages using the Order-Link method. In any case, the behavior of the shopping cart when products
are added to the cart will be determined by the Shopping Cart Catalog Mode setting, which is in Store
Configuration > Shop Parameters.

To manage the catalog, open the Administration Panel and click on the Edit Catalog menu link.
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Before adding products to the catalog, set the thumbnail image size in Layout. 
Product images are automatically resized when uploaded through the Files menu. Resizing is done
using ImageMagick or GD software, depending on which software is installed on the server. If the
thumbnail image size is later changed, all of the previously uploaded images must be resized again.

Add at least one category, then add products.

3.2 New Category

Before adding products to AShop, at least one category must be added.

When viewing the shopping cart catalog, if only one category exists, the shopping cart catalog does
NOT display the category selector on the left hand side. If more than one category exists, then the
category selector appears to the left of the product listings. Categories that are empty or contain only
inactive products are not listed.

To add a new category, from the Administration Panel,
click Edit Catalog.

1. Click on the "New Category" button.
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2. Enter the name of the new top-category. Optionally enter a description for the category.

Note: To add a sub-category you must first be viewing the category you want to make a sub-category
for then click the "New Category" button. You must also change the type to Subcategory.

3. Set the language. Leave it set to Any if the category is to open for all language preferences. Only

languages that are installed will be selectable here. If it is set to a specific language, the category
will only appear in the catalog when that language is selected. See: Language Selection

4. Click the "Submit" button to save the new category.

Note: Category levels are limited to three; top-category, sub-category, and sub-sub-category. There is
no limit to the number of top-categories, sub-categories, or sub-sub-categories within the three
levels.

3.3 Edit Category

From the Administration Panel, select Edit Catalog.

1. To edit a category, click on the "edit" link underneath the category name.
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2. Edit the category name and description, then click Submit to save the changes. Note: The

Owner selection box only appears when Digital Mall is activated.
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3.4 Remove Category

From the Administration Panel, select Edit Catalog

1. To remove a category, click on the "remove" link underneath the category name.

Warning! Removing a top-category permanently deletes any sub-categories and products that are stored
in that category!  

Removing a sub-category permanently deletes any sub-categories and products that are stored in that
sub-category. 

2. A warning notice will be displayed before the category is removed. If you are sure about

deleting the category, click "Yes", if not click "No" or the back arrow to cancel the removal.

3.5 Move Category

From the Administration Panel, select Edit Catalog.  
 
The listing order of categories can be changed by moving them up one level at a time and by
moving a category to the top. 
Top level categories can be moved in relation to other top level categories. Sub-categories can be moved
up relative to other sub-categories, but not from one top level category to another. The same is true in
reverse. Top level categories cannot be moved into a sub-category position.

To move a category up in the list one category at a time, click on the Move Up link.
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To move a category to the top of the category list, click on the Move to top link.

3.6 Manage Products

From the Administration Panel, select Edit Catalog.

Products can be all in one category or they can be organized within categories, sub-
categories and sub-sub-categories. Click on the category name to view products in each category.
If there is a sub-category, it will display below the selected category. To view its products, click the
sub-category name. If there is a sub-sub-category, it will then appear below the selected sub-category.
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Use the Search tool to find products. 
When there are more than a few categories it is usually easiest to find products using the Search tool
instead of navigating to it through the categories. The search tool reads the product names and
descriptions.

Search Keywords and Product Codes
When there are only a few products, they are easy to find. As the number of categories and/or
products grows there becomes a need for a system to find products. If there are not too many
products, you might simply identify unique keywords that exist in the product descriptions and search
for those keywords to display specific products. Here are are a few suggestions for getting more out of
the Search tool.

Ways to use search strings in product descriptions
· Include a manufacturers BIN or SKU code.
· Create a simple product code system. It may be preferable to create your own product code and

search system. It can be very simple and still be effective. For instance a book that is fiction and is
by an author with code name Hort and it is his 1st book might have a code "BFHort1". A link to
search.php?searchstring=BFHort1 will display only that product. However, a link to search.php?
searchstring=BFHort will display all of the fiction books by that author, etc. 

· Use Search URLs - The Search tool can be used in site navigation and links to display specific
products. For instance a link to http://www.yoursite/search.php?searchstring=keyword will
display only the products that contain the "keyword" in the name or description field. Use this to
simply link to products when it is convenient or take it to the next level by creating a custom
navigation scheme using keywords and search links. The possiblities are limitless.

· Hide product codes in descriptions using HTML comment tags. <!-- productcode -->
Concerned about customers seeing the product codes? Put the product codes in the descriptions
and enclose the keywords or product codes within HTML comment tags. The comment tags will
keep the code from appearing in the catalog pages, but the search tool will still find the keywords
and product codes even when they are between comment tags.

3.7 Import Products

Products may be imported into each category from a pipe separate list. This bulk import tool is limited to
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the product name, description, retail price, and a thumbnail image. It will reduce the initial shopping cart
setup time if your product list is very long, but you must still set individual attributes, preview files,
multiple product files, shipping methods, etc.

Create a Pipe Separated List

The products are imported from a pipe separated list. Here is an example. This example is also included
in a file named productimportsample.txt, which is provided with the AShop Deluxe new installation
package.

Product Name 1|Product Description 1|10.00|productfile1.pdf|thumbnailfile1.gif
Product Name 2|Product Description 2|15.00|productfile2.pdf|thumbnailfile2.gif
Product Name 3|Product Description 3|5.00|productfile3.pdf|thumbnailfile3.gif

Excel spreadsheets can be saved as a pipe separated list using Excel 2003 and newer.

Upload Images by FTP

All thumbnail images must be preuploaded to the prodimg directory and all product files to products
directory. They will be copied to the filenames described in the product list file. They aren't renamed or
removed in order to allow the same thumbnail or product file to be used for multiple products.

Import the Pipe Separated List

To import a product list, navigate to Edit Catalog. Click the "edit" link below the category where the
products will be imported to. Browse to the pipe separated list text file.

3.8 Add Products

From the Administration Panel, select Edit Catalog.



Manage Products 163

AShop Internet © Copyright 2002 - 2008

See also: Import Products

Before adding the first product to the catalog, set the Thumbnail Image Size in Layout so that resizing
will be consistent for all products and their thumbnail images.

1. Select the category that the product will be added to. If one does not exist, you must first add a new
category.

2. Click on the New Product button at the top of the page.

3. Enter the Name, Price, and Description.

Note: HTML may be used in the Description box to include larger images, links to product detail pages,
etc.

Note: There may be additional settings in the add or edit product page depending on which modules are
installed with the shopping cart. For example, when Digital Mall is activated there will be a setting to
assign ownership of the product to administrator or a member and when eMerchant is installed there
may be a setting for Vendor and product Availability. Not all of the possible settings are shown here.
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Product Options

· Catalog Status - Choose whether you want the product to be displayed in the catalog or not.
Note: In the Edit Catalog menu, you may also click the Active/Inactive icons to change the

catalog status.  or 
· eBay Item Number (optional) - Integrate eBay - PayPal payments and PayPal Buy buttons to the

AShop shopping cart.
· License Agreement (optional) - If the product requires a license agreement, click the License

Agreement button and enter the license agreement text.
· Affiliate Commission Level 1 - Set per product as a percentage of the product price or as a fixed

currency amount.
· Affiliate Commission Level 2 - Set per product as a percentage of the product price or as a fixed

currency amount.
Note: The affiliate commission you set for each product overrides the default affiliate commission
set in the Affiliate Program menu.

· Taxable - Check this box if sales tax is to be added for this product. The taxable state, amount of
tax, selection to tax shipping or not, and order handling fees are set within Administration Panel/
Store Configuration/Shipping and Taxes.

Note: The Shipping information form will not appear during checkout if only downloadable products or
products that do not have shipping set are in the cart, unless the Taxable option is set for the products.
To avoid the shipping form during checkout, uncheck Taxable.

Third Party Software Integration

AShop will optionally integrate with several popular PHP applications such as mailing list, bulletin board,
and password management programs. If the third party application is installed within the same server
account and the path is set within the admin/config.inc.php, a drop-down selection box will appear on
the add product or edit product pages. Select the group that this product is to be associated with. See
Installation of AShop - Third Party Software Integration.

4. Click "Submit" to save the product information and go on to manage product files.

Product File Options

· Product Image - Before uploading product images, the Thumbnail image size and Link to large
original image options should first be set in Layout. To add a product image, navigate to a gif or jpg
image or select from files that have been uploaded to the prodimg folder via FTP. Only one image may
be added for each product through this menu. Images may also be included in the product description
by inserting HTML with links to the images.

· Preview/Demo File - Click the Browse button to navigate to and upload a preview or demo of the
downloadable product. A link to the preview file will appear under the product description in the pages
that are dynamically generated by catalogue.php. The default link text "Download Preview/Demo" may
be edited in the catalogue.inc.php file for each language.

· Product Files (for Downloadable Products) - Browse to the product file. Note: Some hosting services
limit http file uploads to less than 2 MB. If this is the case and the product file is larger than 2 MB, you
may alternatively upload the file via FTP to the "product" folder and then select it from the drop-down
box. Another option is to use the same product file(s) that another product is already using by entering
the product ID number of the orignal product.

· Upload Key Codes - Upload your key code list for downloadable products.
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Note: If you are uploading product files: Depending on the size of the image, preview, product files and
the type of Internet connection, the upload process may take a few minutes or more. Some browsers will
display a progress meter in the status bar at the bottom of the browser.

5. Click the Update/Delete button to upload the files you have selected.

6. Click the Finish button and proceed to the Shipping Calculation Method page.

7. Choose the Shipping Calculation Method you desire and click Submit.
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3.9 Edit Products

From the Administration Panel, select Edit Catalog. Select the category that the product to be edited is
in.

Navigate to the product and click the button for the area that is to be edited. 
The Search tool can be used to find products. Type the product name or a portion of it into the search
field and click the search button, all products matching that product name will appear regardless of
which category they are in. Read more about the Search tool in the Manage Products topic.

· Remove - Removes the product completely and permanently from all categories.
· Edit - The edit menu is where product details such as Name, Price, Description, License Agreement,

Affiliate Commissions, Taxable are managed. See Add Products
· Discount Codes - Manage discount codes and one-time gifts.
· Shipping - Set the shipping method for each product.
· Qty Pricing - calculate price of this product based on quantity of this product OR all products in the

order.
· Files - Upload and manage thumbnail image, preview/demo file, product files, key codes
· Attributes - Set selectable options such as color, style, format. Collect product specific information.
· Fulfilment - Send fulfilment notices. Initiate product delivery. Automate services.
· Flags - Product flags provide a way to easily display standardized text for assigned products. Create

and maintain flags through the Store Configuration > Shop Parameters menu. Then select flags for
each product through Edit Products > Flags.

· Update - Update is a method of sending messages and file downloads selectively to customers who
have purchased a specific product.

· Gift - Send a message with a link and password for a free downloadable product file. A default text
message is written within the message field. This can be edited so that you can use any message
you desire. The default text message also contains two tokens %email% and %password% which
you can use to give the customer the information to login and download their product files.

· Categories - Move or copy a product to a different category. 
· Move Up -  Move a product up within the existing category.

3.10 Remove Products

From the Administration Panel, select Edit Catalog.

Each product may be listed in more than one category. The Remove button removes the product
completely from all categories. If a product is listed in more than one category, to remove it from
only one category while leaving it in the other categories, click on the Categories button
instead and then click on the button labeled Remove From Here (for the category).

1. Select the category that the product to be removed is in.
2. Click on the "Remove" button under the product.
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Warning! Removing a product permanently deletes it from the database.

3. A warning notice will be displayed before the product is removed. If you are sure about deleting the
product, click "Yes", if not click "No" or the back arrow to cancel the removal.

3.11 Move Products

Products can be moved to a different category without deleting and re-entering the product information or
files.

Note: You may also sort products within a category. Either alphabetically, by product ID number, or
reverse their listed order. The order you select will appear that way in the product catalog as well as in
your Admin Panel.

From the Administration Panel, select Edit Catalog.

Move a product to another category

1. Select the category that the product is currently in.

2. Click the Categories button under the product.

Categories will be displayed with a Move here button beneath them.
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To display sub-categories, click on the top-category name. Sub-categories will be displayed under their
top-category with a bullet in front of them.

3. Click the "Move here" button beneath the category that you wish to move the product to. The
product will then be displayed within the new category.

Note: You can copy the product to another category while keeping the product in its existing category
as well. Just click on the "Copy here" button instead of the "Move here" button.

Remove a product from a category.

If a product is listed in more than one category, to remove it from only one category while leaving it in the
other categories, click on the Categories button and then click on the button labeled Remove From Here
(for the category).

Move a product up within a category

1. Select the category that the product is in.

2. Click the Move Up button beneath the product.
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The product will move up one place within the selected category.

3.12 Discount Coupon Codes

There are two ways that discounts can be created and redeemed in the shopping cart.

Per Order Discounts
An unlimited number of per order discounts may be created. Create per order discounts in Edit Catalog.
Click on the Discounts button on the top right side.

1. Enter the discount code
2. Enter the amount or percentage of the discount. Percent discounts are applied to each order

subtotal (before shipping and taxes).
3. (Optional) Enter a valid affiliateid number to credit an affiliate when this discount is redeemed.
4. Click Add to add the new discount.

Per Product Discounts

Per product discount codes are created each product in Edit Catalog. Per product discounts may be
entered by customers when selecting each product or per product discounts may be automatically
applied when customers enter a manual referral code.
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Create a Discount Code For Each Product

1. Navigate to the category where the product discount is to be added or edited.

2. Click on the Discount button under the product.

3. Enter a discount code up to 50 characters.

4. Enter the discount amount and check if it is percentage of the product price or an amount.

5. Click the Add button to save the discount. To remove a discount, simply click the Remove button.

When a discount code exists for a product, a discount box will appear in the shopping cart catalog next
to the product. When the correct code is entered and the product is added to the cart, the discount is
subtracted from the product amount before taxes and shipping.

Create a One-Time Discount

AShop Deluxe will let you allow specified customers to be able to get a discount good for only one
purchase? Here's how...
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When you add or edit a discount you will notice a check box under the discount amount labeled "One
time discount"
Check the box and click the "Add" button. 

Now you must enter the email addresses that the one-time discount will be good for.

You can add one email address at a time. Enter the email address and click the Add button.
You may also upload a whole list of email addresses. Browse to the text file and click the Upload
button.

*The uploaded list must be in plain text format separated by line breaks. For example...
test@testemail.com
joe@customer.biz
customer@business.com

As you add and/or upload email address they will appear below the Import email list form field. 

When a customer uses their discount the text under the "Used" column next to their email address will
change from No to Yes and they will not be able to receive the discount again. You may delete a
customer's email address from the list at any time by clicking on the trash can icon.

Create a Gift Certificate
If you have a customer who you would like to send a gift certificate to, you can do so using the one-time
discount feature: 
1. Add a product with a price of $0.00 (no taxes or shipping).
2. Click the "Discount" button for that product and add a one-time discount for that customer (or

customers) as described above.

That's all there is to it. The customer(s) will enter their email address and discount code into the fields
provided in the product catalog. Doing so will add a product of to their cart that has a negative dollar
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value which will be calculated into the total.
Also see the Gift Certificate Tech Tip.

3.13 Quantity Based Pricing

Incremental Quantity Based Pricing sets the price of one product based upon either the total quantity of
that product OR the total quantity of all products in the basket. Instead of applying one price based upon
the quantity total, a different price will be applied to each quantity range.

To set pricing levels based on the amount of products purchased, click Edit Catalog, navigate to the
product you wish to add quantity based pricing to, and click on the Qty Pricing button. (You may also
set this when you first Add Products). 

1. Add a pricing description, which will appear as the Price in the catalog instead of the regular price
for that product.

2. Select whether the pricing will calculate based on the total quantity of this product only OR if the
total quantity of all products will affect the pricing of this product.

3. Click the Update button.

* Note that the initial price is already set into the first pricing level. Add this one first before adding
additional pricing levels.

4. Add additional pricing levels. Click the Add button each time a new pricing level is inserted.

In this example, prices (set specifically for the quantity of this product only) are $4.00 per item. When 3 -
5 more are purchased they are $3.00 each additionally. When 6 or more additional are purchased they
are priced at $2.00 each on top of the $4 for the initial 2 items and $3 each for the 3-5 more items.

http://www.ashopsoftware.com/techtips/gift-certificate.htm


Manage Products 173

AShop Internet © Copyright 2002 - 2008

You may delete a pricing level by simply clicking the Delete button.

When changing the pricing level be sure to click the Update button.

You will notice when in the Edit Catalog menu that the price for a product with Quantity Based Pricing
will now say "Qty Based". 

In the actual product catalog the price will show the Pricing Description that you entered in Step 1.
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3.14 eBay Item ID

When products are listed in an eBay store and have only the PayPal payment option set for the eBay
listing, payment for the eBay item can be linked to AShop. This feature may also be used with PayPal
Buy buttons, which are created through your PayPal login.

eBay Orders Paid Through AShop Deluxe
To use this feature, you need to have a premier or business PayPal account. No other payment
gateways will work. The default Instant Payment Notification (IPN) URL in the preferences for your
PayPal account (at paypal.com, not in your AShop) must be set to the URL where your ebay.php script
is located (where AShop is installed).

For instance: http://www.yourdomain.com/ashop/ebay.php. The eBay id will only be shown in the receipt
and the admin notice emails when an item has actually been purchased through eBay.

When the customer pays for the item using PayPal, the order is recorded in the AShop database, a
receipt is emailed to the customer and an order notice is emailed to the AShop administrator. If the
product is downloadable, a password and link to download the file is included in the customer's receipt.
If key codes are set for the product, a key code will be included in the customer's receipt. If the product
is a subscription type, a password and link to the subscription directory is included in the customer's
receipt.

eBay > PayPal > AShop Setup
1. Setup your PayPal account to send default IPN requests to your ashop/ebay.php script.  

· Login to your verified PayPal account administration panel at http://www.paypal.com.  
· Click "Profile".  
· Click "Instant Payment Notification Preferences".  
· Set IPN to On.  
· Set the IPN URL to the location of your ebay.php script.  
· For instance: http://www.yourdomain.com/ashop/ebay.php.

2. Add the product to your eBay store and set the payment options to only PayPal.

3. Enter the eBay Item Number in the product settings in Add Products or Edit Products.

http://www.paypal.com/
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The ebay.php works like order.php but uses the eBay Item Number instead of the productid to identify
which product has been purchased.

Note: The affiliate tracking will not work for products sold on eBay. 

AShop Admin Order Notice Format

This is the order notice format that will be used in the current version of the ebay.php script:
--------------------------------------------------------------------------------------------------------------
The following transaction took place 2004-02-01 07:07:09 from: 65.230.38.65
Customer: 51 Customer Name
Email: customer@domain.com
Address: 123 5th Ave., 35212-3704, Birmingham, AL, United States
Phone: 123-456-7890
Products: 1: eBay item: 5555555 Product Name
Amount: 25.00
Payment option: eBay+PayPal
Send the products to:
Customer Name
123 5th Ave.
Birmingham, AL 35212
United States
--------------------------------------------------------------------------------------------------------------

The eBay item number can be found before the product name.

Using the eBay Item Number With PayPal Buy Buttons

The eBay Item Number functionality may be used with PayPal Buy buttons that are not part of an eBay
store.

1. Set the eBay item number to the same as the product ID in Edit Catalog > Edit (for the product).
2. The IPN URL setting in the PayPal account must be set to where the ebay.php is located unless

you make an unencrypted "Buy Now" button, which will let you add the IPN URL as a hidden field
named: notify_url. For example: <input type="hidden" name="notify_url" value="http://www.
yourdomain.com/ashop/ebay.php">

3. When you create the button in the PayPal account, enter the product ID into the optional item
number/id box.

 
The ebay.php script doesn't currently support fulfilment and there might be other newer features that is
missing. It will handle downloadable products, third party software integration (ListMail, ListMessenger
etc) and all the basic functionality from the AShop order processing script.

3.15 Product License Agreements

License agreements may be added for each product. When a license agreement is set for a product,
customers must agree to it before being allowed to purchase the product.
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When customers add a product to the cart that has a license agreement set, an "I Agree" check box will
display in the confirmation window with a link to the license agreement.

The "terms of the sale" link opens the license agreement window.

License agreements are added in Add Products or Edit Products.

Navigate to the product you want to add a license agreement to and click the "Edit" button.

Click the "Add license agreement" button and enter your license agreement information.

Click the "Submit" button to save your changes.

Note: The license agreement can contain HTML formatting and links.



Manage Products 177

AShop Internet © Copyright 2002 - 2008

Tip: If you upload a text document named agreement.txt, into the directory you have AShop installed at,
a license agreement page will appear when the customer clicks the Check Out button. The customer
must click the Accept button to proceed with the order. The agreement.txt file is included with the
AShop program files, but is named agreementEXAMPLE.txt. You must rename it to agreement.txt for
this functionality to work. You can use HTML code in the text file.

3.16 AShop Secure Download

AShop Secure Download™
Protects Downloadable Products Against Unauthorized Downloads in Three Ways:

Payment Verification
An unique, encrypted code is generated for each order and stored in the database. The payment
gateway must return the order code with a successful payment response for AShop to complete the
order and send a password. Attempts to access the order response script without a valid transaction
code results in an error page.

Password Protection
After payment has been processed, a random password is automatically generated and e-mailed to the
customer. This verifies the customer's e-mail address and is required to access the download area. The
password will automatically expire in a number of days, which is set by the administrator. A limit to the
number of downloads may also be set.

Product File Renaming
When adding a digital product to the shopping cart, the file name is stored in a secure database. The
actual data is renamed and saved under a different file name in a protected folder on the server. When
delivery of the product file is authorized, AShop displays the original product file name to the customer,
but the original file (that was renamed) is actually downloaded. The name and location of the product on
the server is never available to the public and is only accessible through the AShop program.

3.17 Downloadable Products

Downloadable products can be software, music, pictures, text, pdf files, or just about any kind of file or
folder. If the product consists of many files and/or folders, zip them into one compressed folder for
distribution.

See also: Add Products

Downloadable product files are protected from piracy and unauthorized linking by AShop Secure
Download.

Each product can have a product file and/or key code delivery. Digital product delivery is not supported
with subscriptions (password protected membership directories).
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To add a file download for a product.

1. Click on Edit Catalog.

2. Navigate to the product category and either add a new product or click the "Files" button to add a
file to an existing product.

3. Click the Browse button next to Product Files and navigate to the file on your local machine.

4. Highlight the product file and click Open.
You may upload more than one downloadable file per product, but only one at a time.

5. Click the "Upload/Delete" button each time you wish to add or delete a downloadable file.

6. When done uploading files click the "Finish" button.

When a product file is present, a download icon will appear next to the product in the Edit Catalog page
and "Direct Download!" will appear in the catalog that customers see along with the file type and size.

Uploading Product Files That Are Larger Than The http_upload Limit  
The PHP configuration file limits HTTP file uploads to 2 MB on most hosting services. To check the
http_upload file size limit that is set on your server, upload and run phpinfo.php.

To upload product files larger than the limit set by your servers PHP configuration:

1. Upload the product file to the ashop/products folder via FTP or using your hosting service's file
management program.

2. AShop checks to see if there are any product files that have not already been recorded into the
database and will display a drop-down selection box within the Add Product or Edit Product window
where the file can be selected.
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4. Choose a file from the previously uploaded file selection box.

5. Click the "Upload/Delete" button, AShop will rename the product file and record the original filename
into the database.

6. When finished adding product files click the "Finish" button.

Update Notification & Delivery

The update feature emails a notice to each customer who has purchased a specific product. If a file is
uploaded, the update notice includes a link and password to download the file. If a file is not uploaded,
only the message text or html is sent.

 
For each product there is a button labeled "Update" on the edit product page.

Click that button to see a form where you can select an update file, choose the time period the customer
should have bought the product to receive the update, choose how many days the download will be
available, and add the subject and message text for the email notice to customers.

When sending an update file, you must browse to and select the file from your computer. This file will be
sent to the customers who purchased the product you are sending an update for.
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The update notification can be sent in both Plain text or Html formats.

When the form is submitted, the file is uploaded to the updates directory and the message with a
password and download link is sent to all customers who should receive the update.

When customers download the file, a notice is emailed to the shop administrator with the customers
name and IP address.

3.18 Free Downloads/Products

Send a Free Downloadable Gift

It is possible to send a customer a free gift if the product contains a downloadable product file.
Downloadable products will contain an extra button under them in Edit Products labeled Gift.

1. Click the Gift button to open a menu where you will enter the customer's Name, Email Address,
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Subject, and an HTML or Text format message.

Note: Use tags such as %email% in the message to send the customer's email address and %
password% for the login password.

2. Click the Send Gift button to send the customer their free downloadable gift.

Free Products

When the total of all the products in a customer's shopping cart equals zero dollars, whether the
products have a price of $0.00 or they used their Gift Certificate to purchase products, the local payment
form will automatically be used. Order processing will be done using a built in payment option that uses
manual.gw. All orders with only free products will be treated exactly like paid orders and the customers'
billing info will be stored in the database.

This feature can be used as a sign up form for free membership resources because it collects customer
information, creates and sends subscription directory password, and enters the customer into the
AShop mailing list. It can also be used to get customer information before giving a free download or key
code.

3.19 What Are Subscription Directories?

Subscriptions within AShop Deluxe are a method to sell access to password protected directories.

When a subscription product is purchased, a receipt is emailed to the customer, which includes a link
and password for access to the protected directory.

The initial subscription length is set within AShop for each subscription directory. Expired passwords
can be removed manually by running a script or the process can be automated by running a Cron job on
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the server.

AShop Deluxe integrates to Password Administrator+ and Password Robot, third party software, for
ongoing password management.

3.20 Subscription Products

ASubscribe provides a method to sell password-protected access to specific folders (directories).  

The first few instructions are for creating subscription directories without Password Robot. If you are
using Password Robot, follow the Password Robot instructions to create protected directories, then see 
integrate AShop Deluxe with Password Robot, and then create a subscription within the product catalog.

To add a subscription without Password Robot, you must first create a subdirectory to

hold the protected content. The directory must be below AShop on the server directory tree and it must
be protected using a .htaccess and .htpasswd file inside the protected directory.

1. Create a directory below AShop on the server directory tree so that the protected folder is at the
same directory as catalogue.php. Name it whatever you want to.

a. Change permissions for this directory to 777.

2. Create a blank text file and save it as ".htpasswd".

a. Upload it to the top level of the subscription directory.

b. Change permissions for this file to 777.

Note: AShop will write the e-mail address and encrypted passwords to the .htpasswd file for authorized
access to this directory.

Note: Depending on your FTP client software and server settings, the .ht files may not appear in the FTP
browser on the server side. In this case, to view or edit the file use your web host's file utility program.
OR Rename the files without the leading dot and upload them, change the permissions to 777, then
rename them with the dot in front.

3. Create a text file, and insert the following text:

AuthUserFILE /usr/home/username/ashop/protected/.htpasswd
AuthGroupFILE /dev/null
AuthNAME "Text that is shown in the login dialog box"
AuthTYPE Basic
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AuthAuthoritative On  

require valid-user  
<limit GET POST PUT>  
order 'allow,deny'  
allow from all  
</limit>

a. Set the AuthUserFILE to the protected directory path and change the AuthNAME to the text
that will display on the login page.

Hint: View the Secure File System Path in the Admin Panel under Shop Parameters then Advanced
Options and add the protected directory name then the file name ".htpasswd".
Example: /home/httpd/vhosts/username/httpdocs/ashop/protected/.htpasswd

b. Save the file as ".htaccess".

c. Upload it to the top level of the protected directory.

d. Change permissions for this file to 777.

Create A Subscription In The Product Catalog

1. From within the Administration Panel/Edit Catalog, select an existing or create a new category
where the subscription product is to appear within the store catalog.

2. Select New Subscription.

3. Enter the product name, status, price, and description. If the status box is unchecked, the product
will not appear in the shopping cart catalog. HTML may be used in the description box to include
larger images or link to product detail pages.

4. Enter the name of the protected directory.

5. Enter the URL to the protected directory. If this setting is available it is always used to create the
link to the protected directory in the customer receipt.

6. Enter the length in days until each password expires. Set this to 0 (zero) for no expiration.
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Other Options
· License Agreement - If the product requires a license agreement, click the License Agreement

button and enter the license agreement text.
· Affiliate Commission Level - Set the default Affiliate Commission as a percentage of the product

price or as a fixed currency amount.
· Taxable - Select whether the product is taxable or not.

Third Party Software Integration
AShop will optionally integrate with several popular PHP applications such as mailing list, bulletin
board, and password management programs. If the third party application is installed within the
same server account and the path is set within the admin/config.inc.php, a drop-down selection box
will appear on the add product or edit product pages. Select the group that this product is to be
associated with.
See Installation of AShop - Third Party Software Integration.

7. Click the Submit button to save the product information.

Customers May Recover Forgotten Passwords
If a customer, who has purchased a subscription product, cannot remember their password, they can
retrieve it. If they call sendsubscrpass.php from their browser they will be prompted for the directory that
they have subscription access to and their email address. An email will be sent to your customer with
their password.

example: http://www.yourdomain.com/ashop/sendsubscrpass.php
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Deactivating Expired Subscriptions (without Password Robot)
1. The checksubscr.php script deactivates expired subscriptions. You can run this script manually

through a browser or setup a Cron job in the server control panel to run this script on a regular
basis. Your hosting company must provide a method to create Cron jobs or you must have root
access to the server to set up a Cron job. More Info...

2. Change the $ashoppath at the top of the checksubscr.php script to the correct path to AShop
Deluxe if the script is placed outside of the AShop root, for instance outside the document root to
avoid making it publicly accessible.

3. Change permissions to chmod 755.

The subscription product will be labeled "Instant Access" in the store catalog product listing.

Links to the purchased subscription directories, user names, and passwords will be included in the e-
mailed store receipts that are sent to customers.

Discount Coupon Codes may be created for subscription products.

3.21 Key Codes

Key-codes are typically used to unlock trial software, activate phone cards, distribute passwords, or to
send unique information with the purchase of a product. When a product that has key codes is
purchased, a key code is sent to the customer by email. Key codes can be distributed with any product
in the AShop catalog except subscriptions.

Note: Key-codes can be distributed in the original key-code text file list order or in random order. This
order of distribution is set within Store Configuration > Shop Parameters.

To set a product to distribute key-codes:
Within Add Products or Edit Products, click on the Files button, then click on the browse button next to
the Unlock Keys File box and upload a keycode.txt file.

Note: This file must be a text file where each line contains exactly the text that is to be sent to each
customer who purchases the product. This information will be stored in a database table called
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unlockkeys.

A key code product will display Direct Email Delivery! next to the product name in the store catalog and

will display a  icon next to it within Edit Catalog. If the product has downloadable files associated with
it, as well as the Key Codes, it will NOT display Direct Email Delivery! next to the product name in the
store catalog.

When a customer buys a key-code product an unused key-code is selected from the database and
included in the customer's receipt. If manual payment processing is used, an "activate order" link will be
included in the administrator's order notice. Upon receipt of payment, the administrator may then click
the link to complete the order and send the key code to the customer. 

The number of remaining key codes is listed in Edit Catalog next to each product that has key codes.

The icon is a link. Click on the icon to view the list of used and available key codes.

Each time a key code is ordered, AShop checks how many unused keys are left in the database. When
there are less than 4 keys left a warning message is sent telling the shop administrator to upload new
keys to the database. If there was no keys available at all the warning message tells the shop
administrator to send one manually to the customer and includes a link to the customers email address.

The key codes may be distributed in random order or in the original text file list order. Select random or
list order in Shop Parameters.

How To Delete Key Codes
When a list of unlock keys is uploaded for a product through the Files menu in the AShop admin panel,
the keys are saved in the database table named "unlockkeys". Each key in the table has a separate
record, which can be deleted or edited. You may use a tool such as phpMyAdmin or DatabaseAdmin to
browse or search the database table to find the key and edit or remove it. The database managment
tools are typically available through your domain hosting administration panel. Example: In the Plesk
server admin panel, click on the domain name, Databases, the name of the database, and then
DatabaseAdmin.

3.22 Shipping and Sales Tax

Tangible products are physical as opposed to intellectual property. Tangible products typically require
shipping and/or sales tax amounts to be calculated and added to each order. (Products that are set to
add shipping, handling, and sales tax can ALSO deliver downloadable products and mail out key codes.)
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There are two places in the shopping cart administration where shipping calculations are managed. 

1. The main Shipping Method and Storewide settings are managed through Store Configuration >
Shipping.

2. Settings that apply to each product individually are managed through Edit Catalog > Shipping (for
each product).
(Storewide and per product shipping calculations can be mixed in each order.)

Local and international handling charges (per order) are set in Shipping.

Sales tax regions and rates are set up in Store Configuration > Taxes.

3.23 Shipping Settings For Each Product

In the Admin Panel, Edit Catalog. Each shippable product has a button under it labeled "Shipping"

To set the shipping charge calculation method, click on the drop-down box labeled Shipping Option.
Each product can use a different shipping option. An unlimited number of products with different shipping
options can be mixed in each order. Each shipping option calculates independently in the background
and then they are added together for the total shipping charges.

Shipping Options:
Note that shipping setting options for each product will be different depending on the main Shipping
Method that is set in Store Configuration > Shipping. 
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None - Shipping is not added for this product. If all of the products in an order have None set for
shipping, the shipping information form does not appear for the customer during checkout and handling
charges (if set in Shipping and Taxes) are not added. If any of the products in the order require shipping
calculation, then the shipping information page appears and must be completed before checkout.

Flat rate – A fixed dollar amount for each of this product that is ordered will be added to the shopping
cart. 

1. Select Flat rate from the Select option drop-down box. A Shipping box will appear.
2. Enter the flat rate shipping amount into the box.
3. Click the Submit button.

UPS – This shipping option uses the United Parcel Service Online Tools to calculate U.S. and Canada
Ground rates in real time based upon the shipping weight and origin of each package for each product
and the destination zip code of each order. There is no limit to the number of packages that can be
calculated for each product and each package may have a different origin zip code. The shipping amount
is calculated individually for each package and added to the total shipping for each product in the
shopping cart based upon the ship to destination for each order.
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1. Select UPS from the Select option Drop-down box. A shipping origin and weight per package form
will appear.

2. Enter the zip code of the shipping origin and the weight of the first package.
3. If the product ships in more than one package, click Add package. A new row will appear.
4. Enter the origin zip code and shipping weight for each package and repeat the process as needed.
5. Click the Submit button when finished.

FedEx – This shipping option uses the FedEx Quick Ship online calculator to calculate U.S. Ground
rates in real time based upon the shipping weight and origin of each package for each product and the
destination zip code of each order. There is no limit to the number of packages that can be calculated for
each product and each package may have a different origin zip code. The shipping amount is calculated
individually for each package and added to the total shipping for each product in the shopping cart based
upon the ship to destination for each order.

1. Select FedEx from the Select option Drop-down box. A shipping origin and weight per package
form will appear.
2. Enter the zip code of the shipping origin and the weight of the first package.
3. If the product ships in more than one package, click Add package. A new row will appear.
4. Enter the origin zip code and shipping weight for each package and repeat the process as
needed.
5. Click the Submit button when finished.

Watkins ML – AutoRate (Watkins ML) shipping calculation method is used for large and heavy items
such as furniture that are shipped by common carrier. You don't need to have any kind of membership
with Watkins ML to use the calculation. You only need to specify the options on the edit shipping page.
The freight class must be entered. The National Motor Freight Classification (NMFC) tariff is a publication
for motor carriers containing classes, rules, descriptions and ratings of all commodities moving in
commerce. There are 18 classes ranging between 50 and 500. Most manufacturers and professional
transportation managers are participating members of the NMFC, or are familiar with their products'

http://www.watkins.com
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classifications. If you are not sure of the correct classification for your freight, contact a Watkins
Customer Service Representative at (800) 274-9099 or the National Motor Freight Traffic Association at
(703) 838-1810." The classes must be exactly right or there will be an incorrect zip code error when
submitting the shipping destination.

1. Select Watkins ML from the Select option Drop-down box. A shipping origin, class, and weight per
package form will appear.

2. Enter the zip code of the shipping origin, class, and the weight of the first package.
3. If the product ships in more than one package, click Add package. A new row will appear.
4. Enter the origin zip code, class, and shipping weight for each package and repeat the process as

needed.
5. Click Submit when finished.

Zip Zone Rate Tables – Zip zone rate tables work much like UPS and FedEx tools, but you can define
your own zip code zones and set custom zone rates for each product. See help topic: Zip Zone Shipping
Rates
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Quantity Based Shipping can be set for each product. In this example, if quantity 1 to 4 of this product
is ordered, shipping will be the quantity of this product times $4.52. If quantity 5 to 9 of this product is
ordered, the shipping will be the quantity of this product times $2.50. If quantity 10 to 14 of this product
is ordered, the shipping for this product will be the quantity times $0.50. When a customer orders 15 or
more of this product, the shipping for this product is zero. See help topic: Quantity Based Shipping

Storewide Shipping looks up or calculates the shipping based on the total weight of (Storewide)
products in each order. Storewide shipping can lookup from UPS or FedEx. A package is added each
time the total weight exceeds the maximum weight per box so that the correct number of boxes and
weight per box is looked up. The flat rate per pound option can have a base charge to cover the cost of
packaging the total flat rate times the total weight of (Storewide) products. See help topic: Storewide
Shipping
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3.24 Quantity Based Shipping

NOTE! The shipping options for each product are dependent on the main Shipping Method setting in 
Store Configuration > Shipping. To use custom shipping methods, the main Shipping Method must be
set to "Custom".

To set quantity based shipping for each product, click Edit Catalog, navigate to the category where the
product is located, and click on the Shipping button. (The shipping options also appear after new
products are added.)

1. Select "Quantity" from the Shipping Calculation Method drop-down selection box.

2. Enter the amount of shipping that is to be charged for quantity 1 or more and click the Update
button. This amount will be multiplied times the quantity of products in the basket until the quantity
of this product is greater than the next quantity level. (in the next step)

3. After the form is updated, a second row will appear. Enter the quantity to begin and set the shipping
amount to charge, then click Add Row.

The quantity row will be saved and yet another blank row will appear.
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In this example so far, $1.15 will be multiplied times the quantity of this product for quantities less than
5. For quantities 5 or greater, $0.75 will be multiplied times the quantity for this product and added to the
shipping charges.

4. If there are no more quantity shipping charge levels to add, you are finished and may exit by
clicking on any of the Administration Panel navigation links or by closing the browser. To add
another quantity shipping level, enter the next quantity level and shipping amount, then click Add
Row. Repeat as needed for the number of levels desired and click Add Row to save each one.

3.25 Zip Zone Shipping Rates

Zip zone rate tables provide a method to set 7 shipping zone rates for each product. The zone is looked
up from a custom zip code table that is created for each shipping origin.

If products that have zip zone shipping are in the cart, a shipping information form appears when
checking out. The first three digits of the zip code are used to lookup the zone and the shipping rate that
is set for that zone (for that product) is added to the order.

The zip zone method is essentially what UPS or FedEx Ground uses with their online rate calculation
tools. One advantage of custom zip zone lookup tables is that you don't have to register and link to UPS
or FedEx online tools or rely on a connection to them. Another is that you can calculate similar to
FedEx or UPS, but adjust your zone rates to market products differently in various areas of the country.
For instance, you may want to charge less than FedEx in zone 8 and more in zone 2 to adjust extreme
shipping amounts or to match a competitor's delivered price.

How To Set Up Zip Zone Shipping
First, you set up a custom zip code lookup table. This can be done through Shipping and Taxes or in
Edit Products. 

1. Click on the Manage Zip Zones link to open the Zip Zone Tables management.
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2. Add a new Zip Zone Table and click Submit. You may want to name it in relation to the origin of the
shipment or vendor.

3. Click Add New Zip.

4. Enter the first three digits of the zip code, select a zone, and click the Add Zip Zone button.

5. Repeat steps 3 and 4 until you have the desired amount of zip zones covered.

The Zip Zone tables consist of two columns and as many rows as you need. The left hand column is the
first three digits of the zip code. The right hand column is the zone that will be looked up when a zip
code starting with the corresponding first three digits is processed for an order shipment address. It is
not necessary to put every zip code in. only the points where there is a change in the zone. For
instance, in the above example, zips starting with 000 up to 349 lookup zone 8. Zips starting with 350 up
to 358 lookup zone 7. Then zips 359 up to 364 lookup zone 6 and so on.

After a Zip Zone table is setup, it may be selected as a shipping method for each product and an amount
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can be set for each zone. The customer's zip code is used to lookup the zone, then the zone is used to
lookup the rate that is set for the selected products when shipped to that zone. Be sure to click the
Submit button after you have set shipping prices for each Zip Zone.

3.26 Product Attributes

Product attributes provide a method to specify specific versions or variations of each product when
adding the product to the shopping cart. The selected attributes are sent in the receipts and order
notices and are also recorded in the sales history. An unlimited number of product attributes can be set
for each product.
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Each product attribute alternative can be optionally set to override downloads, shipping charges, and/or
sales tax. This is useful where one product might be delivered in various formats. An example of where
this might be used is where music titles are available for the same price in several different formats. No
shipping or tax would be charged for the MP3 file download in the U.S., but it might be taxed in the UK.
CD or mini-disks would have shipping costs and might be taxable, depending on the local tax laws.

Add Product Attributes
To create or edit product attributes, click Edit Catalog, select the category, and click the Attributes
button next to the product.

To add a new attribute, enter the Caption, the number of Alternatives and click the Add Attribute button.
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Note: Comment Field Attributes...
If the number of alternatives is set to 0 and the Add Attribute button is clicked, the attribute will be added
as a Comment Field.

Enter the parameters for each alternative.

Attribute alternatives can have a different price set for each alternative. Check the "Activate separate
buy buttons and/or prices" box to allow each alternative to have a separate price and separate buy
buttons for each in the catalog.

Check the "Activate separate shipping options" box to have the option of setting each attribute have no
shipping and/or no sales tax.

To delete an alternative simply click the "Delete" button. When finished editing the alternatives click the
"Save" button.

Note: Only one set of alternatives for each attribute can have prices. When prices are set in the
alternatives, separate buy buttons and prices appear in the catalog. The attribute prices and separate
buy buttons will work with shopping cart turned On or Off. A gif image may be displayed in the catalog in
place of each alternative by naming it the same as the alternative, but in all lower case and uploading it
to the images directory. For instance, if the alternative is named "CD", the image file name should be cd.
gif.
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Edit Existing Attributes
To edit or remove existing attributes, click the Attributes button in the Edit Catalog menu. Existing
attributes will appear with Update, Remove, and Alternatives buttons next to them.

To change the caption, edit the text and click Update. To exit without changes click the back button or
another menu selection.

To edit alternatives, click the Alternatives button. Edit or delete the alternatives as needed, then click the
Save button.

Attributes for Downloadable Products

When you have a downloadable product there is an extra check box labeled "Activate separate download
options"
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If you upload multiple files for a product. You can have each alternative point to one, none, or all (default)
of those files.

Let's say you have a product that can be shippable or downloadable.
With this feature you may use one alternative as the shippable product and the others as specific
downloadable file types.

Deactivate shipping and taxes on the downloadable products.

Change prices accordingly.

Don't forget to click the Save button when you have finished editing the attribute.

Pass productid to third party script using an attribute
The product ID is not included by the automation fulfilment feature but there is a way to include this or
any other product specific information you want to send. An attribute with 1 alternative to the product you
wish to use the automation for. You can for example call this attribute "Product ID". Set the single
alternative to the product ID for your product or to any other identifier you wish to use. Click the
Fulfilment button for the product on the Edit Catalog page and select the fulfilment option you are using.
Enter a field name for the attribute, for example "productid" or any variable name your receiving cgi script
is using. Now your fulfilment option will send this information to the cgi script after a purchase and since
the number of alternatives is just 1 your customers will not see the attribute.

3.27 Product Comment Fields

Comment fields that are editable by customers are created in Edit Products > Attributes for each
product. When a product has a comment field attribute, customers can enter text for each product. The
text will be saved for each product and will appear in the receipt and order notice. This feature might be
useful where a custom inscription or specific instructions are required for each product ordered.
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Examples:  or 

3.28 Product Buy Buttons

In addition to the automatically generated catalogue.php pages, product buy buttons, view cart and
checkout links may be manually added to  HTML and PHP pages using snippets of HTML and/or PHP
code. Here are some examples.

Order-Link is a simple way to add buy buttons in local or remote web pages. Order-link may also be
used in newsletters, forums and blogs.

Multiple Product Buy - More than one product may be added to the cart at one time from a form post.

Separate Category Tree and Product Listing Includes - Components of the catalog page may be
included separately within PHP files and where PHP is enabled in HTML files.

3.29 Make HTML

The Make HTML button under each product listing in Edit Catalog will create static HTML web pages
and save them on the server. This a new feature and it is still being developed. It does not create a table
of contents or insert links from the product listings in the catalog to the static HTML pages.
Improvements to this area are scheduled for mid 2008.

The Make HTML tool will use a page template, get product information and images, and create a new
HTML page from the page template and product data. Buy buttons can be automatically generated in
each product page. Everything works, but this feature is still rough.  Use it if you want to, but don't
expect too much until it is developed more. We invite your suggestions in this area.

1. Design a page template and save it to the admin/htmltemplates directory. An example is

included with the new installation files.

2. Insert tokens in the page template where product data and buttons are to appear. See

example template.html.

http://www.ashopsoftware.com/contact
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3. Create a product page using the Make HTML button. Save it to a subdirectory. Pages

made this way cannot typically be saved to the public root directory because the permissions do not
allow it.

4 Customers & Sales

4.1 Manage Sales

From the Administration Panel main menu, select Manage Sales. There are two main sections:

Customers and Messaging
View/Edit/Delete Customer Profile
View Individual Customer Purchases
Mail To Individual, Selected, Or All Customers

Sales Reports
Generate Sales Reports For Date Ranges
Order Reports By Date, Price, or Customer
Download Reports In Comma Delimited Files For Viewing Off-line

4.2 Customers and Messaging

From the Administration Panel main menu, select Manage Sales. A top menu bar appears and the
Customers and Messaging page opens with customers listed.
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e-Mail Messaging to Customers

To e-mail a message to one customer
Click on the e-mail link for the selected customer. This will open your default e-mail program, such as
Outlook Express or Eudora.

To e-mail a message to selected customers
1. Place a check mark in the box next to each customer that you wish to send a message to.
2. Enter the Subject and Message text into the corresponding text boxes.
3. Click the "Mail to selected" button to send the message to selected customers.

To e-mail a message to all of the customers
1. Enter the Subject and Message text into the corresponding text boxes.
2. Click the "Mail to all" button to send the message to all customers.

HTML-format or Plain Text
You may select emails to be sent in either HTML or Plain Text format.

HTML-format
With HTML-format selected, formatting tags, tables and hyperlinks may be typed or pasted into the
message box. With this setting, a page may be designed within your favorite WYSIWYG HTML
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editor. You can then copy the HTML code and paste it into the message box to send newsletters,
advertisements, and other notices to customers or affiliates.

Note: With this setting, carriage returns within the message box do not generate line breaks and
must always be inserted with <br> or <p> tags or the text will all flow together in the resulting e-
mail message.

Plain text
The Plain text setting does not recognize HTML tags and will render tag text in the e-mail message
just as you enter it into the message box. With this setting, carriage returns in the message box
generate a line break in the resulting e-mail message as they do in your client e-mail software such
as Eudora or Microsoft Outlook.

Delete Customer Record
Warning: This will permanently delete the customer record; there is not an undo.

1. Click the Delete icon, , next to the customer to that is to be deleted.
2. A warning message page will appear to confirm your intention.
3. Click Yes to delete the customer record or No to cancel and return to the Customers and
Messaging page.

View/Edit Customer Profile

To view or edit a customer's billing and shipping information, click the Profile icon, , or the customer
ID number link next the customers listing.

Sales History By Customer

Customer sales history can be viewed by clicking on the Sales icon, , next to each customer.

4.3 Customer Profile

Customer contact information can be accessed by clicking the Profile icon, , or ID number link next to
the customer listings.

To view or edit a customer's profile:
1. Click on the Profile icon or ID number link next to the customer that you wish to view or edit.
2. The selected customer's profile data will appear with their name and contact information displayed

within text boxes.
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3. To view the customer's profile data without editing it, simply click another menu option or page back
when finished viewing.

4. To edit the customer's data, type or paste the new information into the appropriate text boxes and
overwrite the pre-existing data as needed, then click the Update button. The new data will replace
the previous data and you will be redirected back to the Customers and Messaging page.

Note: The billing information is initially collected when the payment is made. The shipping information is
collected before viewing the cart or checking out in order to calculate shipping and sales tax, if any. If
shipping is not set for any of the products ordered and none of the products are taxable, the shipping
information form does not appear and this information is not collected.  

4.4 Sales History

Customer sales history can be viewed by clicking on the Sales link next to each customer from within 
Customers and Messaging.
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To view a customer's sales history:

1. Click on the Statistics icon, , next to the selected customer.
2. A Sales Report page will open for the selected customer with the date, time, product name, and

referring affiliate ID and name for each order.

· To send an e-mail message to the selected customer, click on the customer's name. Your local
mail program will open and be addressed to the customer.

· To view the referring affiliate's statistics, click the affiliate ID number for that order record.
· To send an e-mail message to the referring affiliate, click on the affiliate's name. Your local mail

program will open and be addressed to the affiliate.

· To reactivate the order, click the exclamation point icon, , to the far right.

· Click the Profile icon, , next to the customer ID to view this customer's profile.

4.5 Sales Reports

From the Administration Panel main menu, select Manage Sales. A top menu bar appears and the
Customers and Messaging page opens with customers listed. From the top menu bar, select Sales

Reports. Sales Reports may also be opened by clicking on the Sales Reports icon, , next to the
Sales quick stats in the administration panel index page.

Report Filters
Report filters limit the data that is included in each report.

· Transaction Type: Retail, Wholesale or All
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· Payment Status: Unpaid, Paid, Chargebacks or All
· Date Range From: date, To: date

Sorting and Grouping
The filtered report data may be grouped and sorted to view the data from different perspectives.

· Order By: Date, Amount, Customer ID, Product, Downloadable Product, Physical Product
· Sort Order: Ascending or Descending order.

View - Download - Edit
The View and Edit buttons display the report in the browser, but different data and links appear in the

right column. Download exports the report data in a .csv file.

View - Sales report is shown with date, order ID, products, amounts, customer and affiliate links.

Edit - Sales report is shown with date, order ID, products, amounts, customer and links to chargeback

or reactivate and resend orders. In this mode, the last column has links to take action with each order.

Sales Report Mode: Edit
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Chargebacks - Reversals
A chargeback in AShop Deluxe creates a transaction equal and opposite to the original transaction. The
reverse transaction is dated with todays date so that the sales reports can be reconciled with bank
deposits. To Chargeback an order and the corresponding affiliate commissions, click on the Cancel Sale

icon, , next to each order record.
See: Chargebacks - Reversals

Resend Receipt and Reactivate Orders
Receipts may be resent and download limits may be reset at the same time by clicking on the

Reactivate icon. 
See: Resend Receipt

Unpaid Orders will have a payment icon  and a send reminder icon . Click the payment icon to
mark the order as paid and optionally send a receipt for the payment. Click the reminder icon to send an
email to the customer. A reminder message is automatically generated with the order reference number
and a link to pay online through the shopping cart checkout. The message may be edited before
sending.

eMerchant only:  Payment receipts and reminder messages are saved in eMerchant history for each

customer. When eMerchant is installed there will be an icon in each customer's profile, which will
open the eMerchant history for that customer.

Download
When the Download button is selected, the sales report data is exported in a .csv file, which can be
imported to Microsoft Excel. The fields are separated by a semicolon. To separate the data into
columns, open the csv file in Excel. If the separator is not already set to semicolon, all of the data fields
will appear in the first column. To separate the fields into columns within Excel, Select (highlight) the
column that contains the data and then select Data > Text In Columns. Select delimited, then click Next
and set the separator to semicolon. This process may be slightly different for each version of Excel.

screen shot from Microsoft Excel 2000



AShop Deluxe User Guide208

AShop Internet © Copyright 2002 - 2008

Recovering Incomplete and Failed Orders

Preliminary Orders

A preliminary orderid is created each time a customer begins to add products to his/her cart. A
preliminary order is saved in the database for each shopping session so that many customers may shop
at the same time and also to enable more data to be processed for each order. Payment gateways limit
the amount of data that can be passed through the payment process. Preliminary orders are used by the
shopping cart to handle more order related data.

Note: When viewing sales reports for active paid and unpaid orders, the orderid reference numbers will
have gaps in the sequence. This is normal because not all preliminary orders are completed.

Preliminary orders will accumulate in the database over time, which is why there is a Clear button.
Clicking this button will remove all preliminary orders except the last 10 (since some of them could be
orders that are currently being processed).

Activating Incomplete/Failed Orders
Failed orders are simply preliminary orders, which have not received a payment confirmation from the
payment gateway. Unfortunately the Internet is not perfect. Connections, equipment, and software can
fail for various sometimes unexplainable reasons. The shopping cart relies on the payment gateway to
post a payment response to complete and activate each order. If the payment gateway has trouble at
the time that the order is placed or the payment gateway response fails to reach the shopping cart, the
payment may be captured by the payment gateway, but until a payment response is received the
shopping cart will not send a store receipt and the order will not be recorded as paid in the shopping cart
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history.. 

The Incomplete/Failed Orders report provides a way to view preliminary orders to find one that failed, and
then activate the order so that a store receipt will be sent and the order will be recorded in the shopping
cart history. Payment is NOT submitted to any payment service during this process.

1. From the Sales Report page, under Incomplete/Failed Orders, click Edit to show all of the
preliminary orders.

2. Find the preliminary order and click the Activate Order icon, , to open the Complete Preliminary
Orders menu.

3. Select a payment option, verify the customer's shipping address and enter information as needed,
and then click the Submit button to activate the order. Payment is recorded in AShop for the option
selected so that the order appears in sales reports for Paid orders. The receipt, order notice, and
fulfilment notice are sent in the same way as when normal orders are processed. For downloadable
product orders, a link and password will be included. For key code products, the key code(s) will be
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included in the customer's receipt.

4.6 Chargebacks - Reversals

A chargeback in AShop Deluxe creates a transaction equal and opposite to the original transaction. The
reverse transaction is dated with todays date so that the sales reports can be reconciled with bank
deposits and refunds. To Chargeback an order and the corresponding affiliate commissions, Open Sales

Reports and select the date range of the transaction to be reversed. Click on the Cancel Sale icon, ,
next to the order that is to be reversed.

Select or set the options as needed. Different options may appear depending on how the products and
shopping cart are set up. The amounts and product data are selectable here so that report data will be
correct under various circumstances. This chargeback feature is only for reporting and accounting. It
does NOT post any payments or refunds to any payment services.
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Chargebacks appear in reports with red text and negative amounts. There is an icon next to each
chargeback, which displays the comment when the mouse is passed over it.

Note: If your mail server is in a different time zone and the $timezoneoffset is not set to adjust for the
difference, very recent sales transactions may not be included even when the "To:" date is set for the
current date. This happens when the order is stamped with a time that is ahead of your current time
zone.

4.7 Resend Receipt

Resend - Reactivate Receipts

It is possible to resend a receipt and reactivate the password for downloadable products that were in the
order. Open the Sales Report page, select a date range, and click Edit. Click the Resend/Reactivate

icon, , next to the order.
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You will see a page where you can select to resend the receipt, change the email where it will be sent,
send a copy to the administrator, and select to reset the allowed download days and allowed number of
downloads.

Click the Submit button and the Receipt will be resent and/or reactivated accordingly.

View Original Receipts

AShop will save all the sales receipts that have been sent to you customers so that you can view them
any time you have access to your AShop Admin Panel.

If you want receipts to be saved you must change the permissions of the admin/receipts to "777". The
receipts will be saved as a numbered file directly related to the Order ID.

To view the sales receipts you should simply login to your Admin Panel and navigate to Manage Sales. If
you click the Order ID number, for the order you wish to view a receipt for, you can download a copy of
that receipt.

4.8 Unpaid Orders

Unpaid orders are created in the shopping cart when a manual payment option is used.

Apply Payment and Activate Unpaid Order
1. An order notice is emailed to the shop administrator when each order is completed. When a manual

payment method is used to pay for an order, the order notice will include a link, which can be used to
record receipt of payment and activate the order.
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2. Unpaid orders may also be activated through the Sales Reports menu.

Select Unpaid and click Edit.

Then click the manual payment icon in the Unpaid Orders Sales Report.

Payment Confirmation Message
After payment is applied there is an option to send a payment confirmation message to the customer.
The Subject and Message body is automatically filled in with predefined text, which may be edited
before sending the message.
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Send Payment Reminder Message
In Sales Reports, select Unpaid and Edit mode. For each unpaid order, there will be a link to send a
payment reminder message.

Click on the payment reminder icon/link.

The Subject and Message is pre-filled in and may also be edited.
A link to pay will be automatically included in the message.
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5 Affiliates & Referals

5.1 Affiliate Program

From the AShop Administration main menu, click Store Configuration on the left side menu. This will
open the Configure AShop menu. Click on the "Affiliate Program" link.

Affiliate Text
This text will display on the affiliate sign up page. The most common use for this text is to disclose the
terms of the affiliate program and to invite new affiliates to join. HTML and hyperlinks can be included in
this text area.

Affiliate eMail  
The Affiliate E-mail is the address of the affiliate administrator, which can be different from the store
administrator e-mail that is set in Shop Parameters. Affiliate sign-up and affiliate sales notices are sent
the Affiliate E-mail address.

Second Tier
Check this box and set the second tier affiliate commission percentage to enable the second tier
commissions.

Default Affiliate Commission
When a new product is added to the catalog, the percentage amount will default to this amount. The
commission may be set to a percentage or flat rate amount for each product from within Add Products or
Edit Products.

Level 2 Affiliate Commission
A second level of commission rates. You may choose for each affiliate to have Level 1 or Level 2
commissions.
You must select the level of commission an affiliate will receive in their profile.
View your affiliate's profiles in the Messaging and Management section of Manage Affiliates
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Require PayPal ID
Check this box if you want the PayPal field to be required when affiliates sign up. PayPal ID is used
within AShop to make payments for commissions earned. There is also a manual method of recording
commission payments.

Redirect URL
Customer click a link on an affiliate's website or e-newsletter. The link URL goes to the affiliate.php
script and includes the affiliate's ID. The affiliate.php script immediately reads the affiliate's ID from the
URL and places a cookie on the customer's computer so that, when a sale is made to this customer,
the affiliate will be credited a commission for the sale, then redirects to a page of your choosing. It
doesn't matter if the customer goes directly to the catalog page. It may be preferable to direct the
customer to a different page first, for instance; a product information page or ad copy. The Redirect URL
setting is provided for this purpose. To complete the sale, a link to the shopping cart catalog can be
provided, or OrderForm shopping cart functionality may be used within an HTML web page, or
OrderLinks may be used, depending on the type of product and how it is marketed.

Note: For affiliates to receive credit for commissions from click-thru sales, the product catalog
must be accessed by navigating to the file affiliate.php and must include the affiliate's ID in the URL.

For instance:
http://www.yourdomain.com/ashop/affiliate.php?id=1.
Hyperlink code, which includes the affiliate ID is automatically generated for affiliates in the Affiliate
Support Panel.

AShop places a cookie on the visitor's computer and redirects to the URL that is set within
Administration Panel/Store Configuration/Affiliate Program/Redirect URL (usually http://www.yourdomain.
com/ashop/catalogue.php). Once the cookie is set, visitors can leave and return at any time to make a
purchase. AShop checks the cookie and credits the referring affiliate.
The catalog can also be accessed by navigating directly to the script catalogue.php (for instance, http://
www.yourdomain.com/ashop/catalogue.php) or to the AShop folder, where the index.html file will redirect
to catalogue.php, but these links will not credit any affiliate.

Note: The affiliate link can be manipulated to assign another redirect URL. Affiliate referrals can record
stats, set a cookie, and redirect to a specific product page for each link.

For example:
http://www.yourdomain.com/ashop/affiliate.php?id=1&redirect=http://www.anydomain.com/product.html

This link will set the cookie, record the click, and redirect to http://www.anydomain.com/productinfo.html
The syntax in Admin Panel > Manage Affiliates > Link Codes for adding such an affiliate link is:
%affiliatelink%&redirect=http://www.anydomain.com/product.html

You could use this to create affiliate links to a product page or any page you want. The product pages
could even be on a completely different domain. To complete the order, the productinfo.html page can
have a link to the shopping cart catalog, to an OrderForm page, or directly to checkout with an Order-
Link.

Affiliate Commission FAQs

Tier-1 commissions are earned when a customer clicks through an affiliate link and then purchases a
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product that has a tier-1 commission set for it. 

The tier-1 commission rate is set as a dollar amount or percentage for each product. You can set a
different amount/percentage for two commission levels (not to be confused with tiers). When each
affiliate first signs up, he/she receives level 1 commissions. 
See: Add Products

Tier-2 commissions are commissions that are earned by an affiliate when somebody who clicked
through his/her affiliate link signs up as an affiliate and then refers customers who purchase products.
See: Second Tier Affiliate Commissions

Tier-2 commissions are set as a percentage of orders. There are two levels, just as with tier-1
commissions. Tier-2 commission rates are set in the Store Configuration > Affiliate Program page.
See: affiliate_program_1.htm

You can promote the affiliate to level 2 in the profile page for each affiliate.
See: View Edit Affiliate Contact Information

AShop Deluxe posts only one-time payments to PayPal. One-time payments through the shopping
cart and PayPal IPN method do not initiate recurring billing. Recurring billing setup through PayPal does
not affect affiliate commissions in AShop Deluxe.

None of the commissions are automatically recurring. 

Tier-1 commissions are only earned once when a product with a tier-1 commission is ordered. 

Tier-2 commissions are only earned once when a second tier affiliate refers a customer who orders a
product.

5.2 Second Tier Affiliate Commissions

From the AShop Administration main menu, click Store Configuration on the left side menu. This will
open the Configure AShop menu. Then select "Affiliate Program". Set the tier-2 commission rate by a
percentage of each order subtotal.

2-Tier Affiliate Commission Tracking

Two tier affiliate commission tracking in AShop Software calculates different types of commissions.
Each affiliate tier promotes your online business in a different way.

Tier one commissions are earned by affiliates who promote your products. Tier one commissions
are set per product by an amount or percentage of the product price and are paid to affiliates for referring
customers who order products directly from your site through affiliate links.

Tier two commissions are earned by affiliates who promote your affiliate sales program. Tier
two commissions are paid to each affiliate who signs up other affiliates (who earn the tier one
commissions for direct referral sales). The tier 2 commission rate is set as a percentage of the order
subtotal (before taxes and shipping, if any). The second tier amount per order is typically a much smaller
amount compared to the tier 1 commission rate, however when multiplied by numerous affiliate signups,
it creates a powerful incentive to promote your affiliate sales program.
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How 2-Tier Affiliate Commission Tracking Works

· Tier-1 commissions are set by percentage or dollar amount per product.
· Tier-2 commissions are set by a percentage of the order subtotal (before taxes and shipping).
· Every affiliate can potentially earn tier-1 and/or tier-2 commissions.
· Tier-1 commissions are earned by direct sales referrals.
· Affiliates earn tier-2 commissions from sales of other affiliates who signed up through them.

Example:
Affiliate A signs up and places a sign up link on his web site.
Affiliate B signs up through Affiliate A.
Affiliate C signs up through Affiliate B.

When a customer buys something through a link on Affiliate A's site, Affiliate A will receive the tier-1
commission rate for each product that is ordered.

When a customer buys something through a link on Affiliate B's site, Affiliate B will receive the
commission rate for each product that is ordered and Affiliate A will receive the second tier commission,
which is set as a percentage of the order subtotal.

When someone buys something from a link on Affiliate C's site Affiliate C will receive the tier-1
commission rate for each product ordered and Affiliate B will receive the second tier, which is a
percentage of the order subtotal.

Each affiliate places a sign up form link and a sales link on his or her web site. Each affiliate earns the
tier-1 commissions for AShop sales that come through his sales link and also earns a smaller
commission for sales by the affiliates that have signed up through his or her sign up form link.

5.3 Manage Affiliates

Click on the "Affiliate Management" link in the Administration Panel main menu to manage affiliates. A
top menu bar appears and the Profiles and Messaging main page opens. There are three areas within
Affiliate Management.

Messaging and Management
E-Mail Messages To All Or Select Affiliates
View The Affiliates' Websites
View And Edit Affiliate Contact Information
View Commission & Payment History
Assign Discount Codes For Manual Referrals

Statistics and Payment
View Affiliate Sales, Commission Stats, and History
PayPal Payments and Update Commissions Paid

Link Codes
Link Code Generator
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5.4 E-Mail Messages To Affiliates

From the Administration Panel main menu, select Manage Affiliates. A top menu bar appears and the
Messaging and Management main page opens. Enter the subject and message into the text boxes.

To e-mail a message to one affiliate
1. Click on the e-mail link for the selected affiliate. This will open your default e-mail program, such

as Outlook Express or Eudora.

To e-mail a message to selected affiliates
1. Place a check mark in the box next to each affiliate that you wish to send a message to.
2. Enter the Subject and Message text into the corresponding text boxes.
3. Click the "Mail to selected" button to send the message to selected affiliate.

To e-mail a message to all of the affiliates
1. Enter the Subject and Message text into the corresponding text boxes.
2. Click the "Mail to all" button to send the message to selected affiliates.

HTML-format or Plain text

HTML-format
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With HTML-format selected, formatting tags, tables and hyperlinks may be typed or pasted into the
message box. With this setting, a page may be designed within your favorite WYSIWYG HTML
editor. You can then copy the HTML code and paste it into the message box to send newsletters,
advertisements, and other notices to customers or affiliates.

Note: With this setting, carriage returns within the message box do not generate line breaks and
must always be inserted with <br> or <p> tags or the text will all flow together in the resulting e-
mail message.

Plain text
The Plain text setting does not recognize HTML tags and will render tag text in the e-mail message
just as you enter it into the message box. With this setting, carriage returns in the message box
generate a line break in the resulting e-mail message as they do in your client e-mail software such
as Eudora or Microsoft Outlook 

5.5 View Affiliates' Websites

From the Administration Panel main menu, select Manage Affiliates. A top menu bar appears and the
Profiles and Messaging main page opens.

Click on the URL for the affiliate website that you wish to view. The website will open in a new browser
window. When you are finished viewing the affiliate's website, close the affiliate website browser to return
to the Affiliate Management panel.
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5.6 View/Edit Affiliate Contact Information

From the Administration Panel main menu, select Manage Affiliates. A top menu bar appears and the
Messaging and Management page opens. To view or edit an affiliate's contact information, click the

Profile icon, , or the number next to the selected affiliate.

The affiliate's contact information will be displayed in text boxes within a form.

The Manual Referral Code can be used to track word of mouth and print advertising and discount
coupon campaigns. It is automatically generated by AShop when each affiliate signs up. It is generated
with 8 characters; generally the first two letters of the first name, the first three letters of the last name,
and a three digit number. The referral code is editable by the shop administrator.

See also: Discount Codes, Referral Codes And Discounts

Affiliate Contact Information
· Username
· Password
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· First Name
· Last Name
· E-mail Address
· Street Address
· City, State, Zip
· Country
· Telephone Number
· Website URL
· PayPal ID (e-mail address to receive PayPal commission payments)

Note: All of the Affiliate Contact Information is required in the affiliate sign up form, with the exception of
the PayPal ID, which is optionally required.

To edit any of the above fields, type new information into each text box that you wish to change. Click
the Update button. The information that is displayed in the form will replace the existing information in
the database.

5.7 Statistics and Payment

From the Administration Panel main menu, click on Manage Affiliates, and then click on Statistics and
Payment. The affiliates' names are listed with to-date summaries of Clicks, Orders, Earned, and Unpaid

stats. Click the affiliate ID number or the Profile Icon, , to open the affiliate profile page. Click the
affiliate name to email the affiliate.

A Pay Now icon, , will appear next to each affiliate who is owed a commission.

Click the Pay Now icon, , to open the Affiliate Payment panel.

Click the Statistics icon, ,to view stats and history for each affiliate.

Click on the Order ID link to view the order details.
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Click on the Affiliate ID number in the Referred by column to return to that affiliate's statistics page.

5.8 Affiliate Commission Payments

From the Administration Panel main menu, click on Manage Affiliates, and then click on Statistics and
Payment.

A Pay Now icon, , will appear next to each affiliate who is owed a commission.

Click the Pay Now icon, , to open the Affiliate Payment page for that affiliate. The total balance due for
the selected affiliate is listed at the top of the page. Unpaid commissions are listed with the Order ID,
Date, and Commission amount.

To pay commissions to the selected affiliate and mark the commissions as paid:
1. Select commissions for payment by placing or removing the check mark next to each unpaid

commission.
2. Check the method of payment. PayPal or Check.
3. Click Mark As Paid to process the payment. If PayPal is the selected payment method, the

browser will be directed to a PayPal payment page with the amount to be paid filled into the
payment form. If Check is the selected payment method, the affiliate contact information for check
writing will be displayed.
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To undo payment records:

1. Click on Manage Affiliates, select Statistics and Payment, then click on the Statistics, , next to
the affiliate that you wish to edit.

2. Click on the Delete icon, , next to the commission payment record that is to be deleted.

Note: To use the PayPal payments feature, the affiliate must first have a PayPal ID recorded in Affiliate
Contact Information.

Note: Your pay from PayPal account must be a verified business account to use this feature or PayPal
will not accept the transaction. The first time this feature is used, you must enter your PayPal account.
This will be stored in a cookie on your PC. Subsequently, the PayPal payment form will default to this
pay from account.

5.9 Affiliate Link Code Generator

From the Administration Panel main menu, select Manage Affiliates. Select Link Code from the top
menu bar.
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The affiliate link code generator enables the store administrator to create banners and text ads for
affiliates to use in their web sites, ezines, and newsletters. Once the store administrator enters the
banners and text ads, the code generator automatically inserts each affiliate's ID into the code for them
to copy from their affiliate support panel.

Add A New Banner
1. Browse for a .jpg or .gif image to upload.
2. Set the image alt text. (Text that appears on the page when the mouse is passed over the image)
3. Optionally, set the Redirect URL. If this is not set, customers will be redirected to the default

redirect URL, which is set within Store Configuration > Affiliate Program.
4. Optionally, enter text for a text link.
5. Submit the form to save changes. AShop will generate a link for each affiliate with their ID code for

tracking.

HTML Code (Link text)

Enter the text and HTML that will be provided to affiliates for advertising. Tokens can be used within the
HTML link code to provide affiliates with a copy of the code with the correct affiliate ID number . For
example, if the URL to your affiliate.php script is http://www.yourdomain.com/affiliate.php and the
referring affiliate's ID is 2, then when affiliate number 2 logs in, he will see the link code with the id=2
parameter. http://www.yourdomain.com/affiliate.php?id=2

Link Code Tokens
There are two tokens, which can be used to insert the affiliate.php URL with each affiliates' ID number.

%affiliatelink% inserts the URL to the affiliate.php script on your site and adds each affiliates' ID
parameter.
Example: You enter this text and HTML into the affiliate link code generator.
We like to <a href="%affiliatelink%">Go here</a>.

Affiliate number 2 sees the following link code when logged into his or her affiliate panel.
We like to <a href="http://www.yourdomain.com/affiliate.php?id=2">Go here</a>.

Customers see "We like to Go here."

http://www.yourdomain.com/affiliate.php?id=2
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When the mouse is passed over the link, the complete URL appears in the browser status bar.
http://www.yourdomain.com/affiliate.php?id=2

%affiliatecloaklink% inserts the URL to the affiliate.php script on your site and adds each affiliates' ID
parameter. It also adds link cloaking code, which prevents the actual URL from being displayed in the
browser status bar. This token must be placed within the HTML code in a different way so that it can
create the hyperlink opening tag in the correct place.
Example: You enter this text and HTML into the affiliate link code generator.
We like to %affiliatecloaklink% Go here</a>.

Affiliate number 2 sees the following link code when logged into his or her affiliate panel.
We like to <a href="http://www.yourdomain.com" onClick="window.open('http://www.
yourdomain.com/affiliate.php?id=2', 'PGM', 'scrollbars=yes, toolbar=yes, status=yes,
menubar=yes location=yes resizable=yes'); return false;"> Go here</a>.

Customers see "We like to Go here."
When the mouse is passed over the link, only the URL from the beginning of the <a> tag appears in the
browser status bar.
http://www.yourdomain.com

Read more about how affiliate links work in Store Configuration > Affiliate Program.

5.10 Referral Codes and Discounts

Disounts can be created and applied to each order or to each product. The two different types of
discounts are managed in two different places. Per order discounts are set through the Discounts
button, which is at the top right of the Edit Catalog page. Individual product discounts are set by clicking
the Discount button under each product listing in the Edit Catalog page.

Per Order Discounts - Applied At Check Out

Per Product Discounts - Applied To Each Product While Shopping

Per product discounts can be used as incentives to track affiliate referals. One way that this can be
done is by using the Manual Referral Code, which is unique for each affiliate. Each affiliate can be
registered with any number of discount codes by linking the discounts to his/her manual referal code.

To register affiliates with discount codes, go to Manage Affiliates.

Click on the Referral Discounts icon, , to the right of each affiliate to manage discount registration.

To register an affiliate with a discount code, select from the drop down box and click Add.

All of the registered discount codes will appear for each affiliate.

http://www.yourdomain.com
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Customers can be sent to a page where they are prompted to enter a referral code. This page can be
the affiliate.php script or a form that is placed within an HTML page.

affiliate.php (uses the cart.html page template)

When a valid referral code is entered, the affiliate is credited for the click and a tracking cookie is set on
the visitor's browser. The catalog pages will automatically show the discount codes that are registered to
the referring affiliate.
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5.11 Referral Form Code

There are two ways for customers to enter an affiliate's manual referral code. When affiliate.php is
opened without an affiliate ID parameter, the following form opens in the browser. The form page uses the
cart.html page template.

The manual referral form may also be inserted into an HTML web page. An example of the form is
included with distribution of AShop Deluxe and is named referralformEXAMPLE.html.

<form action="affiliate.php" method="post">
        <input type="text" name="referrer" size="15">
        <input type="submit" value="Submit" name="submit">
</form>

5.12 Affiliate Sign Up Form

New Affiliate Sign Up

1. For new affiliate sign ups, open the signupform.php file.

For example: http://www.yourdomain.com/ashop/affiliate/signupform.php
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2. The new affiliate can choose a User Name and enter contact information, a website URL, and a
PayPal account e-mail address into the sign-up form. 

3. After completing the form, the affiliate clicks the Submit button to save the information.
4. AShop automatically sends a password to the affiliate's e-mail address and the new affiliate is

instructed to check his/her e-mail for the password before proceeding.
5. A notice of the new affiliate is automatically e-mailed by AShop to the Affiliate Administrator.
6. The affiliate is then redirected to the login page where the password is required in order to access

his/her Affiliate Support Panel.

5.13 Affiliate Support Panel

Affiliate Support Panel
The Affiliate Support Panel is where affiliates sign up and login to update their contact information, view
stats for clicks and commissions earned, and copy link and banner code to paste into their web sites,
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ezines, and newsletters.

Existing affiliates will login to view/edit their profiles or change their passwords by navigating to the login.
php file.
For example: http://www.yourdomain.com/ashop/affiliate/login.php

If an affiliate forgets his password, there is a "Forgot your password?" utility that will e-mail the password
to the e-mail address on file for that affiliate.

Upon logging in, the Affiliate Support Panel will open with the affiliate's stats listed:
· Number of Clicks From Affiliate's Page
· Number of Orders From Affiliate's Page
· Number of Orders From Affiliate's Recruited Affiliates (appears only if you have Second Tier affiliates

activated in the Affiliate Program menu)
· Total of Affiliate's Earnings
· Amount of Commissions Currently Owed

View/Edit Affiliate's Profile
The affiliate may view or edit his profile data by clicking on the View/Edit Profile button. The affiliate's
contact information will be displayed in text boxes within a form.

Affiliate Contact Information
· First Name
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· Last Name
· E-mail Address
· Street Address
· City, State, Zip, Country
· Telephone Number
· Website URL
· PayPal ID (e-mail address to receive PayPal commission payments)

To edit any of the fields, type new information into each text box to be edited. Click the Update button.
The information that is displayed in the form will replace the existing information in the database.

Change Affiliate Password
Affiliates may change their passwords by clicking on the Change password button. The existing
password must be entered once and the new password entered twice to verify that it is entered correctly.
To save the new password, click the Update button.

Affiliate Link Code
The store administrator adds banners and ads in the Administration Panel/Manage Affiliates/Link Code.
The banner and text code is generated for each affiliate to include a link to the ashop store and also to
include the affiliate's ID number for tracking. 

Note: The link will direct customers to the AShop affiliate.php file, which tracks the affiliate's clicks and
sales, and then redirects the customer to the catalog or any other URL specified by the store
administrator from within the Administration Panel/Affiliate Program/Redirect URL setting.
For example: http://www.yourdomain.com/ashop/affiliate.php?id=1 where id=[the affiliate's ID number]

Note: AShop will automatically generate one simple link with affiliate code for each affiliate.
For example: <a href="http://www.yourdomain.com/ashop/affiliate.php?id=1">The Name Of Your Store</
a>

6 eMerchant

6.1 eMerchant Introduction

This section applies only to eMerchant.
See also: Install eMerchant , eMerchant Configuration , eMerchant Tour

The eMerchant operator pages are divided into three main areas. The eMerchant tool bar on the left side

http://www.ashopsoftware.com/emerchant-order-entry-tracking-software.htm


AShop Deluxe User Guide232

AShop Internet © Copyright 2002 - 2008

appears in all pages.

Messages

The Customer Messages page displays new messages, which are fetched from the customer mailbox
that is set in eMerchant configuration. If spam blocking is enabled, messages from unknown senders go
to the spam bin. A message history link displays previous customer messages in chronological order.

The Vendor Messages page displays new messages, which are fetched from the vendor mailbox that is
set in eMerchant configuration. Spam blocking is not applied to vendor messages.  A message history
link displays previous vendor messages in chronological order.

Customers

Quick Quotes can be created, saved, and sent without requiring complete customer billing or shipping
information. A quick quote may later be retrieved for conversion into a bill or a paid order.

Edit a Quote by entering the quote number. The quote may be resent or converted into a bill or paid
order.

Find Customer - List customers alphabetically by last name or search by full or partial spelling of the
email address, any part of the first or last name, or full or partial phone number.

Add a New Customer

Vendors

Manage Purchase Orders - Create and send purchase orders to vendors. Report purchase orders by
status: sent, unshipped, and shipped (but not billed yet). Look up purchase orders in relation to
customer order numbers. This area provides a comprehensive way to directly access order and shipment
related information from customer or the vendor references.

Manage Bills - Report paid and unpaid bills. Vendor bill reports can be sorted and filtered by vendor,
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status and date ranges.

Manage Vendors - Add and edit vendor contact information. View vendor history.

6.2 eMerchant Tool Bar

The eMerchant tool bar appears in all of the eMerchant operator pages.

The eMerchant tool bar is divided into 5 sections: Open Items, Announcements, Reminders, Links, and
Contact Information.

Open Items include information about and links to: Customer Messages, Vendor Messages, Spam,
Unconverted Quotes

Announcements are set by the AShop administrator panel under eMerchant. This is a place where the
administrator of the shop can post messages for all operators (eMerchant users) to see.
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Reminders can be created and deleted by any eMerchant user. Reminders appear for all eMerchant
users when logged in.

Links can be created and deleted by any eMerchant user. Links open in a new window. They may be to
any valid URL. There are two links that cannot be deleted: Product Catalogue opens catalogue.php.
Admin Panel only appears when logged in as admin and it opens the AShop admin panel in a new
browser.

Contact Information is the contact information that is set for the shop in the AShop admin panel Store
Configuration > Shop Parameters. This is the same information that appears by default in receipts and in
the payment confirmation page. This information is here as reference for eMerchant operators (users).

6.3 Customer Messages

The admin user can login through the admin panel or directly to eMerchant. All other users must login to
the emerchant directory. For example: http://www.yourdomain.com/emerchant or http://www.
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yourdomain.com/ashop/emerchant depending on where AShop is installed. emerchant/index.html
automatically redirects to emerchant/login.php

Upon login, mail is fetched from the customer email box, which is set in eMerchant Configuration. If
spam blocking is not enabled all customer messages are moved to the customer messages inbox. If the
spam blocking is enabled in eMerchant Configuration, then eMail that is from known senders is moved to
the inbox and all other eMail is moved to the Spam Bin.

If the admin email setting, which is set in Store Configuration > Shop Parameters is set to the same
address as the eMerchant customer email address, all admin notices will post directly in the eMerchant
customer inbox (not sent by email to the POP3 mailbox). This method is more reliable and secure than
sending admin notices by email and it reduces the load on the local mail server. If the addresses are
different, the admin notices will be sent as regular email (same as when AShop Deluxe is installed
without eMerchant).

Customer Messages are received in two ways.

1. The customer mailbox is checked and new messages are fetched automatically upon logging into
eMerchant and when the Messages page is opened. eMail is fetched from a POP3 mailbox and the
messages are then deleted from the POP3 mailbox.

3. Messages from contact forms are posted directly to this inbox. Admin notices also post directly to
the eMerchant customer inbox if the admin email address is same as the eMerchant customer
email address.

How to Process Messages

Use the icon/links on the right to reply, save, delete, view profile, and view history. You may view the
sender's email address in the browser status bar by passing the mouse over the From field. Open a new
message to the Sender in your local email client (for example Outlook) by clicking on the From field. 

Open the view message window by clicking on the Subject line. There are also links in the view
message window to reply, save or delete the message.
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 When a Reply is sent, the original message and the reply are saved to the customer history. If a
customer with that email address already exists, the messages are saved to that customer history. If
there is not an existing customer with that email address, a new customer profile is created and the
messages are saved to the new customer history.

 Forward the message (and attachment, if any). The forwarding window will open with the
eMerchant customer address. Change it to the forwarding recipient.

 Delete completely deletes the message.

 Save saves to an existing customer history or creates a new customer profile if there is not already
a customer with that email address.

 Customer Profile icon/links only appear for existing customers. They link directly to each
customer's contact information.

 Customer History icon/links only appear for existing customers. They link directly to each
customer's history.

To Delete or Save Multiple Messages, click the checkbox to the left of each message to select
specific messages or click the checkbox at the top of the column to select all of the messages. Then
click on delete or save button at the bottom.

Check Mail while logged in by clicking on the Check Mail button in the Messages page. There is also a
check mail link on the left in the tool bar, which appears in every eMerchant page.



eMerchant 237

AShop Internet © Copyright 2002 - 2008

Message History

To view previous customer messages in chronological order, click on the Message History link.

 
Shortcut icon/links provide direct access to related customer information and to process the messages.
Use the page links at the bottom to browse message history by page number or previous/next page.

6.4 Spam Bin

Upon login, mail is fetched from the customer email box, which is set in eMerchant Configuration. If
spam blocking is not enabled all customer messages are moved to the customer messages inbox. If the
spam blocking is enabled in eMerchant Configuration, then eMail that is from known senders is moved to
the inbox and all other eMail is moved to the Spam Bin.

Click the Save icon/link next to each message in the spam bin to move it to the customer inbox.
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Click the Empty button to delete all the spam messages with one click.

Click the From link to open a local email client such as Outlook. Note that when messages are sent
through a local email client software they are NOT automatically saved in eMerchant message history. 

Click the Subject line to open the eMerchant view message window. When a message from the spam
bin is replied to, a customer profile is created for the original sender and related messages are saved in
the customer's history. Future messages from the same sender will then be received in the inbox
instead of the spam bin.

6.5 Vendor Messages

Upon login, mail is fetched from the vendor email box, which is set in eMerchant Configuration. Spam
blocking does not apply to the vendor messages. Use the icon/links on the right to process each
message or to go directly to the vendor profile or history.

Click the From link to open a local email client such as Outlook. Note that when messages are sent
through a local email client software they are NOT automatically saved in eMerchant message history. 

Click the Subject line to open the eMerchant view message window. When a vendor message is replied
to through eMerchant, the original message and the reply are automatically saved in the corresponding
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vendor's history.

6.6 Customers

In the main menu at the top of the page, click Customers.

Create a (Quick) Quote

The Quick Quote feature is used to look-up product prices, calculate shipping and taxes, and calculate
total amounts. The customer name and address is not necessary for a quick quote. A quick quote can
be saved and sent to a valid email address or printed. Quotes can be looked up, related to a customer,
and converted into orders or bills through the Unconverted Quotes menu, which is in the eMerchant Tool
Bar.
See also: Quotes and Orders

To create a Quick Quote, enter the shipping state and zip and click Go. 



AShop Deluxe User Guide240

AShop Internet © Copyright 2002 - 2008

Select products and add them to the quote.
· To exit without saving changes, navigate to another page in the main menus or logout.
· Save - the quote and create a reference number.
· Send - the by email, save the quote and create a reference number. 
· Bill - converts the quote to an unpaid order and sends an invoice with a link to pay online.
· Print - the quote, save it and create a reference number.

Edit an Existing Quote

Previously saved quotes may be looked up by the reference number. A previously saved quick quote can
then be edited, processed, and related to a specific customer.
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Find an Existing Customer

The alphabetic customer lookup lists customers by last name in ascending order.

Find customers by partial or complete spelling of the email address, (first or last) name, or phone
number. Find by phone number ignores non-numeric characters and spaces so that the phone number
may be entered in any format.
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Merge Customer Profiles

Each customer's email address is a unique reference. If a customer has used more than one email
address when ordering products or contacting the shop, it is possible for more than one customer profile
to exist for the same customer. To merge the customer profiles into one customer profile, find the
customer by last name or phone number. In the search results, check the box next to each listing for
the customer and click the Merge selected profiles button at the bottom of the page.

Select the customer profile where the multiple profiles will be merged to and click Merge into selected
profile.
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The billing and shipping addresses in the selected profile are kept and saved. The billing and shipping
addresses from the unselected profiles are deleted during the merge. eMail addresses and phone
numbers from the unselected profiles are saved in the selected profile under Alternate eMail and
Alternate Phone.

Add a New Customer Record

To add a new customer record, enter the name, email address and billing information. An email address
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must be entered as this is the unique reference for each customer. All of the address text fields must
have an entry before the form can be submitted. If some of the information is not known yet, enter
"unknown" or a hyphen or any other character and click Save.

After the customer contact and billing information is saved, shipping information may be entered and
saved with the customer profile. Check the box labeled "Sending email to this customer is allowed" for
the customer to receive mass emails, which may be sent from the customer messaging tools.

Customer History

Click on the history icon  to view a customer's history. History icons are located in the inbox next to
each known contact and at the top of the page in each customer's profile page.
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The history for each customer includes all messages, notes, quotes, orders, and bills that relate to that
customer. Historical listings are linked to the original transaction where applicable.

Messages that were received from and sent to the customer appear in the history page with a link to
open the message. Message history includes emails that were sent and received through Customer
Messages. Each customer history also includes reminder and past due messages, which can be sent
manually through Sales Reports and may also be sent automatically for each bill. The message subject
link opens each message in a pop-up window.
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Notes that were saved for the customer appear with the word "Comment" and the subject line of the
note, which links to open the note for viewing and editing. When a note is saved, it is datestamped.
When it is edited, the datestamp is replaced with the edit datestamp.
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Quotes that were previously sent or saved for the customer appear with the quote number, which
links to the original quote to open it for editing or to convert it into an order.  See Quotes and Orders.
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Orders that are listed in customer history may have more than one link depending on the type of
products that are in each order.
· The orderid number links to open the original receipt in a new browser window.
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· A Status link appears when any products in the order are assigned to a vendor. Click the Status link
to view the status of related purchase orders. If there is multiple vendor assigned products within one
order, the products will be grouped by vendor so that there will be one purchase order for each vendor.



AShop Deluxe User Guide250

AShop Internet © Copyright 2002 - 2008

· An Edit link will appear next to the orderid if the order is unpaid. Unpaid orders are created when
payment has not been applied to an order that was paid by a manual payment option. For example
when a customer checks out and selects to pay by check and the check has not been received yet.
Unpaid orders may also be created in eMerchant by converting a quote into a payable bill. Click the
Edit link to view and edit the bill properties. Additional text such as "Unpaid" or "Overdue" will appear
before the orderid depending on the status of the unpaid order.

· A Recurring link will appear for bills that are recurring. Click the Recurring link to view and edit the
recurring bill properties. With the use of billing templates it is possible to create multiple recurring bills
from each order. If the order included more than one recurring bill, the recurring bills will be listed
separately with a link to edit each bill.
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6.7 Quotes and Orders

Every customer order begins as a quote, which may then be converted into an order. Quotes may be
created, edited, and processed in various ways.

Quick Quote
The Quick Quote feature is used to look-up product prices, calculate shipping and taxes, and calculate
total amounts. The customer name and address is not necessary for a quick quote. A quick quote can
be saved and sent to a valid email address or printed. Quotes can be looked up, related to a customer,
and converted into orders or bills through the Unconverted Quotes menu, which is in the eMerchant Tool
Bar.
For more about Quick Quotes see: Customers

Create a New Quote For a New or Existing Customer
To create a new customer profile or find an existing customer profile go to the Customers menu. Note
that a profile is automatically created for each new customer when an order is placed through the
shopping cart and when a new customer contacts the shop through the eMerchant contact form. A
quote may then be created for the selected customer from the customer profile page or from the
customer history page.

Select an existing customer or create a new customer profile.
Click the quote icon/link at the top of the customer's profile or history page.
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Add products and comments to the quote and then process it. Shipping and tax will be automatically
calculated and can then be edited manually if desired.

Find a Saved Quote

Saved quotes may be found in several ways.

eMerchant Tool Bar
Quotes are listed in chronological order through the eMerchant tool bar Unconverted Quotes.

Quotes that are related to a customer are listed with the customer name. Quick quotes, which are not
related to a customer are listed with the state and zip.
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Search By Quote Number
To search for a quote by the quote reference number, click Customers in the top nav bar. Enter the
quote number and click Go.

Customer History
Quotes also appear in each related customer's history.

6.8 Vendors

To access the vendor management tools, click on the Vendors link at the top of the page.
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Manage Purchase Orders
There are two ways to create purchase orders in eMerchant.
1. When a customer order is received and the order includes products that are assigned to a vendor or

more than one vendor, the products are grouped by vendor and a purchase order is automatically
suggested for each vendor. The suggested new purchase orders appear in the Open Orders report.
At this point, the POs are not saved yet and they do not have purchase order reference numbers.
The new POs may be edited or voided if necessary. When a new purchase order is printed or sent,
a purchase order number is assigned, the purchase order is saved, the PO status changes to Sent,
and the saved PO will now appear in Unshipped Purchase Orders reports.

2. Purchase orders may be created manually for each vendor and referenced to a customer. A
purchase order number is assigned when the manually created PO is saved, printed, or sent.

Edit an existing purchase order.
Enter the purchase order number and click Go. Existing purchase orders may also be found in relation
to each customer order by looking up the Status of Order ID (below) and also by looking up the order
through each customer's history.

Create a new purchase order.
Select the vendor for which the purchase order will be created and then click the Go button. When
creating a purchase order to a vendor, only that vendor's products appear in the product selection box.
Products from more than one vendor cannot be mixed in one purchase order.

Open Orders are customer orders that include vendor products for which purchase orders have not been
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created yet. Open Orders may be reported for all vendors or for a specific vendor. To view open orders for
all vendors click Go with All vendors selected (default selection). To view open orders for a specific
vendor, first select the vendor, then click Go.

How to Void a New Purchase Order
New orders that contain vendor products automatically suggest a new purchase order for each vendor in
Open Orders. A purchase order cannot be voided until it is sent and saved. To void a new (suggested)
purchase order, first send it to "No Recipient". After it is sent, a void link will appear at the bottom of the
PO.

Unshipped Purchase Orders have been saved and sent or printed, but have not been marked as
shipped. Orders are typically datestamped as shipped when the vendor sends notice of shipment and/or
the vendor sends tracking information. To view unshipped orders for all vendors click the Go button on
the right. To view unshipped orders for a specific vendor, first select the vendor, then click Go.

Shipped Purchase Orders are purchase orders that have been marked as shipped, but for which a bill
has not been received yet. To view shipped orders for all vendors click the Go button on the right. To view
shipped orders for a specific vendor, first select the vendor, then click Go.

Manage Vendor Bills

A vendor bill may be entered for each shipped purchase order. Vendor bills may then be reported by date
and status. In the reports, the vendor bills link to the related purchase orders, which link to related
vendor and customer information. Note that this feature is intended to track order and billing status and
to facilitate daily operations. It is not intended to replace an accounting system or to be the authoritative
source of data for accounting.

Select the report filters and click Go.

The Vendor selection can be for all vendors or only one selected vendor. The date range can be selected
by bill date or paid date. Status can be all, paid, or unpaid. The reports can be sorted in order of vendor
or date. Action is display or download in CSV.

Unpaid bills appear in vendor reports with a check box. Check the boxes and click Calculate Selected
to see the total amount to be paid.
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Set the paid date and click Submit to mark the selected bills as paid.

Manage Vendors

Select or search for a vendor to view/edit a vendor profile, vendor contacts, vendor history, and related
transactions. To add a new vendor, click the Add Vendor button at the bottom of the page.

Vendor Contacts may be added for each vendor. Notes and messages from the contact will appear in
that contact's history. All notes and messages to and from the main vendor email and all of the vendor
contacts will appear in the main vendor history.
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6.9 Bills and Recurring Billing

To create a bill and send an invoice, begin by creating a quote and then convert the quote into a bill.
When a bill is created an invoice may be emailed to the customer. The invoice will automatically include
the order reference number and a link to pay online through the shopping cart checkout/payment pages.
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A bill may be one-time or recurring. If it is recurring, a new bill will be automatically created and emailed
to the customer on a schedule, which is set in the edit bill page. Recurring bills may be set to stop after
a specific number of billing cycles or they may be set to continue indefinitely.
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The Due Date appears at the bottom of invoices and it is used as a reference for sending reminders,
past due messages, and recurring bills.

For service from: %startdate% to: %enddate% - These dates are used by the tokens in the Add
Comment field (below). The first invoice will use the dates that are set when the bill is first created. If the
bill is recurring, the dates will automatically increment for each billing cycle based on the length of the
billing cycle. For example with monthly recurring bills the next automatically generated invoice will
include from/to dates that are one month after the from/to dates of the previous invoice.

Add Comment - A comment may be included in each invoice. Tokens may be used to include variable
content such as dates and order related data. To omit the comment from invoices, leave this field blank.

Remind (number of days) before due date if not paid - Check the box to enable the reminder
message and enter a number of days that is appropriate for the billing cycle. For example if the recurring
invoice is to be created and sent 10 days before the due date for each billing cycle, the reminder
message can be sent within 1 to 10 days of the due date.

· Reminder messages will not be sent for bills that have already been paid.
· A reminder cannot be sent before the invoice is sent. If the Remind (number of days) is set to a value

that is before the date that the bill will be sent,  there will be a pop up error message and the setting
will not be saved.

· The reminder will never be sent if it is time to send the past due message. For example; if the cron job
for autobill.php has been inactive for a while.

Reminder Message - The reminder message text is included in reminder messages that are
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automatically sent and also in reminders that are manually sent from Sales Reports (for Unpaid orders in
Edit mode). Tokens may be used to include variable content such as dates and order related data.

Send Past Due Message (number of days) after due date if not paid - When the box is checked, a
past due message will be automatically generated and sent the set number of days after the due date.
Past due messages are not sent for bills that have already been paid.

Past Due Message - This text is included in automatically generated past due messages. Tokens may
be used to include variable content such as dates and order related data.

Recurring options are None, Weekly, Monthly, Quarterly, Semiannually or Annually. After the first bill
sent, recurring bills will be automatically created and sent based upon the cycle that is set for Recurring.
AutoBill will calculate the date to send the next recurring bill by first figuring out its due date and then
subtracting the "send x days before due date" from it. If "send x days before due date" is set to zero, the
next bill will be sent on the next due date.

Repeat number of times - This is how many times automatic recurring bills will be created and sent.
This does not include the first bill, which was manually created or created from a shopping cart order
with a recurring bill template. Set the number of times to zero if the recurring bills are to continue
indefinitely.

Create and send bill (number of days) before due date - Automatic recurring bills are typically
created and sent before the due date so that customers have adequate time to pay before the bill
becomes past due. The number of days set here should be greater than the Reminder Message number
of days.

Tokens are placeholders where variable data is inserted into the message text by the program.

%startdate% - The beginning date of period of time for which the service is being billed.
%enddate% - The ending date of the period of time for which the service is being billed.
%duedate% - This is the due date for each bill.
%orderid%

The %startdate%, %enddate%, and %duedate% values are initially set when a new bill is created. For
recurring bills, the dates are automatically incremented with each billing cycle.

AutoBill - Automatic Recurring Bills

To generate new automatic recurring bills and to send reminder and past due messages the emerchant/
autobill.php script should be run.

Before running autobill.php,  open the script in a text editor and set the server path. Do not remove the
quotes or the semicolon around the path setting. Do not edit anything else in this file.
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To run autobill.php automatically on a daily schedule, set up a Cron. Set the Crontab to run every day. If
there are other Crons scheduled for the same domain, set this one to run at a different time so that
potential conflicts are avoided. Here is an example of a Cron command to run autobill.php.
/usr/bin/php -q /home/httpd/vhosts/yourdomain.com/httpdocs/emerchant/autobill.php

Typical Cron Setup in Plesk

Daily AutoBill Reports

http://en.wikipedia.org/wiki/Cron
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Each time autobill.php runs, a report is sent to the eMerchant customer inbox. When the Cron runs, an
AutoBill Cron Job Report is sent. When new bills, reminders and past due messages are sent, an
AutoBill Activity report is sent to the eMerchant customer inbox. The daily activity reports help to insure
that the Cron is running and that the bills are being processed consistently. To daily AutoBill report data
is saved in the database table: emerchant_autobillreport, which may be browsed using phpMyAdmin or a
similar tool. (Most hosting services provide phpByAdmin or a similar database management tool.)

Billing Templates

Billing templates are used to automatically create recurring bills from orders. See eMerchant > Billing
Templates.

Managing Unpaid Orders

Unpaid Orders are reported in the admin panel under Sales Reports. Select status Unpaid and Edit
mode to manage unpaid orders and to send reminders. Unpaid orders also appear in each related
customer's history through eMerchant.

7 Digital Mall

7.1 Digital Mall Introduction

This section only applies to Digital Mall.
See also: Install Digital Mall, Shop Parameters > Member Shops, Digital Mall Tour

Member products may be displayed in individual catalogs OR in one main catalog. The setting for this is
in Shop Parameters > Member Shops. 

Member Catalogs Enabled
· mall.php displays the member shop directory listing and search tools.
· Each member has an individual catalog of products.
· Each member may design custom shopping cart pages.
· Each member may create product categories, which appear only in that member's catalog.

Member Catalogs Disabled
· mall.php redirects to the catalogue.php
· All member and admin products appear in one main catalog.
· The mall administrator designs the shopping cart pages.
· Only the mall administrator may add or change product categories.

New Member Signup and Activation

7.2 Individual Member Catalogs

When individual member catalogs are enabled, each member has an individual catalog where only that
member's products appear. The following example is shown with Member Product Management enabled.

http://ashopsoftware.com/tour-dm/
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When individual member catalogs are enabled, each member has a Layout link when Store Configuration
is selected. Each member may upload a logo image, set fonts, colors, borders and other layout
parameters.
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Each member may upload a page header and page footer, which is then included at the top and bottom
of catalog, view cart, and check out pages. HTML may be used in the page header and footer to format
text, layout tables, and specify page parameters.

7.3 Member Signup

New members signup a members/index.php. See Install Digital Mall for instructions to set up the
member signup form.
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When a member application is submitted, the new applicant sees a confirmation page advising that the
application will be reviewed first before the account is activated. The applicant also receives an email
confirmation with a similar message and the mall administrator receives an email notice of the
application.

Activate New Members

Each new member account must be activated by the mall administrator. This is done in the admin panel
when logged in as ashopadmin. Click on Manage Members.
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Click on the exclamation icon to activate the new member.

When the member account is activated, a welcome message is emailed to the member with link and
password to the member's admin panel. The exclamation icon then becomes a member history icon.

Member Login

Members login at admin/login.php, same as the mall administrator (ashopadmin). When logged in as a
member, the administration panel functionality is limited and the member has only has access to his/her
products and information.

7.4 Member Shop Parameters

When logged into the admin panel as a member, in the main navigation on the left click Store
Configuration and then Shop Parameters at the top of the page. This is where each member can edit his
contact information, shop categories and description, and other member related data.
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